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Tutorial: Introducing
AutoCAD Map 3D 2011

■ These tutorials provide an overview of the product and hands-on exercises to help you
learn many aspects of AutoCAD Map 3D.

Lesson 1: Get Ready to Use the Tutorials
These AutoCAD Map 3D tutorials cover the following:

■ Introducing AutoCAD Map 3D 2011 (page 1): Take a quick tour of the
application. Create a map file, assign a coordinate system, connect to data,
style features, and save your work.

■ Building a map (page 37): Learn all the basics of creating a map from start
to finish. Use multiple sources, design themes and composite styles to change
the appearance of objects, create new features and edit them, and publish
your finished map.

■ Moving from AutoCAD to AutoCAD Map 3D 2011 (page 81): Prepare
drawings for use with AutoCAD Map 3D, clean up drawing data, add drawing
objects to a map, add and edit raster images, and share maps with others.

■ Annotating Your Map (page 133): Use annotation templates, labels, and text
layers to add textual information to a map.

■ Classifying Drawing Objects (page 177): Define object classes, assign drawing
objects to different classes, and then use the object classes to create, edit,
and export drawing objects. To be part of the object class, drawing objects
must meet certain rules when they are classified. Object classes help to ensure
that drawing objects are standardized.
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■ Creating a Map Book With an Inset (page 217): Customize a map book
template, create a map book, create an inset, and publish to DWF.

■ Analyzing Data (page 243): Add a surface and style it using a theme and
contour lines to show elevation. Join an external database to a feature and
create a style using both sets of data. Create a buffer zone that highlights
areas within 1000 feet of a river and identify parcels that lie within that
zone. Export comma-separated data to use in a report to the owners of
those parcels. Overlay two geospatial layers and save the resulting
comparison layer as a separate data store. Edit a workflow to automate
editing processes.

■ Working with Survey Data (page 291): Enter the location of new features
based on field-collected measurements. Import electronically stored point
data. Create a point cloud from LiDAR data, and then manage the point
cloud data and create a raster-based surface from it.

■ Managing Data From Different Sources (page 335): Export drawing objects
to Autodesk SDF format, and then connect to the resulting SDF file to add
it as a layer in another map. Use Bulk Copy to copy the SDF data to SHP
format. Import the SDF data to convert it back to drawing layers.

■ Working With Polygon Features (page 371): Connect to geospatial data for
parcel polygons. Join a data source to the parcels to add assessor data. Add
a new calculated property that uses native and joined properties. Split a
parcel into two uneven pieces using the Split command and assign
attributes to each resulting parcel using split/merge rules.

■ Batch Exporting (page 397): Export large numbers of DWG files to a different
format (for example, a GIS file format). Move a folder of DWG files to the
SDF format in a single operation.

Exercise 1: Prepare your sample data
When you installed AutoCAD Map 3D, the tutorial sample data was installed
on your computer in the \Program Files\AutoCAD Map 3D 2011\Help\Map 3D
Tutorials folder. You need that sample data to use the tutorials.

Copy the Map 3D Tutorials folder to My Documents. That way, if you change
the sample files, the original versions remain unchanged and can be used
again and again.
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To make a copy of the sample data

1 In Windows Explorer, navigate to the\Program Files\AutoCAD Map 3D
2011\Help folder.

2 Right-click the Map 3D Tutorials folder and click Copy.

3 Navigate to your My Documents folder.

NOTE The location of My Documents varies, depending on your operating
system. For Microsoft Windows XP, it is usually C:\MyDocuments. For Microsoft
Vista, it might be C:\Documents and Settings\Administrator\My Documents\Map
3D Tutorials.

4 Paste the Map 3D Tutorials folder into My Documents.

A new folder is displayed in My Documents, for example C:\My
Documents\Map 3D Tutorials.

5 Add the location to the Favorites list in Windows Explorer, or make a
note of it.

Exercise 2: Save your tutorial maps
You can create a folder for any map files you create or change as you use the
tutorials.

To create a folder for your tutorial map files

1 Open Windows Explorer.

2 Navigate to the C:\My Documents folder.

NOTE The location of My Documents varies, depending on your operating
system. For Microsoft Windows XP, it is usually C:\MyDocuments. For Microsoft
Vista, it might be C:\Documents and Settings\Administrator\My Documents\Map
3D Tutorials.

3 Click File  ➤ New Folder.

4 Change the name of the new folder to My AutoCAD Map 3D Tutorial Data.
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Exercise 3: Set up the tutorial window
Resize the window that displays the tutorial instructions so you can see it
while you work.

To resize the tutorial window

1 In AutoCAD Map 3D, display the tutorials. In the Tool-based Ribbon
Workspace, click Help  ➤ Learning Resources  ➤ Tutorials.

2 In the tutorials window, click  to hide the pane that contains the
Contents, Index, and Search tabs.

Use  to go to either the next or previous pages in the exercises.

Exercise 4: Choose a workspace
The tutorials assume that you are using the Tool-based Ribbon workspace (the
default) unless otherwise noted.

To switch to the Tool-based Ribbon workspace

1 Click the workspace entry in the status bar.

2 Click Tool-based Ribbon Workspace.

Lesson 2: Take a Quick Tour of AutoCAD Map 3D
Start by becoming familiar with the AutoCAD Map 3D window:
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The AutoCAD Map 3D window

To tour the AutoCAD Map 3D application window

1 Before you begin the tutorial, see Lesson 1: Get Ready to Use the Tutorials
(page 1).

2 From the desktop or the Start menu, start AutoCAD Map 3D.

3 Click  .

4 Navigate to the folder in My Documents where you copied the sample
files.

5 Open SampleMap.dwg.

An alert may tell you that an undefined drive alias (page 411) is referenced.
If so, click Define and use the following procedure. If not, proceed to
“The Ribbon (page 6).”

To define a drive alias

■ The alias you need is already selected. Click in the Actual Path field
and click Browse.

Lesson 2: Take a Quick Tour of AutoCAD Map 3D | 5



■ Navigate to the folder where you copied the sample files. Open that
folder and click OK. (Be careful to select the Map 3D Tutorials subfolder,
not the parent My Documents folder.)

■ Click Add, and then click Close.
The sample data location is now mapped to your drive alias. In future,
you can open the sample data without defining any further aliases.

The Ribbon
In AutoCAD Map 3D, the tabs across the top of the application window are
called a ribbon.

Tabs are like horizontal menus. Click a tab to see the commands associated
with it. Sets of related commands are grouped in panels. Click a command
icon within a panel to select that command. Panel titles that display a down
arrow contain more options. Panel titles that display an arrow in the lower
right corner have a dialog box associated with them.

Use the following techniques when working with the ribbon

■ To see more options for a panel, click the down arrow on the panel title
bar. Click the pushpin icon to keep the expanded portion displayed.
For example, on the Home tab, click the down arrow on the Data panel.

■ To see the dialog box associated with a panel, click the arrow in the lower
right corner of the panel.
For example, click the arrow on the Data panel to see the AutoCAD Map
3D Options dialog box.

■ To see the keyboard shortcuts for displaying ribbon elements, press the
Alt key. Press it again to hide the shortcuts.

■ To make a panel into a floating panel, drag its title bar away from the
ribbon. To reinsert it into the ribbon, drag it by its title bar to the desired
location.

■ To change the order of the tabs, drag a tab to a new position in the ribbon.
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■ To see commands for a particular Display Manager layer or Map Explorer
entry, select that item. The ribbon expands to include a new tab for the
selected item.
By default, the ribbon switches to the new tab. To keep the ribbon from
switching, at the Command prompt, type ribboncontextselect.

The application menu

The application menu includes the Search Field (page 10) and file-related
commands. Options displays the AutoCAD Options dialog box, which controls
such things as the background color for maps.

To use the application menu

1 Click  to see the application menu.
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2 Do any of the following:

■ Click a command or submenu item on the left side of the application
menu.

■ To issue a different command, type its name into the Search field. See
Finding Commands (page 9).

■ To switch between viewing recent documents and open documents,
click the icons above the list of commands on the left.
You can view recent documents as an ordered list, or by size, type, or
access date. You can display large or small icons or images for either
list.

■ To change AutoCAD settings, click Options. See Options (page 29).

Quick Access Toolbar

Put the commands you use most often on the Quick Access Toolbar. You can
display the toolbar at the top of the application window or just below the
ribbon.

To customize the Quick Access Toolbar

1 Click the down arrow next to the current Quick Access Toolbar.

2 Do any of the following:

■ To add a command to the Quick Access Toolbar, select any command
that is listed.

■ To remove a selected command from the Quick Access Toolbar, click
it to clear its check mark.

■ To move the Quick Access Toolbar below the ribbon area, select Show
Below The Ribbon.

To continue this tour of AutoCAD Map 3D, go to Finding Commands (page
9)

See also:

■ Customizing Your Work Environment

■ Workspaces (page 11)

■ Finding Commands (page 9)
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Finding Commands
If you know the command you want but cannot locate it in the ribbon, use
these tools to find it.

Ribbon Command Locator

The Ribbon Command Locator displays the current ribbon location for menu
commands you used in previous releases of AutoCAD Map 3D. If the command
is not on the ribbon, the Ribbon Command Locator tells you how to access
it.

To locate a command on the ribbon

1 In the InfoCenter field, type the name of the command.

2 In the list that displays, choose Find A Command On The Ribbon.

NOTE You can also click Tools tab  ➤ Customization panel  ➤ Ribbon
Command Locator.

3 In the Ribbon Command Locator window, specify the workspace you
used in the previous release.

4 Select the command from a menu to see its current ribbon location (or
an alternative way to access it).

Choose the command from the menu you used in the previous release of AutoCAD
Map 3D. Its current location appears in the Location In Ribbon field.
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Search Field

Type a command name into the application menu Search field to issue that
command or display its dialog box.

The Search field is at the top of the application menu.

To use the Search field

1 Click  to see the application menu.

2 In the field at the top of the menu, type all or part of the command name.

For example, type define. Commands beginning with the word “define”
are displayed.

3 In the list that displays, click the appropriate entry.
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For example, if you typed define, click Define Query to display the Define
Query Of Attached Drawing(s) dialog box.

NOTE If you customized the ribbon, the command might not be in the
indicated location. To find its current location, use the Ribbon Command
Locator instead.

To continue this tour of AutoCAD Map 3D, go to Workspaces (page 11)

Workspaces
AutoCAD Map 3D comes with predefined workspaces. Each workspace
organizes and displays commands and toolbars differently. You can switch
between the following workspaces:

■ Tool-based ribbon workspace — customized for those who are already
familiar with the AutoCAD ribbon

■ Task-based ribbon workspace — customized for AutoCAD Map 3D
commands

■ Map Classic — the menu-driven interface from earlier versions of the
product. Some new commands are unavailable from this workspace.

You can customize any workspace, specifying the contents of the ribbon tabs,
keyboard shortcuts, and how the mouse buttons behave.

To select a workspace

1 Click the workspace entry in the status bar.

2 Select the workspace most appropriate for your work.

■ If you are familiar with the AutoCAD ribbon interface, select
Tool-based Ribbon Workspace.

Workspaces | 11



The tutorials assume that you use the Tool-based Ribbon workspace
unless otherwise noted.

■ If you work mainly with AutoCAD Map 3D, select Task-based Ribbon
Workspace.

■ Those familiar with older versions of AutoCAD Map 3D might prefer
Map Classic. However, some commands added in recent releases are
not available from the menus in this workspace.

To continue this tour of AutoCAD Map 3D, go to The Task Pane (page 12)

See also:

■ Customizing Your Work Environment

■ Finding Commands (page 9)

■ The Ribbon (page 6)

The Task Pane
The Task pane gives you quick access to frequently used features, and groups
these features into task-related views. Use the Task pane to create, manage,
display, and publish maps.
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The Task pane

There are four tabs:

■ Display Manager (page 410), where you manage features stored in data stores
(databases, geospatial data files, and raster files), attach drawing files, and
change the appearance of features. Each geospatial feature class is a layer
in Display Manager. You can add drawing layers as well.

■ Map Explorer (page 413), where you view the elements of your map project.
Such elements include the files you connected to as sources, queries you
used and saved, and templates for linking drawing objects to data. Use this
view to query in objects from attached drawings and to view the data for
any object.

■ Map Book (page 413), where you divide a large map into "tiles." Each tile is
rendered on a separate page. You can publish map books in various formats,
both for printing and for online display.

■ Survey (page 415), where you bring in and work with survey point data.

Each view of the Task pane has its own menu area. You can also right-click
any item in the Task pane to see a customized menu for that item.

Use these techniques for the Task pane

■ To switch between views, click the tabs on the Task Pane (page 416).
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■ To see options for the current Task pane tab, click an icon in the menu
area at the top of the Task pane.

■ To hide the Task pane, click its Minimize button. Hold your cursor over
the Task pane title bar to see the Minimize button. To display the Task
pane after hiding it, move your cursor over its title bar.

■ To make the Task pane a floating palette, grab its title bar and drag it to
the desired location. Drag the title bar to a window edge to dock it again.

NOTE To minimize the Task pane each time you move your cursor away from
it, right-click the Task pane title bar and turn on Auto-hide.

■ To close the Task pane, click the X in its top right corner. Hold your cursor
over the Task pane title bar to see the X.
Once you have closed the Task pane, you can redisplay it. In the Tool-based
Ribbon Workspace, click View tab ➤ Palettes panel ➤ Map Task pane.

See also:

■ Setting Task Pane Options

Map Explorer

Use Map Explorer to manage the data sources included in your current map.
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Use Map Explorer to manage the following:

■ feature sources (such as Oracle, ArcSDE, SHP, and SDF)

■ attached source drawings

■ drawing queries

■ object classes

■ external data sources for drawing objects

■ topologies

■ link templates

To attach a drawing to the current map

■ Drag the file from Windows Explorer to the Map Explorer tab of the Task
pane.
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To use a database in a drawing

Do one of the following:

■ From Windows Explorer, drag a database file to the Map Explorer tab of
the Task pane.
If the Map Explorer tab does not immediately display the data source,
right-click a blank space in the Map Explorer tab. Click Refresh.

■ Right-click the Data Sources folder on the Map Explorer tab and select
Attach.
AutoCAD Map 3D automatically creates the required files for
communicating with the database application. However, for some database
types, you must configure these files yourself.

Display Manager

The Display Manager lets you create display maps. Each display map contains
a set of styled layers. You can have more than one display map in a map file,
and you can style the same data differently in each one.

Use Data Connect to add features to your map, or drag data sources into Display
Manager to add them as layers. For example, drag an SDF file from Windows®

Explorer into the layer area to add it.
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Use these techniques in the Display Manager

■ To change the appearance of a layer, select it and click 

■ To view and edit the attributes for a layer, select it and click 

■ To change the draw order of the layers, select a layer and click Draw Order.
Drag the layers into the order in which you want them to appear in your
map.

■ To see options specific to a layer, right-click any layer.
Selecting a layer also displays a contextual tab in the ribbon, with the
available options for that layer. See Shortcut Menus (page 27)

To use the Style Editor to style geospatial features

1 In the SampleMap.dwg file, select the Parcels layer in Display Manager
(page 410).

2 To change the color of the parcels, click the Style button in the Task Pane
(page 416) menu area.

■ Click in the Style field in the middle of the Style Editor window.

■ Select a different Foreground color and click OK.

■ Close the Style Editor by clicking the X in its top right corner. The
changes are displayed in your map.

See also:

■ Overview of the Display Manager

■ Organizing Layers in Your Map

■ Controlling Display Order

Map Book

Use the Map Book tab to create printed maps, map books, and multi-page
DWFs from styled maps. Map Book uses the AutoCAD Sheet Set Manager, and
provides a tree view of the tiles in the map book, like pages in an atlas. Use
navigation arrows to move between tiles in your map.
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To create a map book

1 Set up a map book template.

2 Identify layout placeholders.

3 Build the map book.

4 View or edit the map book tiles.

5 Publish the map book.

See also:

■ Overview of Map Books

Survey

Use the Survey tab to import and organize survey data points.
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Use the Survey tab to import and
organize survey data.

To work with survey data

1 Create a survey data store to contain the data.

2 Import data from LandXML or ASCII files.

3 Organize the data:

■ Organize the data into projects.

■ Within each project, create surveys and classify points into point
groups.

■ Create new points within defined point groups, and create features
from points.

To continue this tour of AutoCAD Map 3D, go to Properties Palette (page 20)

See also:

■ Bringing in Survey Data

■ Working with Survey Data
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Properties Palette
View the properties of the selected drawing object or feature in the Properties
palette.

The Properties palette

The Properties palette lists the current settings for properties of the selected
object or set of objects. For drawing objects, you can modify any property that
can be changed by specifying a new value. For features, you can change
attribute values but not geometry.

When more than one object is selected, the Properties palette displays only
those properties common to all objects in the selection set.

When no objects or features are selected, the Properties palette displays only
the General, 3D Visualization, Plot Style, View and Misc properties for the
current layer. If you select a feature layer in the Display Manager, the layer
name and title are displayed. For drawing layers, the Element and Element
Source are displayed.

Drawing objects that belong to an object class (page 413) have additional
information on the Object Class tab. Use the Display tab to see the source
drawing for a drawing object, or to change the thumbnail preview for that
object layer.

To use the Properties palette to style drawing objects

1 In the SampleMap.dwg file, select a road.

The Quick Properties window is displayed. However, to see all the
properties, display the Properties palette.

2 Right-click the road and click Properties.
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The Properties palette is displayed.

3 Click the Design tab if it is not already displayed.

The roads are objects in an AutoCAD drawing. Notice that the current
selection is defined as a Polyline. For drawing objects, you can format
some properties with the Properties palette.

■ To change the way the currently selected road segment is displayed,
click in the Color field and then click the down arrow to select a color.
If you are asked whether to add this object to the save set, click No.
With your cursor positioned in the map, press Esc to see the results.

■ To change the color for all roads, click Home tab  ➤ AutoCAD Layers
panel  ➤ Layer Properties. Click in the Color field for layer 0, which
contains the roads, select a color, and click OK.
The color of all the roads changes to the color you selected.

To edit feature properties in the Properties palette

1 In the SampleMap.dwg file, select the Parcels layer in Display Manager
(page 410).

2 Click a parcel in the map.

3 If the Properties palette is not still open, right-click the parcel and select
Properties.

The Design tab displays the properties for this feature.

4 Click in the LAND_VALUE field and type a new value for this parcel.

5 Press the Tab key or click in a different field to make your changes take
effect.

To continue this tour of AutoCAD Map 3D, go to Data Table and Data View
(page 21)

Data Table and Data View
Data Table displays geospatial features in a tabular format. Data View displays
external data linked to drawing objects.

Data Table and Data View | 21



Data Table

Use the Data Table to highlight data for specific geospatial features in your
map. AutoCAD Map 3D maintains the link between spatial data and attribute
data; when you update the attribute data, the updates are dynamically reflected
in your drawing.

The Data Table displays geometry and attribute data for
a feature. You can search and theme features based on
any data in the feature source.

To display the Data Table

1 Select a feature layer in the Display Manager.

2 Click Table.

Data View

Using the Data View, you can sort and filter the external database records
linked to drawing objects. In addition, if you open the table in Edit mode,
you can edit the data in the database table.
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Data View displays external data linked to a drawing

To use the Data View

■ To view or edit a table, double-click it in Map Explorer.

■ To create or edit links to a table, double-click its link template.

■ To run a query, double-click the database query name.

To continue this tour of AutoCAD Map 3D, go to Status Bars (page 23)

See also:

■ Overview of the Data Table

■ Overview of Viewing External Data Sources for Drawing Objects

Status Bars
The area at the bottom of the application window displays status information
and includes some controls for changing the view.

Status Bars | 23



The status bars

Instructions for the current command replace some status bar items. Some
items appear only while an operation is in progress, for example, publishing
or plotting.

To add an item to the status bar

1 Use one of the following methods:

■ Click the Drawing Status Bar Menu (the down arrow at the far right
of the upper status bar).

■ Click the Application Status Bar Menu (the down arrow at the far right
of the lower status bar).

2 Select the item to add.

NOTE To remove an item you added, select it again from the same menu.

To continue this tour of AutoCAD Map 3D, go to Layout Tabs (page 24)

Layout Tabs
Most of the time you work in model space, where you create your map on a
1:1 scale. You can create multiple paper space layouts, where you can place a
title block, include several views of the same item, and include notes. Switch
between model space and layout spaces using the tabs at the bottom of the
application window.

Model and Layout tabs

By default, each map has one Model tab and two Layout tabs. Create more
Layout tabs if you need them.
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To display and hide the Model and Layout tabs

1 At the bottom of the application window, right-click  (the Model Space
icon).

2 Click Display Layout and Model Tabs.

To hide the tabs again, right-click a tab and click Hide Layout And Model
Tabs.

To create or rename a layout tab

■ Right-click an existing layout tab and click New Layout.

To rename a layout

■ Double-click the layout tab and type a different name.

To continue this tour of AutoCAD Map 3D, go to Dynamic Input (page 25)

Dynamic Input
For experienced AutoCAD users, the command-line interface is a shortcut for
creating objects and specifying properties. AutoCAD Map 3D provides a
command interface near the cursor. This interface is called dynamic input.
The older command line window is hidden by default, but you can display it
at any time.

With dynamic input, you can

■ Launch commands by typing them directly into the drawing area.

■ Respond to command prompts in a tooltip or tooltip menu near the cursor,
instead of on the command line.

■ View the location of the crosshairs as coordinate values in a tooltip.

■ Enter coordinate values in the tooltip when a command prompts for a
point, instead of on the command line.

■ View distance and angle values when a command prompts for a second
point.
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An example of dynamic input

NOTE With the command line hidden, detailed information for some commands
is not visible. To see this information, display the command line by pressing CTRL+9
on the keyboard.

Keep in mind the following rules :

■ Some commands require that you specify vectors with your cursor. When
you finish, press Esc.

■ Some commands require that you select an object. Click the object and
press Enter.

■ Some commands have multiple input fields. Press the Tab key to move
from one to another.

■ When the down arrow icon  appears in a prompt, press the down arrow
on your keyboard to see a list of options for that command. Press the down
arrow again to move between options, and then press Enter to select the
highlighted one.

To use dynamic input

1 Position your cursor over an empty space in the map.

2 Enter circle and press Enter.
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3 Respond to the prompts to draw a circle.

■ For the center point of the circle, click somewhere in the map.

■ For the radius of the circle, enter 500 and press Enter.

To turn dynamic input on or off

■ On the status bar, click  , or press F12.

To turn off dynamic input temporarily

■ Hold down the F12 key while you work.

To control dynamic input settings

■ Right-click  and click Settings.

NOTE By default, dynamic input is set to relative (not absolute) coordinates.
For example, entering 10,10 and then 20,20 draws a line from 10,10 to 30,30.
If you frequently enter absolute coordinates, you can change this setting.

To hide or show the command line window

■ Press CTRL+9 on the keyboard
To display the AutoCAD text window with all your past command-line
input history, press F2. To hide this information, press F2 again.

To continue this tour of AutoCAD Map 3D, go to Shortcut Menus (page 27)

Shortcut Menus
Each item in AutoCAD Map 3D has a custom menu that contains commands
available for that item at the current time.
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An example of a shortcut menu in Display Manager

To use a shortcut menu, do either of the following

■ Right-click an item in the map.

■ Right-click an item in the Task Pane (page 416).

NOTE When you select an item in the Task pane, it might also display a contextual
tab on the ribbon. For example, select an object class on Map Explorer to see the
Classification tab. Select a feature layer on Display Manager to see the Vector Layer
tab.

To continue this tour of AutoCAD Map 3D, go to Options (page 29)

28 | Chapter 1   Tutorial: Introducing AutoCAD Map 3D 2011



Options
You can set two sets of options in AutoCAD Map 3D: AutoCAD options and
AutoCAD Map 3D options.

AutoCAD options affect your map in some ways. For example, you can change
the background color for maps using these options.

AutoCAD Map 3D options are all specific to mapping.

To change AutoCAD options

1 Click  to see the application menu.

The application menu remains displayed until you select a command or
click somewhere else.

2 Click Options (at the bottom of the menu).

3 Change any options you like. For example, to change the background
color of all future maps, change the following option:

■ Click the Display tab.

■ Click Colors.
Under Context, 2D Model Space should be selected. Under Interface
Element, Uniform Background should be selected.

■ Change the value for Color.
Select any color.

■ Click Apply & Close.

To change AutoCAD Map 3D options

1 Click Map Setup tab ➤ Map panel ➤ angle-arrow. 

2 Click a tab.

3 Modify options.

4 Click OK to save the settings.

See also:

■ Overview of Setting Options
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Lesson 3: Get Started
This lesson provides an overview of the basic tasks needed for creating maps.

In this lesson, you use the Display Manager. Bring in a file containing road
data, change the way the roads are displayed, and then save your work. In
about 15 minutes, you will have a complete map.

Exercise 1: Create a map
Create a map file using a standard template. Assign a coordinate system. Any
data you add to your map is converted to that coordinate system.

To create a map

1 Before you begin this tutorial, see Lesson 1: Get Ready to Use the Tutorials
(page 1).

2 From your desktop or the Start menu, start AutoCAD Map 3D (if it is not
already running).

3 Click  and click New  ➤ Drawing.

4 In the Select Template dialog box, select map2d.dwt and click Open.

Select map2d.dwt

This file is an AutoCAD template that is set up to work with
two-dimensional maps in AutoCAD Map 3D.
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5 Assign a coordinate system for your map.

■ In the Task pane, click the Map Explorer tab.

■ In Map Explorer (page 413), right-click Current Drawing and click
Coordinate System.

Set the coordinate system from the Task pane.

■ In the Assign Global Coordinate System dialog box, for Code, enter
CA-I . (Enter the letters CA, hyphen, letter I.)

Specify the code for your coordinate system.

NOTE To find the code for a particular coordinate system, click Select
Coordinate System in this dialog box and select a coordinate system by
category. Use the Properties button to see information about different
coordinate systems until you find the one for your map.
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■ Click OK.

To continue this tutorial, go to Exercise 2: Use Data Connect to add data to
your map (page 32).

Exercise 2: Use Data Connect to add data to your map
Use Display Manager to bring in a file containing road data.

To add data to your map

1 In the Task Pane (page 416), switch to Display Manager (page 410).

2 In the Display Manager menu area, click Data  ➤ Connect To Data.

Use the Data menu in the Task pane to
add any type of data to a map.

The Data Connect (page 410) window is displayed.

3 Under Data Connections By Provider (on the left side), click Add SHP
Connection.

4 Click the file icon next to Source File Or Folder (on the right side).

5 Navigate to the sample data folder (page 2) and select Roads.shp. Click
Open.

6 Click Connect to add the Roads SHP file as a data source.
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To add a feature, first connect to its source.

7 In the Data Connect window, click Add to Map.

Click Add To Map to see the data in your map.

8 Close the Data Connect window by clicking the X at the top.

To continue this tutorial, go to Exercise 3: Style a feature (page 33).

Exercise 3: Style a feature
Change the appearance of the roads.
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To style the roads

1 In Display Manager (page 410), select the layer labeled Roads and click
Style in the menu area.

Select the Roads layer and click Style.

The Style Editor window is displayed over your map.

2 In the Style Editor window, click  for Style and select a thickness, color,
and pattern for the roads. Click OK.
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Select a thickness, color, and pattern for the lines in the Style Line dialog box.

3 Click the X at the top of the Style Editor window to close it.

4 Save your work.

■ Click  ➤ Save.

■ Specify a name and location for your map.
Notice that map files use the file extension .dwg, just as AutoCAD
drawings do. Both file types use the same basic file format.

■ Click Save.

You can also create a composite style for line features, combining multiple
line styles for a more realistic appearance. For more information, see Styling
Line Features.

Where you are now

In the map, you can see the styled roads.
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Tutorial: Building a Map

About the Building a Map Tutorial
The lessons in this tutorial take you through the entire workflow of building
and publishing a map. You use real data from the city of Redding, California
to do the following:

■ Start a map project by connecting to all the data stores needed by your map.
Data stores can include geospatial databases, spatial data files, such as Shape
(SHP) and SDF files, AutoCAD drawings (DWG files), and raster images.
Connecting to a data store makes the information in that data store available
to your map.

■ Style the objects in your map so you can easily identify them. Styles can
help you provide complex information quickly and intuitively. For example,
themed styles can show population density, water depth, or the relative
height of geographic features.

■ Edit objects in your map. In AutoCAD Map 3D, you can check out and edit
any type of object using AutoCAD commands. For example, edit geometry
in a drawing file, a schema in an ESRI SHP file, or geospatial data stored in
an Oracle database. You can then save the changes back into their original
format. You can also use the Data Table to change the properties of geospatial
data.

■ Publish the resulting map for display on a web site. In this tutorial, you
publish to DWF format (for use with Autodesk Design Review). You can also
publish or export to Autodesk MapGuide, or save your map as a static web
page.

2
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Lesson 1: Use Multiple Sources
In the first set of lessons, you practice connecting to data from various sources.

Exercise 1: Drag and drop a source file
Start by creating a map file and adding the city boundaries of Redding to it.

To create a map and add a source file

1 Before you begin this tutorial, see Lesson 1: Get Ready to Use the Tutorials
(page 1).

2 Create a map file.

■ Click  ➤ New  ➤ Drawing.

■ Select the map2d.dwt template.

■ Click Open.

3 Set the coordinate system for the map.

■ Switch to Map Explorer (page 413) in the Task Pane (page 416).

■ Right-click Current Drawing and click Coordinate System.

■ Enter CA-I and click OK.

4 Add the city boundaries to your map by dragging and dropping a source
file to Display Manager.

■ Switch to Display Manager (page 410) in the Task pane.

■ Use Windows Explorer to navigate to the folder in My Documents
where you copied the sample files.

NOTE The location of My Documents varies, depending on your operating
system. For Microsoft Windows XP, it is usually C:\MyDocuments. For
Microsoft Vista, it might be C:\Documents and Settings\Administrator\My
Documents\Map 3D Tutorials.

■ Resize the AutoCAD Map 3D window and your sample data folder
window so you can see both of them at the same time.
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■ Drag and drop the City_Boundary.sdf file onto the lower area of the
Display Manager, just above the Map Base layer.

Drag and drop the city boundary file to Display Manager.

The Redding city boundaries appear in your map.

5 Click  ➤ Save As  ➤ AutoCAD Drawing. In your tutorials folder,
name the file build_map1.dwg and click OK.

To continue this tutorial, go to Exercise 2: Attach a drawing file (page 39).

Exercise 2: Attach a drawing file
You can use Display Manager to attach an AutoCAD drawing file.

NOTE This exercise uses the build_map1.dwg map you created in the previous
exercise.
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To attach an AutoCAD drawing file

1 If you have not already done so, copy the \Program Files\AutoCAD Map
3D 2011\Help\Map 3D Tutorials  folder to My Documents.

NOTE The location of My Documents varies, depending on your operating
system. For Microsoft Windows XP, it is usually C:\MyDocuments. For Microsoft
Vista, it might be C:\Documents and Settings\Administrator\My Documents\Map
3D Tutorials.

2 In the build_map1.dwg file, in the ribbon at the top of the application
window, click Home  ➤  Data ➤  Attach

You can also use Display Manager to attach a drawing file.

3 In the Define/Modify Drawing Set dialog box, click Attach.

4 Navigate to the folder in My Documents where you copied the sample files
and select Counties.dwg.

NOTE The location of My Documents varies, depending on your operating
system. For Microsoft Windows XP, it is usually C:\MyDocuments. For Microsoft
Vista, it might be C:\Documents and Settings\Administrator\My Documents\Map
3D Tutorials.
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5 Click Add and then click OK.

6 In the Define/Modify Drawing Set dialog box, click OK to attach the
drawing file to your map.

When you attach a drawing, it is not listed in Display Manager (page 410)
and it does not appear in your map. You “query in” objects from the
drawing to use in your map, as demonstrated in the next exercise.

7 Save your work. Click  ➤ Save As  ➤ AutoCAD Drawing.

To continue this tutorial, go to Exercise 3: Query in data from the drawing
(page 41).

Exercise 3: Query in data from the drawing
When you attach a drawing to a map, objects in the drawing do not appear
in the map immediately. You must query them in. The drawing file you
attached is a map of California with polygons defined for each county. Since
the city of Redding is in Shasta County, you add the Shasta County boundaries
to your map. You can query in data based on location, properties, or data. In
this case, query the name of the county, which is stored as object data.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To query in drawing data

1 In the build_map1.dwg file, click Home ➤ Data  ➤ Define Query.

2 In the Define Query Of Attached Drawings dialog box, under Query Type,
click Data.

3 In the Data Condition dialog box, select the Object Data option.

4 In the Object Data Fields list, select NAME.

NOTE Do not change the Tables setting.

5 Leave Operator set to = . For Value, enter Shasta.
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Define the data condition for the query.

The query is case sensitive. Be sure to enter it as shown.

6 Click OK in the Data Condition dialog box, and then click Execute Query.

7 In the Tool-based Ribbon Workspace, click View tab ➤ Navigate
panel ➤ Zoom drop-down ➤ Extents.

The Shasta county boundaries are now displayed in the map.

8 Save your work. Click  ➤ Save.

NOTE You might see an alert as you work through the remainder of the tutorial.
It warns that the association between queried objects in the current and attached
drawings is not retained once the current drawing file is closed. This message
reminds you to save back any changes you make to the original drawing file. Since
you do not edit the Shasta County drawing in this tutorial, you can safely ignore
the alert.

To continue this tutorial, go to Exercise 4: Use Data Connect (page 43).
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Exercise 4: Use Data Connect
Use Data Connect (page 410) to connect your map to a file containing parcel
data.

Use the Data Connect window to attach any non-DWG data source:

■ Database formats, such as ArcSDE, Oracle, or SQL Server

■ An ODBC source, such as Microsoft Access

■ A raster file

■ Web-based sources such as WMS or WFS

■ Spatial data files, such as SDF and SHP

Data Connect displays information about all attached non-DWG data sources,
even if you did not use Data Connect to attach them. For example, the SDF
file you dragged and dropped into your map is listed in the Data Connect
window.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To use Data Connect

1 If you have not already done so, copy the \Program Files\AutoCAD Map
3D 2011\Help\Map 3D Tutorials folder to My Documents.

NOTE The location of My Documents varies, depending on your operating
system. For Microsoft Windows XP, it is usually C:\MyDocuments. For Microsoft
Vista, it might be C:\Documents and Settings\Administrator\My Documents\Map
3D Tutorials.

2 In the build_map1.dwg file, in Display Manager (page 410), click Data  ➤ 

Connect to Data.

3 Under Data Connections By Provider, select Add SDF Connection.

4 Click the file icon next to Source File.

5 Navigate to the folder in My Documents where you copied the sample files
and select PARCELS.SDF. Click Open.

6 Click Connect to add the parcel data file as a data source.
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Under Add Data To Map, Parcels is selected.

The coordinate system for this feature class is displayed next to its name.
If this information was incorrect, you could click the current coordinate
system listing to see a down arrow and select a different coordinate system.

NOTE Change the incoming coordinate system only if you know the original
coordinate system for the feature—do not change the coordinate system to
match your map. AutoCAD Map 3D automatically converts each feature from
its own coordinate system into the coordinate system for the current map.
If you change the coordinate system, the conversion might not be correct.

7 Click Add To Map.

In the Data Connect window, connect to a data provider and then select the feature
class you want.

When you click Add To Map, a layer called Parcels is displayed in the list
in the Display Manager (page 410). A layer can be styled, saved, displayed,
or hidden, independent of other layers in your map.

8 Save your work. Click  ➤ Save.

To continue this tutorial, go to Exercise 5: Add a raster image (page 45).
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Exercise 5: Add a raster image
Photographs and other images formed of pixels are called raster images, while
images formed of lines and arcs are called vector images. Bring in an aerial
photograph to display behind the objects in your map. Real-world elements
in the raster image line up with the geometry in your map and make it easier
for the viewer to get a visual orientation.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To add a raster image

1 If you have not already done so, copy the \Program Files\AutoCAD Map
3D 2011\Help\Map 3D Tutorials folder to My Documents.

NOTE The location of My Documents varies, depending on your operating
system. For Microsoft Windows XP, it is usually C:\MyDocuments. For Microsoft
Vista, it might be C:\Documents and Settings\Administrator\My Documents\Map
3D Tutorials.

2 In the build_map1.dwg file, the Data Connect (page 410) window should
still be displayed. If it is not, open Display Manager (page 410). Click Data
 ➤ Connect To Data.

3 Under Data Connections By Provider, select Add Raster Image Or Surface
Connection.

4 Click the folder button next to Source File Or Folder.

5 Navigate to the folder in My Documents where you copied the sample
files. Find the folder containing the JPEG 2000 raster files (originally
called JP2K), and select it. Click OK.

6 Click Connect to add the folder as a data source.

7 Under Add Data To Map, select the j-05, j-07, l-05, and l-07 items.

The folder contains multiple JPEG 2000 files, each of which covers a small
area of the city of Redding. Since there are multiple items and you might
not want all of them, they are not selected automatically.
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If your folder contains multiple images, select the ones you want.

8 Set the coordinate systems for the images.

■ Click Edit Coordinate Systems.

■ In the Global Coordinate System dialog box, click in the blank field
in the row labeled “Default” and click Edit.

■ For Category, select USA, California.

■ Under Coordinate Systems In Category, click CA-I.

■ Click OK in both dialog boxes, to return to the Data Connect window.
All the images now show CA-I as their coordinate systems.

9 Select Combine Into One Layer, so you can style the raster images as a
single item in Display Manager.

10 Enter a name for the layer, for example, ReddingRasterImages.

11 Click Add To Map.
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To see the results

1 Close the Data Connect window.

2 Right-click the new raster layer and click Zoom To Extents.

To continue this tutorial, go to Exercise 6: Display the raster image behind
other features (page 47).

Exercise 6: Display the raster image behind other
features

You want the raster image to provide context for the parcels in your map, but
right now it is hiding the parcels. Move the raster behind the parcels and set
transparency for the parcels so you can see the raster image.

To display the raster image behind other features

1 In the build_map1.dwg file, in the Display Manager (page 410) menu bar,
make sure Draw Order is selected.
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2 Drag the new raster layer just below the Parcels layer.

The list of layers is the draw order for your map. The item at the top of
the list is also at the top of the draw order. Dragging the raster image
below the Parcels layer places it behind that layer in your map.

To see the raster layer behind the parcels, make the city boundary layer
white and make the parcels semi-transparent.

3 In Display Manager, select the City_Boundary layer.

4 Click Style to see the Style Editor.

NOTE If the Style Editor is docked, move your cursor over it to display it. It
might be docked at the left side of the application window.

5 In the Style Editor, in the Polygon Style For 0 - Infinity: Scale Range
section, click the Style entry.

6 Change the Foreground Color to white and click OK.

7 Without closing the Style Editor, select the Parcels layer in Display
Manager.

The Style Editor window updates to show the values for the Parcels layer.

8 In the Style Editor, click the Style entry again.

9 Move the Foreground Transparency slider to 50% and click OK.

Close the Style Editor. Right-click the Parcels layer and click Zoom To
Extents to see the results.

10 Save your map.

Where you are now

You have assembled all the raw materials for your map. The aerial photograph
provides context. The geometry from the DWG drawing shows the county
boundaries, and the SDF files add the city boundary and parcel outlines.
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To continue this tutorial, go to Lesson 2: Style Map Features (page 49)

Lesson 2: Style Map Features
In the Lesson 3: Get Started (page 30) lesson, you changed the style for the
roads in your map. You changed the color, thickness, and pattern for the lines
representing roads.

In this lesson, you use themed styles to give the viewer an immediate sense
of the value of each parcel.

Exercise 1: Create a theme for the parcels layer
A theme uses a range of colors to represent an analogous range of values. You
can also use theming to show relative area, population density, water depth,
or height of geographic features.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To style the parcels layer with a theme

1 Open your finished map from the previous lesson.

■ Click  ➤ Open  ➤ Drawing.

■ Locate build_map1.dwg.

■ Select it, and click Open.

2 Create a theme for the parcel layer.

A theme is a display style. You assign styles for geospatial features by
layer.

■ In Display Manager (page 410), select the Parcels layer and click Style.

NOTE If the Style Editor is docked, move your cursor over it to display it.
It might be docked at the left side of the application window.

■ In the Style Editor, under Polygon Style For 0 - Infinity Scale Range,
click New Theme.
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Click New Theme to define a theme for the Parcels layer.

To continue this tutorial, go to Exercise 2: Define the theme (page 50).

Exercise 2: Define the theme
Tie the theme definition to the value of the parcels: lighter colors represent
parcels with lower values and darker colors represent parcels with higher
values. The parcel value is the "condition" used to determine the color of the
parcel in the map.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To define the theme

1 In the Theme Polygons dialog box, under Create Thematic Rules Based
On A Property, click the down arrow next to Property and select
LAND_VALUE. Leave the minimum value, maximum value, and
distribution settings as they are.
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Use the Theme Polygons dialog box to design your theme.

2 Under Theme The Polygons, click  next to the illustration of the Style
Range.

3 Set Foreground transparency to 50% so you can continue to see the raster
image below the parcels.

4 For Foreground Color Range, select colors from the color boxes under
From and To.

5 Experiment with line thickness and color, if you like.
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Set transparency, colors, and line attributes for the theme.

6 Click OK twice to return to the Style Editor. Leave the Style Editor open
for the next exercise.

To continue this tutorial, go to Exercise 3: Add labels (page 52).

Exercise 3: Add labels
Add a label for each parcel, based on its land value.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.
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To add labels

1 In the Style Editor, click the first field in the Feature Label column.

The field value is “None.”

2 In the Style Label dialog box, for Property To Display, select
LAND_VALUE. Leave the other settings at their current values for now.

Select a property. The data for that property appears in the
labels.

3 Repeat the first two steps for each theme entry.

4 Click OK to close the Style Label dialog box and apply the theme to your
map.

5 Close the Style Editor so you can see your map again.
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6 Zoom in so you can see the labels. In the Tool-based Ribbon Workspace,
click View tab ➤ Navigate panel ➤ Zoom Drop-down ➤ Window.

TIP The smaller you draw the zoom window, the larger the magnification.

7 Save your map.

Where you are now

In the map, the parcels are colored to represent their relative values, which
are displayed as labels on each parcel.

Themed parcels with labels

NOTE For a tutorial on labeling both features and drawing objects, as well as
using text layers, see Tutorial: Annotating Your Map (page 133).

To continue this tutorial, go to Lesson 3: Change the Display by Zoom Level
(page 55)
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Lesson 3: Change the Display by Zoom Level
Use styles to make objects display differently, depending on the zoom level.
In this example, when the viewer is zoomed in, roads are dark gray with a
dashed yellow centerline. When the viewer zooms out, the roads display as
solid black. When the viewer zooms out far enough, roads are not displayed
at all.

Exercise 1: Use a composite style for roads
Add roads to your map and create a composite style to combine two line styles
to form a realistic-looking road style. The composite style is displayed when
you zoom in to a certain scale range in your map. A simpler style is displayed
when you zoom out.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To add roads to your map

1 If you have not already done so, copy the \Program Files\AutoCAD Map
3D 2011\Help\Map 3D Tutorials folder to My Documents.

NOTE The location of My Documents varies, depending on your operating
system. For Microsoft Windows XP, it is usually C:\MyDocuments. For Microsoft
Vista, it might be C:\Documents and Settings\Administrator\My Documents\Map
3D Tutorials.

2 Open your finished map from the previous lesson.

■ Click  ➤ Open  ➤ Drawing.

■ Locate build_map1.dwg.

■ Select the map, and click Open.

3 In the Task Pane (page 416), switch to Display Manager (page 410) .
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4 Drag and drop the roads into Display Manager.

■ Use Windows Explorer to navigate to the folder in My Documents
where you copied the sample files.

■ Resize the AutoCAD Map 3D window and the sample data folder
window so you can see both of them at the same time.

■ Drag and drop the Roads.shp file to the list of layers in the Display
Manager, just above the Parcels layer.

5 In Display Manager, select the Roads layer and click Style.

NOTE If the Style Editor is docked, move your cursor over it to display it. It
might be docked at the left side of the application window.

6 In the Style Editor, click the Style field.

7 In the Style Line dialog box, click Create Composite Lines.

Use the Create Composite Lines link to combine line styles.

8 For Thickness, select 0.2, and for Color select a dark gray.

9 Click New to create the second part of the line style.
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The Build Up Composite Styles area displays the styles you added up
to now.

10 Select a bright yellow for Color and a dotted option for Pattern.

Notice that the preview now displays a dark gray line with a dashed
yellow line inside it.

A composite line for roads

11 Click OK.

Now define scale ranges and assign styles to them. Each scale range
represents the zoom levels at which a style is displayed. When you are
zoomed between the levels of a range, the style for that range is displayed.

12 In the Scale Ranges area at the top of the Style Editor, click the word
“Infinity” and enter 30000 to replace it.

The composite style you created appears for this range.
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Set up zoom levels and assign a style to each one.

13 Define another scale range and specify a solid line style for it.

When the zoom level is within this range, the roads appear as solid lines.

■ Click Add A Scale Range.

■ Set the range to go from 30000 to 50000.

■ Click the Style field in the bottom area of the Style Editor.

■ Reset the style to a single line.

■ Change the color to black.

■ Select a solid pattern (at the top of the list).

■ Set the line thickness to .05.

■ Click OK.

14 Define another scale range so that no styling is applied to the roads when
you zoom out to a distant view.

■ Click Add A Scale Range again.
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■ Set the new range to go from 50000 to infinity.

■ Click the Style field in the bottom area of the Style Editor.

■ Clear the Apply Styles To The Line check box at the top of the Style
Line dialog box.

■ Click OK.

The style for this scale range is now None. When you zoom out to a
distant view, you cannot see the roads.

15 Close the Style Editor and save the file.

To continue this tutorial, go to Exercise 2: View styles at different zoom levels
(page 59).

Exercise 2: View styles at different zoom levels
Zoom to different scales in your map to see the different line styles.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To see the styles at different zoom levels

1 In the build_map1.dwg file, use the Zoom Window tool to zoom in so you
can see the labels and the composite lines. In the Tool-based Ribbon
Workspace, click View tab ➤ Navigate panel ➤ Zoom
drop-down ➤ Window.

TIP The smaller you draw the zoom window, the larger the magnification.

2 Zoom out to see thinner black lines for the roads.

3 Zoom out even farther until the roads are not displayed.

4 Save your map.

Where you are now

In the map, the roads are themed to display appropriately at different zoom
levels.
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At a scale of 1:10000, the roads display the composite style.

To continue this tutorial, go to Lesson 4: Create Map Features (page 60)

Lesson 4: Create Map Features
Use the powerful editing abilities of AutoCAD to draw new features.

Exercise 1: Draw a new parcel
When you draw a new feature, it is automatically added to the layer from
which it was created. The source for that layer is updated to include the feature
you added.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To create a feature

1 If it is not still open, open your map from the previous lesson.

■ Click  ➤ Open  ➤ Drawing.

■ Locate the build_map1.dwg file.
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■ Select it, and click Open.

2 Select the Parcels layer.

3 Click Zoom to Extents.

4 Click Create tab ➤ Feature panel ➤ New Feature drop-down ➤ Polygon.

5 Click a starting point in the map for the new parcel.

Click an area on the border of the city.

6 Click three more points to define the beginning of the parcel and its first
three sides.

7 Press the down arrow on your keyboard to see a menu of choices in the
dynamic input line.

8 Press the down arrow again until a dot is displayed next to Close, showing
that it is selected.

Use dynamic input to draw the parcel.

9 Press Enter to close the polygon.

10 Select Exit from the dynamic input menu to complete the command.

The parcel is complete and the Data Table (page 410) is displayed.

NOTE If the Data Table is docked, move your cursor over it to display it. If
the Data Table does not display automatically, select the Parcels layer in
Display Manager and click Table.

To continue this tutorial, go to Exercise 2: Add information about the new
parcel (page 62).
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Exercise 2: Add information about the new parcel
In the Data Table (page 410), add information about this parcel.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To add information about the new parcel

1 Right-click the parcel in the map and click Check-in Feature.

The original data source is updated.

2 Click in the new blank row in the Data Table.

3 Fill in the data fields for this parcel.

Look at the other entries to see what a logical entry would be for each
column.

4 Right-click the parcel in the map and click Check-in Feature.

The original data source is updated with your changes.

5 Save your map.

Where you are now

You have added a new parcel and updated the parcel data to reflect your
changes.

A new Data Table entry

To continue this tutorial, go to Lesson 5: Find and Edit Features (page 63)
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Lesson 5: Find and Edit Features
Use the Data Table (page 410) to find objects that match certain criteria. Then,
use the Data Table to zoom in to that area of your map.

Exercise 1: Use the Data Table to find a feature
Display the Data Table (page 410) for any layer. Filter the Data Table (page 410)
to show a subset of parcels—in this case, only parcels on Villa Drive.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To use the Data Table to filter features

1 If it is not still open, open your finished map from Lesson 4: Create Map
Features (page 60).

■ Click  ➤ Open  ➤ Drawing.

■ Locate the build_map1.dwg file.

■ Select it and click Open.

2 In the Task pane, switch to Display Manager (page 410).

3 In Display Manager, select the Parcels layer and click Table.

If the Data Table is docked against the left side of the application window,
move your cursor over it to see its contents.

4 In the Data Table (page 410), in the Filter By list, select the STNAME field
and enter VILLA DR into the field.

The field is case sensitive, so be sure to enter all capital letters. Do not
spell out the word “Drive.”

5 Click Apply Filter to show only parcels on Villa Drive.
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Use the Data Table to filter the parcels you see.

6 Make sure Auto-Zoom is on.

This button is a darker color when it is on; otherwise, it is the same color
as the window.

7 Click in the dark-gray, left-most field for a parcel to select that parcel.

NOTE Scroll the Data Table to the left to see the left-most fields.

AutoCAD Map 3D zooms to the selected parcel.

8 Make a note of the number in the Autogenerated_SDF_ID field, because
you will need it again later.

9 Close the Data Table.

NOTE You can do a more sophisticated search. Click Home tab ➤ Data

panel ➤ Search.  That option lets you query a layer with a Boolean
condition—for example, ACRES > 1 to find parcels that are larger than an
acre. The map then shows only the objects that match your query.

10 Save your map, but leave it open for the next exercise.

To continue this tutorial, go to Exercise 2: Check out and edit a feature (page
65)
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Exercise 2: Check out and edit a feature
If AutoCAD Map 3D is set to check in your changes automatically, the source
file updates while you edit. Automatic update can result in inadvertent changes
to the data store. The safest way to edit geospatial data is to turn off automatic
update feature before you edit a feature. Once you make your changes, check
the feature in to update the data store with your changes and make the feature
available to others again.

When you edit a feature, that feature is automatically checked out and locked
for editing by anyone else (if the data format supports such locking). Other
people can view the feature source, but they cannot change it until you check
it back in.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To edit an object

1 If you closed your finished map from the previous lesson, reopen it and
display the Data Table for the Parcels layer.

■ Click  ➤ Open  ➤ Drawing.

■ Locate the build_map1.dwg file.

■ Select it, and click Open.

■ In the Display Manager, click the Parcels layer and click Table.

■ Zoom to a parcel on Villa Drive.

The parcel is checked out
automatically and displays grips.
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2 Turn off the automatic update option. Click Feature Edit tab ➤ Edit Set

panel ➤ Automatic Update. 

NOTE You cannot undo this operation.

3 Use the grips to change the size and shape of the parcel, just as you would
any AutoCAD polygon.

4 Click Feature Edit tab ➤ Edit Set panel ➤ Check In. 

To continue this tutorial, go to Exercise 3: Update information for the edited
feature (page 66).

Exercise 3: Update information for the edited feature
Use the Data Table (page 410) to find the entry for the parcel you edited, and
change its information. When you edit a feature (whether in the map or in
the Data Table), you automatically check it out. Check in the feature to update
its source with your changes.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To edit the feature properties

1 Redisplay the Data Table for the Parcels layer.

Select the Parcels layer and click Table, or right-click the Parcels layer and
click Show Data Table.

2 In the Data Table (page 410), select Autogenerated_SDF_ID from the Filter
By list and enter the parcel ID number you noted earlier (the one you
edited).

3 Click Apply Filter to filter the list and see the parcel entry.

4 Change the area of the parcel and close the Data Table.

5 Update the information in the data source. Click Feature Edit tab ➤ Edit

Set panel ➤ Check In. 
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The information is now available to other users.

6 Save your map.

Where you are now

You edited a parcel and updated its data to reflect your changes. You checked
in the feature to update the source file.

To continue this tutorial, go to Lesson 6: Create a Legend (page 67)

Lesson 6: Create a Legend
Create a legend that lists the layers in your map, using a color key that
identifies each one. The legend is an object that you drop into place on your
map.

Fine-tune the legend to show only the layers you want, in the order in which
you want them. This order might be different from your draw order.

Exercise 1: Insert a legend object
Insert a legend anywhere on your map.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To insert a legend in your map

1 If it is not still open, open your finished map from the previous lesson.

■ Click  ➤ Open  ➤ Drawing.

■ Locate the build_map1.dwg file.

■ Select it, and click Open.

2 In the Task Pane (page 416), switch to Display Manager (page 410).

3 Right-click the Parcels layer and click Zoom To Extents.

4 Click Tools  ➤ Create Legend.
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Use the Tools menu in Display Manager to create a legend.

5 In your map, find a blank area for the legend.

6 Click where you want the legend to appear.

Notice that each layer listed in Display Manager (page 410) is displayed in
the legend automatically, with its identifying color. The items are listed
in the order in which they appear in Display Manager.

7 Save your map.

To continue this tutorial, go to Exercise 2: Change the order of items in the
legend (page 68).

Exercise 2: Change the order of items in the legend
The legend reflects the organizational order in your map. You can move items
in Display Manager (page 410) to change their order in your legend. You can
also turn layers off to prevent them from appearing in the legend.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.
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To change the order of items in the legend

1 In the Display Manager menu area, click Groups  ➤ Draw Order.

Notice that the option name changes to Order, to show that you are now
viewing by draw order.

2 Drag an item to a different position.

The change in your legend is not visible yet.

The parcel layer has multiple entries (one for each level in the theme that
you created for it). Notice that the legend also includes the Map Base
layer, which does not belong in a legend.

The default legend includes the
Map Base layer.

3 In Display Manager, clear the check box for the Map Base layer.

4 Click Tools  ➤ Update Legend.

5 Save your map.

Where you are now

You inserted a legend, and then removed the reference to the Map Base layer
from the legend. The legend now reflects the new organizational order.

To continue this tutorial, go to Lesson 7: Publish Your Map (page 69)

Lesson 7: Publish Your Map
Publish a georeferenced map in DWF format, for eventual display on the Web
or on an intranet. DWF (Design Web Format™) is an open, secure file format
developed by Autodesk for sharing engineering design data. DWF files are
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highly compressed, so they are smaller and quickly transmitted and viewed.
This format can include object data or feature attributes, as well as the graphical
elements of your map.

If you assigned a coordinate system to all model-space maps in your DWF file,
the publishing operation automatically converts the coordinate information
to latitude/longitude coordinates. Autodesk Design Review 2008 can
automatically navigate to a specific location when you enter coordinates. It
displays coordinates of any location in the map when you move your mouse
over that location. With computers integrated with a GPS device using the
NMEA 0183 protocol, field workers can center the map to coordinates provided
by that device. As a result, the “my coordinates” icon appears within the map.

Files in DWF format can be displayed using Autodesk® Design Review. For
product information and a download link for this product, refer to the
Autodesk Design Review page on the Autodesk web site. Autodesk Design
Review is the latest version of the Autodesk® DWF Viewer. It includes the
ability to measure, mark up, stamp, review, convert, and aggregate DWF
content.

Exercise 1: Specify attributes to include
Set DWF publishing options that specify the attribute information to publish
with your map.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To set publishing options

1 Open your finished map from the previous lesson.

■ Click  ➤ Open  ➤ Drawing.

■ Locate the build_map1.dwg file.

■ Select it, and click Open.

2 In the Tool-based Ribbon Workspace, click Output tab ➤ Export To
DWF/PDF panel ➤ Export To DWF/PDF Options (MAPDWFOPTIONS).

3 In the Map Information dialog box, select Publish Map Information.
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4 In the Map Information dialog box, expand the items in the list and
select the Roads and Parcels items.

You can include and exclude information at any
level.

Notice that when you select Roads, everything under Roads is
automatically selected.

5 To publish the information to an XML file, click the file icon and specify
a location for the published file. Click Save.

The DWF Publish operation uses the XML file.

6 Click OK.

To continue this tutorial, go to Exercise 2: Publish to DWF (page 72).
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Exercise 2: Publish to DWF
Publishing to DWF is like printing to a file. You set up plotting parameters,
as if printing to a physical plotter. You apply those settings to your layout,
which is like a plotting template. You display a layout tab for your map to
activate the layout.

Each view of your map (which initially includes model space and two default
layout spaces) is considered a sheet in your map sheet set. Learn more about
sheet sets in the Help.

Use the Publish dialog box to specify the sheets to publish and whether to
publish to a plotter or a file.

NOTE This exercise uses the build_map1.dwg map you created and modified in
the previous exercises.

To publish to DWF

1 Save your map.

You cannot plot or publish without saving first.

2 Click Output tab ➤ Plot panel ➤ Plot. 

3 In the Plot dialog box, select a Printer/Plotter.

4 Click Apply To Layout, and then click Cancel.

Printer/plotter settings are applied to your publishing job without sending
the job to a plotter or printer.

5 If Model and Layout tabs are not displayed just below your map,

right-click  in the status area at the bottom of the application window.
Click Display Model And Layout Tabs.

6 Click the Layout 1 tab.

7 Click  ➤ Publish.

Do not choose an option from the Publish submenu. Click the word
Publish in the application menu.

8 In the Publish dialog box, in the Sheets To Publish list, make sure that
only the sheets you want are selected.
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For example, if another map is open, its model and layout views appear
in the list. The default Layout2 view of the current map also appears.
Select any undesired entries (such as Layout2) and click Remove Sheets.

9 Under Publish To, click DWF.

10 Click Publish Options and click Layer Information (under DWF Data
Options). On the pull-down menu in this field, click Include.

This setting publishes each layer in your map to a separate layer in DWF.
In Design Review, you can turn the display of these layers on and off
independently.

11 Click OK to close the Publish Options dialog box.

12 In the Publish dialog box, click Publish (at the bottom of the window).

13 Specify a location and a name for the published file and click Select.

14 If you are prompted to save the sheet list, click No.

15 You might see a message telling you that the job is processing in the
background. Click OK to dismiss the message.

The files needed by Autodesk Design Review are published to the file you
specified. Monitor the progress of the publishing operation by holding
your cursor over the animated icon in the lower-right corner.

When the job is complete, a bubble appears in the bottom, right-hand
corner of the window. Click the link in the bubble to view any warnings
or errors. Close the window when you are done.

Where you are now

You have published your map to a DWF file, which can be displayed in
Autodesk Design Review.

To continue this tutorial, go to Lesson 8: Branch Out - Find Data Sources (page
73)

Lesson 8: Branch Out - Find Data Sources
As you go on to create your own maps, you can add data to enhance them.
For example, you can add surface rasters with elevation data for your area, or
generic vector symbols showing parks, hydrants, or other items.
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The Autodesk geodata portal has access to multiple data providers. In this
lesson, you explore the geodata portal. Examine the sample data provided
with AutoCAD Map 3D by the data providers who have partnered with
Autodesk.

Exercise 1: Explore the Data Portal - DigitalGlobe®

In this exercise, you visit the geodata portal and view the data available from
DigitalGlobe®.®

To explore the DigitalGlobe data

1 In your browser, go to http://www.autodesk.com/geodata.

2 On the geodata site, click Go Now for DigitalGlobe.

3 Click the image of the Verrazano Narrows Bridge in Brooklyn, New York
to see the high-resolution satellite photo.

DigitalGlobe® has an exhaustive library of high-quality Earth
imagery available for purchase.

4 To try out some of the DigitalGlobe data, click Download Your Free Trial
and follow the directions on the screen.
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Once you install DigitalGlobe and you start AutoCAD Map 3D, a new
ImageConnect menu appears on the menu bar.

To continue this lesson, go to Exercise 2: Explore the Data Portal - NAVTEQ™

(page 75).

Exercise 2: Explore the Data Portal - NAVTEQ™

In this exercise, you view the data available from NAVTEQ™.

To explore the NAVTEQ data

1 Close the DigitalGlobe® window and display the Geospatial Solutions
page in your browser window.

If you are not already at the Geospatial Solutions page, in your browser,
go to http://www.autodesk.com/geodata.

2 On the Geospatial Solutions page, click Go Now for NAVTEQ.

3 Click the image of the city of Redding, California, to see the digital map.

NAVTEQ™ street geometry includes street networks, block address ranges, a Point of
Interest (POI) database, administrative area boundaries, railroads, hydrological data,
and land use information.

4 To try out some of the NAVTEQ data, click Download Free Sample and
follow the directions on the screen.

To continue this lesson, go to Exercise 3: Explore the Data Portal - Intermap™

(page 76).
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Exercise 3: Explore the Data Portal - Intermap™

In this exercise, you view the data available from Intermap™.

To explore the Intermap data

1 Close the NAVTEQ™ window and display the Geospatial Solutions page
in your browser window.

If you are not already at the Geospatial Solutions page, in your browser,
go to http://www.autodesk.com/geodata.

2 On the Geospatial Solutions page, click Go Now for Intermap.

3 Click the Digital Elevation Models image to see information about DEM
topographic layers.

Intermap™ provides digital surface models,
digital terrain models, orthorectified radar
images, and color orthorectified radar images.

4 Close the browser windows.

To continue this lesson, go to Exercise 4: Try out the sample data (page 76).

Exercise 4: Try out the sample data
Sample data from each of these providers is included with AutoCAD Map 3D.
In this exercise, you add some of this data to a map of the city of Munich,
Germany
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To work with the sample data

1 Create a map.

■ Click  ➤ New  ➤ Drawing.

■ In the Open dialog box, select the map2d.dwt template.

■ In Map Explorer, right-click Current Drawing and click Coordinate
System.

■ In the Assign Global Coordinate System dialog box, for Code, set the
coordinate system to LL84 and click OK.

2 Connect to a surface graphic.

■ In Display Manager, click Data  ➤ Connect To Data.

■ In the Data Connect window, under Data Connections By Provider,
click Add Raster Image or Surface Connection.

■ Click the file icon next to Source File Or Folder.

■ In the Open dialog box, navigate to the Intermap Munich_dtm.dem
raster file.

■ Select the file and click Open.

■ In the Data Connect window, click Connect.

■ In the Data Connect window, select the image and click Add To Map.

3 Style the surface image.

■ In Display Manager, select the surface layer.

■ On the status bar at the bottom of the application window, click the
down arrow next to Vertical Exaggeration.

■ Increase the vertical exaggeration to 25x.

■ In Display Manager, with the surface layer still selected, click Style.

■ In the Style Editor, click the down arrow in the Style cell and select
Theme.

■ In the Theme dialog box, under Specify A Theme, select Palette and
select the Contour Palette.

■ Click OK, then click Apply and close the Style Editor.
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4 Connect to a satellite image of Munich.

■ If the Data Connect window is not displayed, in Display Manager,
click Data  ➤ Connect To Data.

■ In the Data Connect window, under Data Connections By Provider,
click Add Raster Image or Surface Connection.

■ Click the file icon next to Source File Or Folder.

■ In the Open dialog box, navigate to the DigitalGlobe_munich.ecw raster
file.

■ Select the file and click Open.

■ In the Data Connect window, click Connect.

■ In the Data Connect window, select the image and click Add To Map.

5 Style the satellite image.

■ In Display Manager, right-click the image layer and click Zoom To
Extents.

■ In Display Manager, with the image layer still selected, click Style.

■ In the Style Editor, click Transparent.

■ Click Select and select a dark gray color in the raster image to be
transparent.

6 Connect to a Navteq SHP file to add points representing restaurants.

■ In Display Manager, click Data  ➤ Connect To Data.

■ In the Data Connect window, under Data Connections By Provider,
click Add SHP Connection.

■ In the Data Connect window, click the file icon next to Source File
Or Folder.

■ In the Open dialog box, navigate to the Navteq Restrnts.shp file.

■ Select the file and click Open.

■ In the Data Connect window, click Connect.

■ Select Restrnts and click Add To Map.
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7 Style the points to use symbols.

■ In Display Manager, select the Restrnts layer and click Style.

■ In the Style Editor, click  in the Style cell.

■ In the Style Point dialog box, click  next to Symbol.

■ In the Select A Symbol dialog box, click  next to Symbol Library
and open the Map - Points of Interest.dwg file.

■ Select the Restaurant symbol.

■ If you want, in the Style Editor, change the Fill Color and Edge Color
of the points so you can see them better.

■ Click OK and close the Style Editor.

Where you are now

You explored the geodata portal. You used sample data from Autodesk partner
providers to create a map of Munich using a surface with elevation, a satellite
photo, and symbols representing restaurants.
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Tutorial: Moving From
AutoCAD to AutoCAD Map
3D

About The AutoCAD/AutoCAD Map 3D Tutorial
AutoCAD Map 3D is built on AutoCAD and includes all AutoCAD functionality.
Map files are saved in DWG format, just like regular AutoCAD drawings.
However, AutoCAD Map 3D adds features that are not available in AutoCAD.
Try out these additional features in this tutorial.

Lesson 1: Prepare Drawings for Use With AutoCAD
Map 3D

If you are new to AutoCAD Map 3D, your drawings might not be ready to take
advantage of the features in AutoCAD Map 3D. This lesson covers some ways
to prepare your data.

Digitize and georeference paper drawings

If your data is still stored in paper drawings, you can use AutoCAD Raster Design
to digitize them and save them in AutoCAD drawing format.

You can also use AutoCAD Raster Design to georeference your data.
Georeferencing aligns the drawing objects to real-world locations. Georeferenced
drawings take advantage of many AutoCAD Map 3D features, such as combining
data from multiple sources.

3
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This tutorial does not cover the required steps in AutoCAD Raster Design to
digitize and georeference drawings. Consult the AutoCAD Raster Design
documentation for this information.

For more information about AutoCAD Raster Design, see
http://www.autodesk.com/rasterdesign.

Set up a drive alias

When you edit drawings in AutoCAD Map 3D, others can work on those same
drawings at the same time. Individual objects are locked when you work on
them, so one person can edit part of a drawing while someone else works on
a different section.

To use this feature, follow the procedures in this lesson to set up a drive alias.

Georeference existing drawings

To incorporate existing drawings into maps, the drawings must be
georeferenced. Otherwise, the drawing objects do not align with features in
larger maps.

Maps use coordinate systems to describe the position of objects using their
longitude and latitude relative to a particular datum (an agreed-upon reference
point). Once you assign a coordinate system to a map, you can add data to
that map from drawings that use different coordinate systems. AutoCAD Map
3D automatically converts the data when you add it to the map, so everything
lines up.

However, if the incoming data does not have a coordinate system assigned to
it, there is no way to convert it. Instead, designate the position of the data
yourself.

This lesson shows you how to align objects in a non-georeferenced drawing
with features in a drawing with a known coordinate system.

Exercise 1: Set up a drive alias
A drive alias allows multiple users to use the same pathname for a drawing
stored on a shared drive. It allows each user to map that drive to a different
drive letter.

To define a drive alias

1 In AutoCAD Map 3D, in the Task pane, click the Display Manager tab.
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2 In Display Manager, click Data  ➤ Add Drawing Data  ➤ Attach Source
Drawings.

3 In the Define/Modify Drawing Set dialog box, click Attach.

4 In the Select Drawings to Attach dialog box, click  (Create/Edit Aliases).

5 In the Drive Alias Administration dialog box, type a name for the alias.

The name must use only alphanumeric characters (including hyphen
and underscore), contain no spaces or colons, and start with a character.
For example, you can call the alias TutorialData.

6 Specify a path for the new alias.

In the Drive Alias Administration dialog box, specify a name for the alias and the actual
path it represents.

In this example, use the path to the folder where you copied your tutorial
files.

7 Click Add, and then click Close.

8 Click OK in the remaining two dialog boxes.

The drawing location is now mapped to your drive alias. You can now
open drawings in that folder without defining any further aliases.
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To continue this tutorial, go to Exercise 2: Georeference source drawings (page
84).

Exercise 2: Georeference source drawings
You can query objects from one drawing into another drawing of the same
geographical area, even if the drawings use different coordinate systems. The
queried objects are automatically converted to the assigned coordinate system.
If a drawing does not use a known coordinate system, align the objects to the
map manually.

In this exercise, you georeference drawing objects by adding them to a map
with a known coordinate system.

In practice, you can obtain such a map from the local county or municipality.
For example, for a drawing of city parcels, obtain a digital version of an assessor
map of that city. Make sure that you know the coordinate system used to
create that map. We refer to this map as the “target map.” In this example,
you connect to an SDF data store containing parcel information.

You use the Rubber Sheet command to align the drawing objects with known
locations in the target map.

To georeference drawing objects

1 Create a drawing and assign a coordinate system.

■ Click  ➤ New  ➤ Drawing. Select the map2d.dwt template and
click Open.

■ Assign a coordinate system. Switch to Map Explorer in the Task Pane
(page 416). Right-click Current Drawing and click Coordinate System.
Enter CA-I and click OK.

2 Connect to a parcel data store of the same geographical area.

In this example, connect to the tutorial sample file PARCELS.SDF, which
uses the coordinate system CA-I.

■ Click Data  ➤ Connect to Data.

■ Under Data Connections By Provider, select Add SDF Connection.

■ Click the file icon next to Source File.
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■ Navigate to the folder where you copied the sample files and select
PARCELS.SDF. Click Open.

■ Click Connect to add the parcel data file as a data source.

■ Under Add Data To Map, select Parcels.

■ Click Add To Map.

3 Open the drawing containing your drawing objects.

In this example, open the sample tutorial drawing subdivision_block.dwg,
which has no coordinate system.

4 In the subdivision_block.dwg drawing, select and copy the objects to align.

The objects in subdivision_block.dwg are defined as a block.

■ Click anywhere on the block perimeter to select all the objects.

■ Click Home tab ➤ Clipboard panel ➤ Copy drop down ➤ Copy Clip

5 In the target map, paste the objects into the blank area in the center of
the drawing.

■ Switch the current window to the parcels drawing you created.

■ Zoom into the large empty area in the center of the drawing.

■ In the empty area, right-click and select Paste.

■ Click an insertion point for the block.
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Paste the subdivision block in the empty space. Find the parcel to which the subdivision
aligns. In this illustration, the parcel is red (but it is not red in the sample file).

6 Find the points that the target map and the drawing objects have in
common.

For example, if your drawing represents new parcels, find the development
that contains those parcels. Find at least two common points.

In the parcels drawing you created, the parcel you want is to the left of
the empty area. In the illustration above, it is red.

7 Use the Rubber Sheet command to align your drawing objects with the
known objects in the map.

■ Zoom in as close as you can, while still displaying the target area and
the subdivision drawing.

■ Click Tools tab ➤ Map Edit panel ➤ Rubber Sheet

■ When prompted on the command line for Base Point 1, click the first
common point in your drawing object block.

■ When prompted on the command line for Reference Point 1, click
the corresponding point in the target map.

■ For this tutorial, specify four reference points. When you are finished,
press Enter.
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The order in which you select the points and the spread of the points
affects the results. For complex curved figures, more vertices result in
a more accurate alignment.

■ Select the object to align it with the reference area.

■ Enter s to select the objects to rubber sheet.

■ Click the subdivision block to select it.

■ Press Enter to complete the process.
For more information about this procedure, and to see a video of
the rubber sheet procedure, see Georeference parcels by rubber
sheeting.

Where you are now

You created a drive alias for drawings stored on a shared drive. You
georeferenced drawing objects, using the Rubber Sheet command to align
them with known locations.

To continue this tutorial, go to Lesson 2: Clean Up Your Drawings (page 87).

Lesson 2: Clean Up Your Drawings
Drawings can contain various kinds of errors that make accurate mapping
difficult. For example, digitizing from a paper map can produce lines that
were actually creases in the paper.

Drawings edited by multiple people can contain duplicate lines or objects.
Finding duplicate objects in the same location can be nearly impossible without
the right tools.

If lines in your drawing do not connect precisely at endpoints, data that
appears to be precise can actually be inaccurate. Locating these issues visually
can take hours.

AutoCAD Map 3D has an option called Drawing Cleanup to help you correct
common geometry errors. In this lesson, you clean up a street map by deleting
duplicate objects and extending undershoots. It is best to perform each
operation separately, so you can see the result of each operation before
performing the next one.

Optionally, you can use a cleanup profile to automate the drawing cleanup
process with scripts or to share settings with other users.
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Exercise 1: Delete duplicates
If the endpoints of lines or geometry fall within a specified tolerance, they
are considered duplicates. Duplicates can be impossible to see, even when
zoomed in close. Drawing Cleanup can find such instances and you can decide
whether to delete them. In this exercise, you clean up a street map by deleting
duplicate objects.

To delete duplicates

1 Before you begin this tutorial, see Lesson 1: Get Ready to Use the Tutorials
(page 1).

2 Navigate to and open the sample tutorial file Street_Centerlines.dwg.

3 Zoom to the extents of the drawing. In the Tool-based Ribbon Workspace,
click View tab ➤ Navigate panel ➤ Zoom Drop-down ➤ Extents.

4 Click Tools tab ➤ Map Edit panel ➤ Clean Up. 

5 Specify which objects to include in the cleanup operation. In this case,
include all objects.

■ In the Drawing Cleanup - Select Objects dialog box, under Objects to
Include In Drawing Cleanup, choose Select All.

■ Make sure there is an asterisk (*) in the Layers box.

Select all objects to include in the cleanup operation.
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■ Click Next.

6 In the Drawing Cleanup - Select Actions dialog box, do the following:

■ Select Delete Duplicates and click Add.

■ In the Selected Actions list, select Delete Duplicates, and under
Cleanup Parameters, enter 2 for Tolerance.
All objects within two drawing units of each other are considered
duplicates. AutoCAD Map 3D does not use a predefined system of
unit measure such as meters or inches. For example, a distance of one
unit can represent one centimeter, one foot, or one mile in real-world
units.

Each operation has its own parameters.

■ Under Options, select Interactive to review errors one by one.

■ Click Next.

7 In the Drawing Cleanup - Cleanup Methods dialog box, do the following:

■ Under Cleanup Method, choose Modify Original Objects.

■ Click Next.

8 In the Drawing Cleanup - Error Markers dialog box, which specifies the
blocks and colors for error markers, click Finish.
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Drawing Cleanup locates the errors in the drawing and displays the
Drawing Cleanup Errors dialog box. The dialog box groups the errors by
error type. Delete Duplicates is highlighted.

To review errors before fixing them, expand Delete
Duplicates. To fix all duplicates at once without
reviewing them, select Delete Duplicates without
expanding it and click Fix All.

9 In the Drawing Cleanup Errors dialog box, do the following:

■ Expand Delete Duplicates to see how many duplicate objects were
detected.

■ Click Error 1 of 3.
In the map, the first error displays a temporary marker so you can
find it easily.
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■ Click Fix to correct this error and proceed to the next error.

■ Continue clicking Fix until you have deleted all duplicate objects.

To continue this tutorial, go to Exercise 2: Extend undershoots (page 91).

Exercise 2: Extend undershoots
Undershoots are objects that come within the specified tolerance radius of
each other, but do not meet. Undershoots can occur due to inaccurate
digitizing or when converting scanned data. Use the Extend Undershoots
cleanup action to locate and correct undershoots.

If possible, one object is extended to cross the other. It maintains the same
direction and snaps to a point on the object. If no node exists, the operation
creates one at the intersection.

Two objects that pass within the specified tolerance snap together, as long as
the snap does not change their direction. If no node exists at that point, the
operation creates one.

NOTE This exercise uses the Street_Centerlines.dwg you used in Exercise 1: Delete
duplicates (page 88).

To extend undershoots

1 If the Street_Centerlines.dwg is not still open, reopen it.

2 Click Tools tab ➤ Map Edit panel ➤ Clean Up. 
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3 In the Drawing Cleanup - Select Objects dialog box, do the following:

■ Under Objects to Include In Drawing Cleanup, choose Select All.

■ Make sure there is an asterisk (*) in the Layers box.

■ Click Next.

Select all objects to include in the cleanup operation.

4 In the Drawing Cleanup - Select Actions dialog box, do the following:

■ Select Extend Undershoots and click Add.

■ In the Selected Actions list, select Extend Undershoots and enter 10
for the Tolerance.

■ Under Options, select Interactive to review errors one by one.

■ Click Next.

5 In the Drawing Cleanup - Cleanup Methods dialog box, do the following:

■ Under Cleanup Method, choose Modify Original Objects.

■ Click Finish.
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6 In the Drawing Cleanup Errors dialog box, Extend Undershoots is
highlighted. Do the following:

■ Expand Extend Undershoots to see how many short objects were
detected.

■ With Extend Undershoots still highlighted, click Mark All to place
markers on all detected short objects.

The errors are not corrected, but they are marked. You can
find them later to review them more closely.

7 Zoom from within the Drawing Cleanup Errors dialog box to examine
errors without leaving the interactive drawing cleanup process. Do the
following:

■ Click Error 1 of 2.

■ Clear the Auto Zoom check box.

■ Under Zoom %, enter a higher value, such as 400. Click Zoom.

■ Click Next to zoom to Error 2 of 2.

■ When you are finished examining the errors, restore the Zoom % to
100.

■ Click Zoom.

■ Select the Auto Zoom check box again.

Zooming helps you see other markers that are farther apart.

8 Close the Drawing Cleanup dialog box and save the drawing.
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To continue this tutorial, go to Exercise 3: Use cleanup profiles (optional)
(page 94).

Exercise 3: Use cleanup profiles (optional)
You can save your settings for Drawing Cleanup in a profile and use them
again later. Profiles are useful when you automate the drawing cleanup process
with scripts or share settings with other users. Drawing Cleanup profiles are
saved as *.dpf files.

NOTE If you do not plan to use Drawing Cleanup profiles, you can skip this exercise
and go on to Lesson 3: Add Drawing Objects to a Map (page 96).

Drawing Cleanup profiles include all the options specified in the Drawing
Cleanup dialog boxes:

■ Layer names used for object selection

■ Cleanup actions and settings

■ Cleanup methods

■ Error marker settings (if any)

Drawing Cleanup profiles do not include the actual objects selected on the
specified layers.

In this exercise you create, save, and edit a Drawing Cleanup profile.

To create and save a Drawing Cleanup profile

1 Navigate to and open the tutorial sample file Street_Centerlines.dwg.

2 Click Tools tab ➤ Map Edit panel ➤ Clean Up. 

3 In the Drawing Cleanup - Select Objects dialog box, do the following:

■ Under Objects To Include In Drawing Cleanup, make sure Select All
is selected.

■ Click Next.

4 In the Drawing Cleanup - Select Actions dialog box, do the following:

■ Under Cleanup Actions, select the actions for your profile.
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Select only Delete Duplicates. Since Drawing Cleanup is most effective
when each action is run separately, you can create a separate profile
for each action you use regularly.

■ Click Add to add Delete Duplicates to the Selected Actions window.

■ Click Save.

5 In the Save Drawing Cleanup Profile dialog box, enter a folder and a
name for the profile.

For example, create a folder called DrawingCleanupProfiles and name this
profile DeleteDuplicates.dpf.

6 Click Save As and specify a name and location.

7 Click Finish.

8 If the Drawing Cleanup Errors dialog box is displayed, click Cancel.

To use a saved profile

1 Open the drawing to clean.

NOTE Do not use the drawing you used in the previous exercises. It has
already been corrected, so the loaded profile does not produce any further
results. If desired, replace that drawing with the original (uncorrected) sample
drawing from the installed tutorial sample data folder.

2 Click Tools tab ➤ Map Edit panel ➤ Clean Up. 

3 In the Drawing Cleanup dialog box, click Load.

4 Select the profile and click Open.

5 In the Drawing Cleanup dialog box, click Finish.

6 Correct any errors.

Where you are now

You used the Drawing Cleanup option to remove duplicate lines and geometry
and undershoots. You created a profile for use with other drawings.

To continue this tutorial, go to Lesson 3: Add Drawing Objects to a Map (page
96).
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Lesson 3: Add Drawing Objects to a Map
When you add drawing objects to a map, you use a query (page 414) to specify
the objects you want. In this lesson, you add objects from multiple source
drawings to a single map. You use three types of queries:

■ Quick View — Displays all data in the attached drawings, but does not
retrieve any objects. When you refresh the screen, the objects disappear.

■ Preview query mode — Displays objects in the attached drawings that match
criteria you specify, but does not retrieve them. When you refresh the screen,
the objects disappear.

■ Draw query mode — Retrieves objects that match criteria you specify
(copies the objects into the current drawing). You can manipulate, edit,
and save the objects (to their attached drawings, to the current drawing,
or to a new drawing).

Attach multiple source drawings

Attaching a drawing to a map does not add any objects to the map. It makes
the drawing data available to the map. You can then preview or add the objects.

Preview drawing objects

Use Quick View or a Preview mode query to display objects in an attached
drawing temporarily. For example, you can use a location preview query to
see all objects that fall within the radius of a circle that you draw.

These objects cross a circle in a location query.
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Use queries to add objects

Use Draw mode queries to retrieve information in attached drawing files and
add them to your drawing. In this lesson, you use two types of Draw mode
queries:

■ Property queries — Retrieve objects based on properties such as color,
linetype, or layer.

■ Location queries — Retrieve objects based on location conditions such as
boundaries and buffer distances.

Alter object properties with a query

A special type of query allows you to alter the properties of the objects as you
add them to the map. For example, you can break out objects into layers,
changing the layer property for the objects as you add them to your map.

Exercise 1: Attach source drawings
In this exercise, you open a drawing for the city of Redding, California. You
attach three source drawings that contain parcel, sewer, and drainage
information. Even though the drawings are attached, no objects appear until
you perform a Quick View or a Preview mode query.

To attach drawings

1 If you have not already done so, see Lesson 1: Get Ready to Use the
Tutorials (page 1).

2 Navigate to and open the tutorial sample file Redding.dwg.

3 On the Map Explorer tab of the Task pane, right-click the Drawings folder.
Click Attach.
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Attach drawings from the Map Explorer tab
of the Task pane.

4 In the Select Drawings to Attach dialog box, do the following:

■ Navigate to the location where you stored your tutorial sample files.

■ Press and hold the Ctrl key and select the following files: Drainage,
Parcel, and Sewer.

■ Click Add.

■ Click OK.
The parcel, sewer, and drainage drawings are now attached to the
Redding.dwg file, but no drawing objects have been added yet.

To continue this tutorial, go to Exercise 2: Preview attached drawings with
Quick View (page 98).

Exercise 2: Preview attached drawings with Quick View
Quick View temporarily displays all data in the attached drawings in your
drawing file. The drawing objects are not copied into the drawing.

NOTE This exercise uses the Redding.dwg map you created and modified in Exercise
1: Attach source drawings (page 97).
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To preview attached drawings with Quick View

1 On the Map Explorer tab of the Task pane, right-click the Drawings folder.
Click Quick View.

2 In the Quick View Drawings dialog box, do the following:

■ Select all three drawings.

■ Select the Zoom to the Extents of Selected Drawings check box.

■ Click OK.

Quick View displays the contents of the attached
drawings without creating any objects in the
Redding.dwg file.

3 At the Command prompt, enter Regen.

The temporary objects are cleared from the screen.

4 Click  ➤ Save As  ➤ AutoCAD Drawing.

5 In the Save As dialog box, navigate to the folder you created for your
tutorial maps. Then click Save.
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To continue this tutorial, go to Exercise 3: Preview drawing objects with a
property query (page 100).

Exercise 3: Preview drawing objects with a property
query

A property query retrieves objects from attached drawings based on their color,
linetype, layer, or other standard AutoCAD properties. In this exercise, you
use a property query to preview drawing objects based on their layer property.

NOTE This exercise uses the Redding.dwg map you created and modified in the
Exercise 1: Attach source drawings (page 97).

To preview drawing objects using a property query

1 If the Redding.dwg map from the previous exercises is not still open, reopen
it.

2 In Map Explorer, under Current Drawing, right-click Current Query, and
then click Define.

3 In the Define Query of Attached Drawing(s)  dialog box, under Query
Type, select Property.

4 In the Property Condition dialog box, do the following:

■ Under Select Property, select Layer.

Select Layer as the property condition. Only objects on the layers you
specify are added to the map.
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■ Click Values.

5 In the Select dialog box, select the PARCELS and SEWER_PIPES layers.
Click OK.

6 In the Property Condition dialog box, under Value, make sure that the
two layers you selected are listed. Click OK.

Specify which layers to use to determine the objects that are added.

7 In the Define Query of Attached Drawing(s) dialog box, do the following:

■ Under Query Mode, make sure that Preview is selected.
Preview mode displays the objects without actually creating them in
your drawing.

■ Click Execute Query.

8 In the Tool-based Ribbon Workspace, click View tab ➤ Navigate
panel ➤ Zoom Drop-down ➤ Extents.

The objects on the PARCELS and SEWER_PIPES layers are displayed in
the drawing window. They are not created in the drawing because you
used the Preview Query Mode.
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The objects that match the criteria appear in the drawing.

9 Use a named view (a predefined view of your map) to see which drawing
objects the query retrieved.

■ In the Tool-based Ribbon Workspace, click View tab ➤ Views
panel ➤ Named Views.

■ In the View Manager, expand Model Views in the tree view.

■ Select PARCELS in the tree view. Click Set Current, and then click OK.
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Only the parcels (polygons with black outlines) and the sewer
pipes (green lines) are displayed in the drawing area.

10 Do not save or close the drawing.

To continue this tutorial, go to Exercise 4: Retrieve objects with a property
and location query (page 103).

Exercise 4: Retrieve objects with a property and location
query

In this exercise, you add location conditions to the property query you defined
in the previous exercise. Then you execute the result as a draw query to display
the information in your drawing.

NOTE This exercise uses the Redding.dwg map you created and modified in Exercise
1: Attach source drawings (page 97).

To combine location and property conditions in a query

1 In Map Explorer, under Current Drawing, right-click Current Query, and
click Define.

2 In the Define Query of Attached Drawing(s)  dialog box, do the following:

■ Under Query Type, make sure And is selected.

■ Click Location.

3 In the Location Condition dialog box, do the following:

■ Under Boundary Type, select Circle.

Exercise 4: Retrieve objects with a property and location query | 103



■ Under Selection Type, make sure Crossing is selected.

Objects that cross the circle you draw are added to
the drawing.

■ Click Define.

4 Click in the center of the drawing and drag your cursor to draw a circle,
as indicated in the following illustration.
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Define the circle for the selection.

5 In the Define Query of Attached Drawing(s)  dialog box, do the following:

■ Under Query Mode, select Draw.

■ Click Execute Query.
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Objects that cross the circle are queried into the Redding
drawing. Because the query mode is Draw, the objects are
copied into the Redding drawing.

6 Press Ctrl + A to select all the objects in the drawing, and then press Delete
to delete them from the drawing.

7 In the Confirm Save Back dialog box, click No.

8 Click  ➤ Save .

To continue this tutorial, go to Exercise 5: Query object data (page 106).

Exercise 5: Query object data
In addition to the geometric properties available in AutoCAD, AutoCAD Map
3D has user-defined properties called object data.

You can use object data as you would regular AutoCAD properties. For example,
use object data:

■ As the basis of a query

■ As the content for annotation

■ As the criteria for styling (using themes)

■ When exporting to another data format
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You must have AutoCAD Map 3D to create object data, but anyone who uses
the free Autodesk® Design Review software can view it. For example, a field
worker can view a DWF™ version of a sewer map in Autodesk® Design Review.
To see information about a sewer pipe, the worker holds the cursor over that
pipe. The information is available without obscuring the map itself.

The drawings in this tutorial have object data tables with information already
entered. In this exercise, you use object data (page 413) as a query condition.
In a later exercise, you use object data to create feature classes in a new data
format.

NOTE This exercise uses the Redding.dwg map you created and modified in Exercise
1: Attach source drawings (page 97).

To create a query based on object data

1 If the Redding.dwg map from the previous exercise is not still open, reopen
it.

2 In Map Explorer, under Current Drawing, right-click Current Query, and
click Define.

3 In the Define Query of Attached Drawing(s)  dialog box, do the following:

■ Under Current Query, click Clear Query.

■ Under Query Type, click Data.

4 In the Data Condition dialog box, do the following:

■ Select Object Data.

■ Under Tables, select SEWER_PIPES.

■ Under Object Data Fields, select PIPESIZE.

■ In the Expression area, under Operator, select >. Under Value, enter
8.
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Specify sewer pipes that are more than 8
inches in diameter.

■ Click OK.

5 In the Define Query of Attached Drawing(s)  dialog box, under Options,
click Zoom Ext.

6 In the Zoom Drawing Extents dialog box, click OK.

7 In the Define Query of Attached Drawing(s) dialog box, under Query
Mode, select Preview, and click Execute Query.
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Only the sewer lines that are greater than 8 inches in diameter
are displayed.

8 To create an object data index to improve performance for object data
queries, leave the drawing open.

To continue this tutorial, go to Exercise 6: Create an object data index
(optional) (page 109).

Exercise 6: Create an object data index (optional)
An object data index speeds up drawing queries on drawings that contain
object data. The index is automatically updated each time you save changes
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to a drawing. In this exercise, you create an object data index for the
Redding.dwg drawing file.

NOTE This exercise uses the Redding.dwg map you created and modified in Exercise
1: Attach source drawings (page 97).

To create an object data index

1 If the Redding.dwg map is not still open, reopen it.

2 On the Map Explorer tab of the Task pane, right-click the Drawings folder.
Click Maintenance.

3 In the Drawing Maintenance dialog box, do the following:

■ Click Select All.

■ Click Drawing Index.

4 In the Index Maintenance dialog box, do the following:

■ Select all the Generate Index options except EED.

Select all the options on the left except EED.

■ Under Generate Index, click Object Data.

5 In the Generate Object Data Index dialog box, do the following:

■ Under Object Data Table, select DRAINAGE_INLETS.

■ Click Select All to select all the object data fields.

■ Select each of the remaining data tables listed under Object Data Table
and select all their data fields in the same way.
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Select a data table, then select its data
fields.

■ Click OK when you are finished.

6 In the Index Maintenance dialog box, click OK.

7 In the Confirm dialog box, click OK.

8 In the Drawing Maintenance dialog box, click Close.

The indexes are created. As you work with your drawings, repeat this
procedure periodically to update and recreate the indexes.

9 Click  ➤ Save .

Where you are now

You used Quick View and Preview queries to look at objects in attached
drawings. You used Draw queries to add objects from attached drawings to
the current drawing. You created an object data index to improve the
performance of data queries.

To see the effect of the object index on performance, repeat Exercise 5: Query
object data (page 106) with the new index you created.

To continue this tutorial, go to Lesson 4: Add Raster Images (page 112).
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Lesson 4: Add Raster Images
Maps can contain more than drawing objects. For example, you can add
graphics.

In this lesson, you insert a raster (bitmapped) graphic and display it behind
the other objects in your map.

You also modify the image in your map. Your edits do not change the original
image file, but only the way the map displays it. In this lesson, you change
the brightness and contrast. You also clip the image, to display only part of
it.

NOTE For a tutorial on adding an FDO raster image through Data Connect, see
Exercise 5: Add a raster image (page 45) in the Building a Map tutorial.

Exercise 1: Insert a raster image
Aerial and satellite photographs often contain information about their location
and scale. This information makes the images “georeferenced.” AutoCAD
cannot use this georeferencing information, so it cannot properly position
the imagery, but AutoCAD Map 3D can.

In this exercise, you insert a digital raster graphic (DRG) of Redding, California,
into a drawing of the same city. The information in the associated TIFF world
file (TWF) allows you to locate and scale the image correctly.

NOTE While it is not required for this tutorial, you can download AutoCAD Raster
Design Object Enabler for AutoCAD Map 3D 2009 from
http://www.autodesk.com/rasterobjenabler. This free utility supports many raster
image formats that Data Connect does not support.
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Raster images provide context for drawing objects, like roads.

To insert a raster image

1 If you have not already done so, see Lesson 1: Get Ready to Use the
Tutorials (page 1).

2 Open the tutorial sample file CITY.dwg.

3 Click Home tab ➤ Data panel ➤ Insert An Image. 

4 In the Insert Image dialog box, do the following:

■ Navigate to the location where you stored your tutorial sample files.

■ In the Files Of Type box, select Tagged Image File Format (*.tif,*.tiff).

■ In the list of images, select REDDING_DRG.tif.

■ Click Information to display the file size, creation date, and other
information, as well as a preview of the image.
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Information displays a preview and image statistics.

■ Select Modify Correlation.

■ Click Open.

5 In the Image Correlation dialog box, do the following:

■ Click the Source tab if it is not already current.
The Correlation Source is a World File called REDDING_DRG.tfw. It
is stored in the location where you copied your tutorial sample files.

The data in the world file determines the Insertion Point X and Y
values under Insertion Values. These values georeference the image,
so it is correctly positioned in the drawing.
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NOTE You can manually adjust the insertion values as needed.

■ Click OK.
The image is correctly placed in the drawing.

6 Save the file.

■ Click  ➤ Save As  ➤ AutoCAD Drawing.

■ In the Save As dialog box, navigate to the folder you created for your
tutorial maps.

■ Click Save.

To continue this tutorial, go to Exercise 2: View image information (page 115).

Exercise 2: View image information
You can view the file name, size, density, depth, and type for an image you
inserted. You can also view the date the image was created and modified, and
the layer on which it resides.

In this exercise, you view information about the raster image in two ways.
The second method displays some additional information, such as the width
and height of the image.

NOTE This exercise uses the CITY.dwg map you used in Exercise 1: Insert a raster
image (page 112).

To view information about a raster image

1 If the CITY.dwg map is not still open, reopen it.

2 In the drawing area, place your cursor over the image, hold down the
Shift key and click the image.

3 Click Insert tab ➤ Image panel ➤ Image Management. 

4 In the Image Management dialog box, view information about the
REDDING_DRG image.
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The Image Management dialog box displays information about the selected image.

5 Click Close when you are finished.

6 Select the image again.

Place your cursor over the image, hold down the Shift key, and click the
image.

7 Right-click the selected image and click Image ➤ Information.

8 In the Image Information dialog box, view information about the
REDDING_DRG image.
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The Image Information dialog box has some extra image
information.

9 Click Close when you are finished.

To continue this tutorial, go to Exercise 3: Change the display order (page 117).

Exercise 3: Change the display order
In this exercise, you change the display order of the raster image in the drawing
file. You send the raster image to the back, so objects in the original map
display in front of it.

NOTE This exercise uses the CITY.dwg map you used in Exercise 1: Insert a raster
image (page 112).

To change the display order

1 If the CITY.dwg map is not still open, reopen it.

2 In the drawing area, place your cursor over the image, hold down the
Shift key, and click the image.
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3 Right-click  ➤ Draw Order  ➤ Send To Back.

The polylines in the original map now display in front of the raster image.

4 Click  ➤ Save.

Where you are now

You inserted a raster image into a drawing, viewed its information, and placed
it behind the polylines in your map to provide context.

To continue this tutorial, go to Lesson 5: Modify Raster Images (page 118).

Lesson 5: Modify Raster Images
Change the way the raster image displays in the drawing. Adjust brightness,
contrast, and fade, and clip the raster image to display only a portion.

Exercise 1: Adjust image brightness, contrast, and fade
In this exercise, you adjust the image display. Your modifications affect the
display of the raster image in your map, but they do not modify the image
file.
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NOTE This exercise uses the CITY.dwg map you used in Lesson 4: Add Raster
Images (page 112).

To adjust brightness, contrast, and fade

1 If the CITY.dwg map is not still open, reopen it.

2 Scroll to the right side of the raster image.

3 Hold down the Shift key and click the edge of the image to select it.

Shift-click the edge of the
image to select it.

4 Right-click the image and click Image  ➤ Adjust.

5 In the Image Adjust dialog box, do the following:

■ Change the Brightness value to 99.

■ Change the Contrast value to 10.

■ Change the Fade value to 10.

■ Click OK.
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The image is much lighter, displaying the polylines of the
original map more clearly.

6 Click  ➤ Save.

To continue this tutorial, go to Exercise 2: Clip the image (page 120).

Exercise 2: Clip the image
In this exercise, you change the width of the polyline that represents the city
limits. The city limits display more prominently in the drawing. Then you
clip the image to display a rectangular portion that frames the city .

NOTE This exercise uses the CITY.dwg map you used in Exercise 1: Adjust image
brightness, contrast, and fade (page 118).

To change the width of a polyline

1 If the CITY.dwg map is not still open, reopen it.

2 Move your cursor over the city limits.
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The green polyline represents the
city limits.

3 Click the polyline to select it.

If the Quick Properties panel is not displayed, right-click
anywhere in the drawing and select Quick Properties.

4 Move your cursor over the Quick Properties window to expand it.

The Global Width property becomes visible.

5 Select the value for Global Width, enter 100, and press Enter.

You can edit values in the Quick
Properties window.

6 Press Esc to close the Quick Properties window.
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The polyline displays at the new width.

7 Click  ➤ Save.

To clip the image

1 Zoom out so you can see the green polyline and the right edge of the
raster image.

2 Hold down the Shift key and click the edge of the image to select it.

Shift-click the edge of the
image to select it.

3 Right-click the image and click Image  ➤ Clip.

4 Do the following to clip the image:

■ Press Enter or type n to create a clip boundary.
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■ Type r to create a rectangular boundary.

■ Click to specify the starting point of the boundary in the upper-left
corner outside the city limits.

■ Click to specify the opposite corner of the boundary outside the
lower-right area of the city limits.

The raster image is clipped to the boundary you specified.
The image displays only the portion within the specified
boundary.

5 Click  ➤ Save.

To continue this tutorial, go to Exercise 3: Add a raster image to a Display
Manager layer (page 123).

Exercise 3: Add a raster image to a Display Manager layer
The Display Manager (page 410) tab of the Task pane controls the styling and
display of items in your map. The layers in the Display Manager are different
from AutoCAD layers, but they allow you to do similar things. For example,
you can hide and show Display Manager layers, even if those layers contain
raster images rather than drawing objects.
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In this lesson, you add a raster image to a Display Manager layer. You rename
and hide the raster image layer.

NOTE This exercise uses the CITY.dwg map you used in Exercise 1: Adjust image
brightness, contrast, and fade (page 118).

To add an image to a new Display Manager layer

1 If the CITY.dwg map is not still open, reopen it.

2 On the Display Manager tab of the Task pane, click Data ➤ Add Drawing
Data ➤ Raster Image.

3 In the Select Image dialog box, select the check box next to
REDDING_DRG.

4 Click OK.

In the Display Manager, REDDING_DRG
is now listed as a layer.

5 In the Display Manager, right-click the REDDING_DRG layer and click
Rename.

6 Type REDDING_RASTER and press Enter.

7 Click  ➤ Save.

8 In the Display Manager, clear the check box for the REDDING_RASTER
layer.
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The raster image is no longer displayed in the drawing.

Where you are now

You adjusted the image appearance in your map without changing the image
file itself. You added the image to a layer in Display Manager, where you can
hide and show it easily.

To continue this tutorial, go to Lesson 6: Share Your Map with Others (page
125).

Lesson 6: Share Your Map with Others
You can convert your drawing objects to a geospatial format using the Export
option.

For example, you can export your map to an Autodesk SDF file. This stores
the geometry for each drawing object as data, so it can be shared with other
Autodesk users in a small, portable format. When you connect to that file in
AutoCAD Map 3D, all the objects appear on the screen, like AutoCAD objects.
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You can edit them using the same commands. However, the objects are now
“features” and are stored in a data file, rather than in an AutoCAD drawing.

You can also publish your map to a DWF file. People without a copy of
AutoCAD Map 3D can view this format using a free, downloadable viewer
available from http://www.autodesk.com/designreview.

Exercise 1: Export a map to Autodesk SDF
The drawing you used in Lesson 2: Clean Up Your Drawings (page 87) contains
object data (page 413). Object data consists of attributes of the real-world objects
that the drawing objects represent. The object data is stored in the map itself
and is associated with individual drawing objects.

When you export drawing objects, you can use object data to create feature
classes in an SDF file. The resulting feature classes have properties that
correspond to the object data attributes.

In this exercise, the street centerlines in the drawing have three object data
attributes: Lanes, Speed_Limit, and Surface.

To export drawing objects to SDF

1 Navigate to and open the Street_Centerlines.dwg map you used in Lesson
2: Clean Up Your Drawings (page 87).

2 Click Output tab ➤ Map Data Transfer panel ➤ Map 3D Export. 

3 In the Export Location dialog box, do the following:

■ Make sure Files Of Type is set to Autodesk SDF (*.SDF).

■ Specify a location and a file name for the exported file.

■ Click OK.

4 In the Export dialog box, on the Selection tab, make sure Select All is
selected.

5 Click the Feature Class tab, and do the following:

■ Click Create Multiple Classes Based On A Drawing Object.

■ For Drawing Object To Use, select Object Data.

■ Under Drawing Object, clear the Non-Classified check box.
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■ Under Feature Class, click Street_Centerlines.

■ Click the browse button that appears in the field.

The object data for Street_Centerlines has three attributes: Lanes, Speed_Limit, and
Surface.

6 In the Feature Class Mapping dialog box, do the following:

■ Click Select Attributes.

■ Expand the Object Data item to see the attributes that will become
properties of the new feature class.

■ Click OK twice to return to the Export dialog box.

7 Click OK to export the drawing objects to the SDF file.
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Use the Data Connect window to connect to the resulting SDF file. To see a
video on how to do this, see Exercise 2: Use Data Connect to add data to your
map (page 32) in the “Introducing AutoCAD Map 3D 2011” tutorial.

You can edit the features in the SDF file using AutoCAD commands.

To continue this tutorial, go to Exercise 2: Publish a map to a DWF file (page
128).

Exercise 2: Publish a map to a DWF file
In this exercise, you set DWF publishing options that specify the object data
to publish with your map. Then you publish your map to a DWF file.

NOTE This exercise uses the Street_Centerlines.dwg map you modified in Lesson
2: Clean Up Your Drawings (page 87).

To set publishing options

1 Navigate to and open the Street_Centerlines.dwg map you used in Lesson
2: Clean Up Your Drawings (page 87).

2 Click Output tab ➤ Export To DWF/PDF panel ➤ DWF Options. 

3 In the Map Information dialog box, select Publish Map Information.

4 In the Map Information dialog box, expand the items in the list and
select Street_Centerlines.
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When you select Street_Centerlines,
everything under Street_Centerlines is
automatically selected.

5 To publish the information to an XML file, click the save icon and specify
a location for the published file. Click Save.

The DWF Publish operation uses the XML file.

6 Click OK.

To publish to DWF

1 Save your map.

You cannot plot or publish without saving first.

2 Just below your map, click the Layout 1 tab.

If you do not see the tabs, right-click  (the
Model Space icon). Click Display Layout and Model
Tabs.

3 Click Output tab  ➤ Plot panel  ➤ Plot. 
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4 In the Plot dialog box, under Printer/Plotter, select DWF6eplot.pc3.

5 Click Apply To Layout, and then click Cancel.

Printer/plotter settings are applied to your publishing job without sending
the job to a plotter or printer.

6 Click  ➤ Publish.

NOTE Do not choose an option from the Publish submenu. Click the word
Publish in the application menu.

7 In the Publish dialog box, do the following:

■ in the Sheets To Publish list, make sure that only the sheets you want
are selected.
For example, if another map is open, its model and layout views appear
in the list. The default Layout2 view of the current map also appears.

Select any undesired entries (such as Layout2) and click  .

■ Under Publish To, select DWF .

■ Click Publish Options.

8 In the Publish Options dialog box, do the following:

■ Click Layer Information (under General DWF/PDF Options).

■ On the pull-down menu in this field, click Include.
Each layer in your map becomes a separate layer in the DWF output.
In Design Review, you can turn the display of these layers on and off
independently.

■ Click OK.

9 In the Publish dialog box, do the following:

■ Click Publish (at the bottom of the window).

■ Specify a location and a name for the published file and click Select.

■ If you are prompted to save the sheet list, click No.

10 If you see a message about the job processing in the background, click
Close to dismiss the message.

The files needed by Autodesk Design Review are published to the file you
specified.
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11 Monitor the progress of the publishing operation by holding your cursor
over the animated icon in the lower-right corner.

12 When the job is complete, a bubble appears in the bottom, right-hand
corner of the window. Click the link in the bubble to view any warnings
or errors. Close the window when you are finished.

Where you are now

You exported your map to an Autodesk SDF file. You also published your map
to a DWF file. People without a copy of AutoCAD Map 3D can view your
published map using a free, downloadable viewer available from
http://www.autodesk.com/designreview.
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Tutorial: Annotating Your
Map

About the Annotation Tutorial
The lessons in this tutorial show you how to add text to your map using the
following methods:

■ Annotation templates. Label drawing objects with information specific to
each object. The annotation can include object data or linked data properties,
as well as native drawing properties (such as measurement data). Add static
text to explain the contents of the label. You can reuse annotation templates
in other maps.

■ Styles. Label geospatial features with information specific to each feature.
Style labels can display any property in the data store, as well as static text.
Styles are saved with the current drawing.

■ Text layers. Add annotation that is not tied to a particular drawing layer or
feature class. For example, use text layers to label large areas on the map, or
add notes about the map as a whole. Text layers are saved independent from
the current map. You can reuse them in other maps.
In this tutorial, you use a map called AnnotationTutorial.dwg. It contains
drawing objects (roads) and geospatial features (parcels and creeks).

Lesson 1: Use Annotation Templates
To annotate drawing objects (geometry drawn with AutoCAD commands), you
follow a two-step process. You lay out the annotation design in an annotation
template. Then you specify the objects to attach the annotation to. The
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annotation replaces the template with information specific to each object you
specify and displays it as a label on those objects.

An annotation template is a type of AutoCAD block. It can contain text and
graphics. The text can include static labels as well as placeholders. Actual data
values replace the placeholders at display time.

Exercise 1: Create an annotation template
To attach text labels to drawing objects, create an annotation template first.
An annotation template is a type of AutoCAD block. You define the template
by defining the block in the Block Editor. The Block Editor is the canvas on
which you lay out the components of the annotation. The relationship between
each component determines how the annotation appears on each object when
you attach the annotation later. For example, if you place a static label above
a dynamic value, the final annotation has two lines (one above the other),
like this example:

The text
“Speed Limit
=” is a static
text label. The
text “50” is a
dynamic value
supplied from
an object data
table.

If your drawing contains object data, or is linked to external data, you can
specify properties of that data as values for the annotation. These properties
are dynamic. When you attach the annotation to objects, each object displays
its own value for that property.

For example, define an annotation for roads that uses the object data property
"NumberOfLanes" and attach that template to a set of roads. The final
annotation displays the number of lanes for each road.

In this tutorial, you use a drawing called AnnotationTutorial.dwg, which contains
an object data table. You use a property in the object data table as the value
for an annotation tag.

134 | Chapter 4   Tutorial: Annotating Your Map



To create an annotation template

1 Copy the sample data to a local drive and switch to the Tool-Based Ribbon
workspace.

■ Prepare your sample data. (page 2)

■ Create a folder for your saved maps. (page 3)

■ Start AutoCAD Map 3D and set up the tutorial window. (page 4)

■ Switch to the Tool-based Ribbon workspace. (page 4)

2 Open AnnotationTutorial.dwg.

■ Click Open in the Quick Access toolbar at the top of the AutoCAD
Map 3D window.

Click Open in the Quick
Access toolbar.

■ Select AnnotationTutorial.dwg.

■ Click Open.
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The drawing opens, displaying the cloverleaf in the middle of the city of Redding.

3 Click Annotate  ➤ Map Annotation  ➤ Define Template.

Click the Annotate tab in the ribbon to see the Map Annotation options.

4 In the Define Annotation Template dialog box, under Annotation
Template, click New.
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Other options in this dialog box are unavailable because there is no
annotation template yet. The dialog box redisplays when you create and
save the annotation template.

5 In the New Annotation Template Name dialog box, enter Speed and then
click OK.

A new tab called Block Editor appears in the ribbon, and a new drawing opens in the
Block Editor.

6 Click Block Editor  ➤ Annotation  ➤ Edit Annotation Text.

7 In the drawing, press Enter to create an annotation.

Press Enter in response to the prompt. The
Annotation Text dialog box displays.

8 In the Annotation Text dialog box, do the following:

■ In the Attribute area, under Tag, enter SpeedLimit.

■ For Value, click the Expression Builder button.

The button to the right of the Value field is the Expression
Builder button.
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9 In the Expression Chooser dialog box, do the following:

■ Expand Object Data and Roads.

Expand the Object Data nodes until you see SpeedLimit.

■ Click SpeedLimit.

■ Click OK.

10 In the Annotation Text dialog box, do the following:

■ In the Object Properties area, under Color, select Blue.

■ In the Text Options area, under Height, enter 30.
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Make the annotation text blue and 30 units high.

■ Click OK.

11 In the Block Editor window, make sure the X and Y axis meet at the 0,0
point.

Check the location of the axis markers by hovering over their intersection
point and looking at the lower left corner of the window.

0,0 represents the anchor point on the object. The annotation block is
offset from the object according to how far away the block insertion point
is from 0,0.

Exercise 1: Create an annotation template | 139



If the axis is not at 0,0, select it and drag it until it is.

Once the axis points are aligned at 0,0, click near, but not on, where the
x and y axes meet. Then press Enter.

Click where the text of the annotation should
start.

12 To view the annotation tag, on the command line, enter zoom. Then
enter e to zoom to the extents of the tag.

The actual speed
limit for each road
replaces the
placeholder
“SpeedLimit.”

13 Click Block Editor  ➤ Open/Save  ➤ Save Block.

14 Click Block Editor  ➤ Close  ➤ Close Block Editor.

The Define Annotation Template dialog box displays.

15 To see the AnnotationTutorial.dwg drawing again, click OK.

There is no annotation in the drawing until you attach the template to
objects.

To continue this tutorial, go to Exercise 2: Attach annotation to drawing
objects (page 141).
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Exercise 2: Attach annotation to drawing objects
Use the annotation template you defined in the previous exercise (page 134)
to insert instances of the annotation into the drawing. Every drawing object
that contains data for speed limit in the object data table will display its own
speed limit value.

NOTE This exercise uses the map you edited in Exercise 1: Create an annotation
template (page 134).

To attach annotation to drawing objects

1 Select some streets in the drawing by clicking them.

For this exercise, select a few streets around the cloverleaf in the middle
of town.

Select the streets around the cloverleaf.

2 Click Annotate  ➤ Map Annotation  ➤ Insert.
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Click the Annotate tab to see
the Map Annotation options.

3 In the Insert Annotation dialog box, under Annotation Template, select
the Speed check box.

Any other annotation templates defined in the drawing would also be listed
here.

4 Click Insert.
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Speed limit values in blue text are added next to each street,
based on the object data associated with the street objects.

5 Use Save As (on the application menu  ) to save the drawing with a
new name.

Make a note of the name and location of the drawing. You will close and
reopen it again later.

To continue this tutorial, go to Exercise 3: Add a static text label (page 143).

Exercise 3: Add a static text label
The annotation indicates the speed limit of each street, but it is not identified
as such. Edit the annotation template you created in the previous exercise.
Add the label "Speed Limit =" and position it above the existing annotation
tag.
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NOTE This exercise uses the map you edited in Exercise 2: Attach annotation to
drawing objects (page 141).

To add a static text label

1 Click Annotate  ➤ Map Annotation  ➤ Define Template.

2 In the Define Annotation Template dialog box, do the following:

■ In the Annotation Template area, under Template Name, select Speed.

■ Click Edit Template Contents.

Click Edit Template Contents at the bottom right of the dialog box.

3 At the Command prompt, enter style and press Enter.
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Click anywhere in the Block Editor and type
style.

4 In the Text Style dialog box, do the following:

■ In the Size area, under Height, enter 30.

■ Click Apply.

Make the new text string the same size as the first one.

■ Close the Text Style dialog box
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5 Type dtext and press Enter.

Click anywhere in the Block Editor and type
dtext.

6 In the Block Editor window, click above the letter "S" of the annotation
tag.

7 Press Enter to accept the default rotation of 0.

8 In the text entry box that appears, type Speed Limit = and press Enter.

Use the Backspace and Delete keys to correct
the text as needed.

9 Click outside the text box. Then press ESC to exit the command.

10 Click Block Editor  ➤ Open/Save  ➤ Save Block.

11 Click Block Editor  ➤ Close  ➤ Close Block Editor.

The Define Annotation Template dialog box appears.
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12 In the Define Annotation Template dialog box, click OK.

13 Save and close the drawing.

Where you are now

In the AnnotationTutorial.dwg map, the descriptive text label appears above
the speed limit.

To continue this tutorial, go to Lesson 2: Add Labels to Features (page 147).

Lesson 2: Add Labels to Features
To annotate geospatial features (features stored in an external source that
specify both geometry and attributes), you use a style option called Labels.
You specify the attribute to use in the label (or an expression that includes an
attribute, text, and formatting options). There is no template involved. The
values for the labels appear as soon as you close the Style window.

Exercise 1: Use a style to label features
The parcel layer in AnnotationTutorial.dwg is a geospatial feature class. The
actual data is stored in an SDF file called Parcels.sdf. The map connects to this
file and displays the geometry and data for the parcels in the map. You can
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style the parcels any way you like. The styling does not affect the data store
itself. Styling is saved in the map, along with the information for connecting
to the data store.

Unlike annotation for drawing objects, all features in the feature class are
labeled. You do not have to select the features individually.

In this exercise, you use the Style Editor to add labels to the parcels.

NOTE This lesson uses the map you edited in Lesson 1: Use Annotation Templates
(page 133).

To use a style to label features

1 Open the map you edited and saved in the previous lesson (page 133).

You used Save As to save the map with a new name.

2 In the Task Pane, switch to Display Manager, if it is not already displayed.

The Display Manager tab shows
the layers in the current map.

3 Select the Parcels layer and click Style.
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Click the Parcels layer and then
click Style.

4 In the Style Editor, click the cell under Feature Label in the lower half of
the window.

5 In the Style Label dialog box, do the following:

■ Make sure Create A Label (at the top of the dialog box) is selected.

■ For Property To Display, select Address.

■ For Background Style, select Transparent.
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Click the cell under Feature Label. Specify the property to display in the label and some
styling options.

■ Click OK.

6 Close the Style Editor.
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Labels display street numbers on the parcels in your map.

To continue this tutorial, go to Exercise 2: Use an expression to refine the
labels (page 151).

Exercise 2: Use an expression to refine the labels
The labels show the street numbers of the parcels, but not the street names.
You can use an expression to concatenate (combine) two properties. In this
case, you concatenate the address (street number) and street name. You use
the expression \n to add a line break, producing a multiline label.

NOTE This exercise uses the map you edited in Exercise 1: Use a style to label
features (page 147).
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To use an expression to refine the labels

1 Select the Parcels layer and click Style.

Click the Parcels layer and then
click Style.

2 In the Style Editor, click the cell under Feature Label in the lower half of
the window.

3 In the Style Label dialog box, for Property To Display, select Expression

Scroll to the bottom of the Property To
Display list to see the Expression option.

4 In the Create/Modify Expressions window, click the large button labeled
Create A Multiline Label.
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Clicking the button adds a placeholder expression to the window, with the first property
highlighted.

5 To replace the first property entry, click Property at the top of the
Create/Modify Expressions window. Select the numeric property ADDRESS.

The property you select replaces the placeholder property in the expression.
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You do not need the Label entry. It serves the same purpose as the Speed=
entry in the annotation template you created in the last lesson. However,
you do not have to label the street name in this case.

6 Select the Label entry in the expression (from the single quotation mark
preceding it to the comma following it). Right-click the selection and
click Delete.

Delete the ‘label’ entry.

7 Replace the second property entry with the text property STNAME.

8 Click Validate (at the bottom of the dialog box) to make sure that the
expression is valid.

You replaced the property placeholders with the properties to display. The \n inserts
a line break, so each property appears on a separate line.

9 Click OK in the Create/Modify Expressions and Style Label dialog boxes
and close the Style Editor.

10 Zoom in to the area around the cloverleaf in the middle of town.
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Where you are now

The streets (drawing objects) display speed limits and the parcels (geospatial
features) display full street addresses.

To continue this tutorial, go to Exercise 3: Display text along a curve (page
155).

Exercise 3: Display text along a curve
For linear features, you can specify that the label for a feature follows the curve
of the line. For example, rivers can display their names along the bends and
curves of the river. In this exercise, you use the Advanced Placement feature
to label the creeks in the map.

NOTE This exercise uses the map you edited in Exercise 2: Use an expression to
refine the labels (page 151).
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To display text along a curve

1 Open the map you edited and saved in the previous exercises.

You used Save As to save the map with a new name.

2 In the Task Pane, switch to Display Manager, if it is not already displayed.

The Display Manager tab shows the
layers in the current map.

3 Select the Creeks layer and click Style.

Click the Creeks layer and then
click Style.

4 In the Style Editor, click the cell under Style in the lower half of the
window.
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5 In the Style Line dialog box, do the following:

■ Change Thickness to 0.1

■ Change Color to blue or green.

Specify the line color and thickness for the
creeks.

■ Click OK.

6 In the Style Editor, click the cell under Feature Label in the lower half of
the window. In the Style Label dialog box, do the following:

■ Make sure Create A Label (at the top of the dialog box) is selected.

■ Select Advanced Placement.

■ For Property To Display, select Name.

■ For Background Style, select Transparent.
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■ Click OK.

7 Close the Style Editor.
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Where you are now

Zoom in to see the names on the creeks in your map.

To continue this tutorial, go to Exercise 4: Add static text (page 159).

Exercise 4: Add static text
You can add static text to the creek label, just as you did in the annotation
template. Use the Concat function again.

In this exercise, you use Concat to add the static text "Waterway:" to the creek
labels.

NOTE This exercise uses the map you edited in Exercise 3: Display text along a
curve (page 155).

To add static text to the label

1 Select the Creeks layer and click Style.

2 In the Style Editor, click the cell under Feature Label in the lower half of
the window.

3 In the Style Label dialog box, for Property To Display, select Expression.
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4 In the Create/Modify Expressions window, click the button labeled Join
Two Text Labels Together.

5 Select the first Property entry and replace it with the text 'Waterway: '.

When you add a static text entry, surround it with single quotes. To include a space
between the static text and the following property, put the space inside the closing
single quote mark.

6 Select the second property. Click Property and select the text property
NAME.
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Replace the second property placeholder with NAME.

7 The expression now looks like this:

CONCAT ( 'Waterway: ' , NAME )

8 Click OK in the Create/Modify Expressions window and the Style Label
dialog box and close the Style Editor.
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Where you are now

Zoom in to the same area around the cloverleaf in the middle of town. The
creeks now display the new labels with the static text and creek names.

To continue this tutorial, go to Lesson 3: Use text layers (page 162).

Lesson 3: Use text layers
A text layer is stored as a separate SDF data store, independent from the current
map. You can use it in the current map, but you can also reuse it in other
maps. To do so, attach it as you would any other SDF file.

Another advantage of text layers is that you can position the text on the layer,
as you would an object on a drawing layer. You can style and rotate text on
a text layer as well.

In this lesson, you create and style a text layer and specify its contents. Then
you will save it out to a separate data store for use in other maps.

Exercise 1: Create a text layer
You create a text layer in the Display Manager, much the same way as you
create a drawing layer.

NOTE This exercise uses the map you edited in Lesson 2: Add Labels to Features
(page 147).
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To create a text layer

1 Open the map you edited and saved in the previous exercises.

You used Save As to save the map with a new name.

2 In the Task Pane, switch to Display Manager, if it is not already displayed.

3 In the Display Manager, click Data  ➤ New Text Layer.

Create a text layer from the
Display Manager.

4 In the Choose Spatial Database File dialog box, enter a name and location
for the SDF file to store the layer information. Click Save.

Call the text layer "Downtown Redding Text."

5 In the Specify Coordinate System dialog box, set the coordinate system
for the layer to CA-I. Click OK.

The new text layer is added to the Display Manager. The default layer
name is Annotation.

6 To rename the layer, select it, and then click its current name. Enter a
new name, for example "Downtown Redding."
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Rename the text layer.

To continue this tutorial, go to Exercise 2: Style the text layer (page 164).

Exercise 2: Style the text layer
In this exercise, you style the text layer, making it bold and changing its color.
There are many settings in the Style Text Layer dialog box. Most of them are
tied to the feature data source and should not be changed.

NOTE This exercise uses the map you edited in Exercise 1: Create a text layer
(page 162).

To style the text layer

1 In the Display Manager, select the new "Downtown Redding" text layer.

Notice that a new Text Layer tab appears in the ribbon when you select
a text layer. You use this tab later when you check in your changes to
the text layer.

2 In the Task Pane, click Style.
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Click the text layer and click Style.

3 In the Style Editor, click the cell under Style.

4 In the Style Text Layer dialog box, make the text bold and a dark red
color.

These values provide the defaults for any text layer
instances you add. You can override the defaults for
an instance when you insert it.
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5 Click OK and close the Style Editor.

To continue this tutorial, go to Exercise 3: Add text to the text layer (page 166).

Exercise 3: Add text to the text layer
In this exercise, you specify the contents of the text layer. To change the text,
edit the text instance and change the contents or styling.

NOTE This exercise uses the map you edited in Exercise 2: Style the text layer
(page 164).

To add text to the layer

1 In the Display Manager, right-click the Downtown Redding layer. Click
Create  ➤ Create New Annotation.
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Each annotation is one "text instance." You can add multiple text instances
to a text layer. When you connect to the text layer later, all the text
instances are inserted into your map.

2 Click in the map, in the white space just below the cloverleaf in the center
of town.
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To reposition the text, select it and drag its grip to another position.

3 In the Edit Text Instance dialog box, do the following:

■ Enter "Downtown Redding."
Do not copy and paste the text. Type it directly into the dialog box.

■ Select through all the text you typed.
You can apply your changes to all or part of the text. If you do not
select text, nothing is applied. For example, if you select just the word
"Downtown," you can make it a different color, size, and style from
the word "Redding."

■ Change the text size to 20.

■ Set the font to Arial.
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Settings apply to selected text only.

4 Click OK.
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The text is not associated with any object or feature.

5 On the Text Layer tab on the ribbon, in the Edit Set tab, click Check In.

Since the text layer is a data store, check in the changes you made so they become
available in other maps.

If you change any text instance on this text layer (the contents or the
formatting), check it in again. Checking in the data updates the data
store with the latest edits.

6 To change the contents of the text layer, select it in the map.

7 Right-click the text and click Edit Text Instance.
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Click the “Downtown Redding” text instance, right click, and click Edit Text
Instance.

8 Change the contents of this text instance to "Redding" and click OK.

9 Click Check In again to update the text layer data store.

10 Save the map.

To continue this tutorial, go to Exercise 4: Use the text layer in another map
(page 172).
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Exercise 4: Use the text layer in another map
You have created and saved the contents of the text layer to an SDF file. Now
you can connect to that file from any map and reuse the text.

NOTE This exercise uses the map you edited in Exercise 3: Add text to the text
layer (page 166).

To use the text layer in another map

1 Click New to create a map.

Click New in the Quick Access
toolbar.

2 In the Display Manager, click Data  ➤ Connect To Data.

Connect to the data store containing
the city boundaries of Redding.

3 For Data Connections By Provider, select Add SDF Connection.

4 For Source File, click the browse button and navigate to the
CITY_BOUNDARY.SDF file.
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Select the SDF provider and navigate to the sample file, CITY_BOUNDARY.SDF.

5 Click Connect, then click Add To Map.

6 With the Data Connect window still open, under Data Connections By
Provider, select Add SDF Connection again.
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7 For Source File, click the browse button and navigate to the Downtown
Redding Text file you created in the previous exercises.

8 Click Connect, then click Add To Map.

9 Close the Data Connect window.
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Where you are now

The text appears in the center of Redding. You can move and restyle the text. If
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you then check it in, you update the text layer data store. The new position and
styling appear each time you use the layer.
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Tutorial: Classifying
Drawing Objects

About the Classifying Drawing Objects Tutorial
In this tutorial, you define object classes, assign drawing objects to different
classes, and then use the object classes to create, edit, and export drawing objects.
To be part of the object class, drawing objects must meet certain rules when
they are classified. If you create a drawing object in an object class, it inherits
the layer and attribute characteristics of that object class. Object classes help to
ensure that drawing objects are standardized.

For example, you can define an object class (page 413) called Roads and specify
its rules:

■ It can contain only line objects.

■ All members of the Roads class have a property for number of lanes.

■ The value for the Lanes property is from 1 through 6.

Then, only line objects that represent 1- to 6-lane roads can be added to the
Roads class.

Object classification is helpful when you create metadata. Although the AutoCAD
Map 3D Metadata feature generates basic metadata for DWG files, it is optimized
for use with maps that use object classes.

Object classification is useful when you are preparing drawing files for export
to a spatial data (FDO) format, such as SDF or Oracle. You can export objects
based on object classes. Then, each set of exported objects has only the properties
assigned to it by its object class.

5
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NOTE This tutorial is for DWG data only. Geospatial data uses feature classes
instead of object classes, and feature classes are defined in the data store itself.

Using Industry Toolkits to Set Up Classification

The AutoCAD Map 3D Industry Toolkits provide industry-specific data models
and templates for water, wastewater, and electric utilities. The Industry Toolkits
include object class definitions and supporting material specific to each
industry. Data in DWG or other file formats can be easily classified to match
Industry Toolkit object classes.

The toolkits include:

■ Data models
A set of industry object classes and corresponding data attributes, for
example, an overhead conductor and the voltage carried by that conductor.

■ A set of pre-configured industry symbols that are tied to the object classes.

■ Templates for AutoCAD Map 3D maps (DWT files) and object classification
(XML files).

■ Documentation (a User’s Guide, Workflows, and Data Model Schemas).

■ Instructional videos

The AutoCAD Map 3D Industry Toolkits are provided as free downloads to
AutoCAD Map 3D 2011 Subscription customers. In North America, the toolkits
are available from within Subscription Center at
http://www.autodesk.com/subscriptioncenter.

The AutoCAD Map 3D Industry Toolkits are for use only with licensed
AutoCAD Map 3D software. The toolkits are subject to the terms and conditions
of the Autodesk Software License Agreement that accompanies that licensed
software.

Lesson 1: Set Up For Classification
To use this tutorial, prepare the sample data, change your AutoCAD Map 3D
workspace, and set up your user privileges (page 416) for AutoCAD Map 3D.
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Exercise 1: Set up your work environment
Copy the sample data to a local drive and switch to the Tool-Based Ribbon
workspace.

1 Prepare your sample data. (page 2)

2 Create a folder for your saved maps. (page 3)

3 Start AutoCAD Map 3D.

4 Switch to the Tool-based Ribbon workspace. (page 4)

To continue this tutorial, go to Exercise 2: Set up your user privileges (page
179).

Exercise 2: Set up your user privileges
You must have the appropriate user privileges (page 416) to define object classes
(page 413) for your version of AutoCAD Map 3D.

Creating a User with the Required Privileges

If your organization does not assign privileges, you can log in as SuperUser
(page 415). As SuperUser, you can create a user with the privileges you need.

NOTE If your organization assigns user privileges for AutoCAD Map 3D, ask the
SuperUser in your group to grant you these privileges.

To log in as SuperUser

1 Click Map Setup tab ➤ Map panel ➤  ➤ User Login. 

2 Do one of the following:

■ If you have not changed the SuperUser login, specify the default login
name SuperUser and the password SUPERUSER, using the capitalization
shown. (Login is case sensitive.)
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Log in as SuperUser to define object
classes.

■ If you changed the name or password for SuperUser, type your new
information.

3 Click OK.

To create a user

1 Click Map Setup tab ➤ Map panel ➤  ➤ User Administration. 

Click Map Setup tab ➤ Map panel ➤  ➤ User Administration. 

If someone else in your organization is the designated SuperUser, ask that
person to do these steps.

If you cannot log in as SuperUser, log in as a
new user with the privileges to create object
classes.
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2 Specify a new user name and password.

3 Assign all privileges except SuperUser to the new user and click OK.

Where you are now

You set up the privileges necessary for creating object class definitions.

To continue this tutorial, go to Lesson 2: Define Object Classes (page 181).

Lesson 2: Define Object Classes
You define object classes by example. You select an existing object that
embodies the object class (page 413) you are defining (a “model object”). Then
you modify the properties for that object to define the class.

Object class definitions are stored in an object class definition (page 413) file,
which you can attach to any map. You can add definitions from multiple
drawings to a single definition file. It becomes a library of object classes. You
attach the definition file to a map. Then you use the object classes in that
definition file to classify existing objects and create new ones.

Exercise 1: Create the object class definition file
Use the Map Explorer tab in the Task pane to create the object class definition
(page 413) file. You can create this file in any map.

To create the definition file

1 Click  ➤ New  ➤ Drawing.

Select the map2d.dwt template and click Open.

2 Switch to Map Explorer in the Task pane.

3 Right-click Object Classes and click New Definition File.
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Create the object class definition
file.

NOTE If you see an error message, you are not logged in as a user who can
define object classes. See Exercise 2: Set up your user privileges (page 179).

4 Name and save the definition file in a convenient location.

For example, navigate to the folder where you copied your tutorial files.
Call the definition file MyDefinition.xml.

5 Right-click Object Classes again and click Attach Definition File. Specify
the definition file you created.

Object classes you define are now saved in the new definition file.

To continue this tutorial, go to Exercise 2: Define an object class (page 182).

Exercise 2: Define an object class
Base each new object class (page 413) on an existing object. Start by opening a
map that contains objects that are typical of the object class you are defining
(“model objects”). In this example, you open the Roads.dwg map to define the
Roads object class.
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NOTE In this tutorial, each set of objects is stored in a separate file. If your objects
are stored in layers within a single file, you could define all the object classes from
within that file. The process is the same.

When you define an object class, you can choose any existing properties of
the model object to include as part of the object class definition. You can also
add properties. For each property you include, you can specify a default value
and an allowable range.

NOTE This exercise uses the MyDefinition.xml object class definition (page 413) file
you created in Exercise 1: Create the object class definition file (page 181).

To define an object class

1 In AutoCAD Map 3D, open Classify_Roads.dwg. Click  ➤ Open  ➤ 

Drawing.

2 On the Map Explorer tab of the Task pane, right-click Object Classes and
click Attach Definition File.

3 Specify the MyDefinition.xml definition file you created.

4 Right-click Object Classes again and click Define Object Class.

Define an object class by selecting a
model object.
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5 Select any road as the model object for this class. Click Map Setup

tab ➤ Object Class panel ➤ Define. 

6 In the Define Object Classification dialog box, specify Roads as the name
for this object class. Click the topmost box in the Object Types list
(AcDbEntity).

Specify the object creation method that existing objects must
use to belong to this object class.

All existing objects you add to this class must use the object type (page
413) you check here. Unless you know for certain that all existing road
objects were created using the AcDbLine or AcDbCurve method, it is safer
to check only AcDbEntity (page 409).

7 Click the Properties List tab and check the properties to include in this
object class.

Objects you include in this class always retain their own properties. The
properties you specify here are the properties of the class as a whole.
Choose properties to set their default values or allowable ranges, or to
make them editable for all members of the class.
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For example, to be able to change the layer, linetype, or color for all
members of the Roads class as a group, select those properties. You can
set default values, where appropriate. For example, you can assign all
members of the Roads class to a Roads layer.

You can include the following property types:

■ General properties, such as color and layer

■ Miscellaneous properties, such as linetype generation

■ Object properties, such as street name (ST_NAME).

Specify the properties for objects in this object class, and any
default values for those properties.

The following table shows a suggested set of General properties and values
for the Roads class.

ValueProperty

General Properties

RedColor
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ValueProperty

RoadsLayer

No valueLinetype

13Lineweight

NOTE To specify a lineweight, enter the decimal value as an integer. For
example, to specify a lineweight of 0.13, enter 13 (as indicated in the table).

8 Specify the object data fields and their values.

For object data fields, clear the values that are specific to the model object
you chose. For example, include the NAME and ST_NAME properties to
ensure that all new roads you create contain those properties. Delete the
values that appear there, because each new road name will differ from
the name of the model object.

For example, click the ST_NAME property and look at its values. The
default value for the street name is the name of the model object. This
value is incorrect for almost any new road you create. Select that value
and delete it.

Objects assigned to this class have a ST_NAME property, but the value
will be the name for that road (as stored in its object properties). If no
value exists, the property is blank. The following table shows a suggested
set of OD:Schema_Roads properties and values for the Roads class.

ValueProperty

No valueAutogenerated_SDF_ID

No valueLENGTH

No valueNAME

No valuePREFIX

No valueSEG_ID

No valueST_NAME

No valueST_TYPE
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ValueProperty

No valueSUFFIX

No ValueTYPE

9 To add a new property that specifies the number of lanes for a road, do
the following:

■ Click New Property.

Define any custom properties for the object class.

■ For Property Name, type NumberLanes and click OK.
NumberLanes is checked and selected.

10 Specify that NumberLanes is a whole number from 1 through 6, with 2
being the default:

■ For Type, select Integer.

■ For Range, type [1,6].
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■ For Default, type 2.

11 Click the Class Settings tab. For Create Method, select Polyline.

Choose the Create Method (page 410) for new objects you
create within this object class.

When you use this class to create a road, use a Polyline to create it.
Existing objects you add to this class do not have to be polylines.

12 Click Save Definition.

13 Leave Classify_Roads.dwg open.

To continue this tutorial, go to Exercise 3: Add object classes to the definition
file (page 189).
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Exercise 3: Add object classes to the definition file
You can add more object classes to the object class definition (page 413) file,
even if you add them from a different drawing. When you attach the resulting
definition file to a map, all the class definitions are available.

NOTE This exercise uses the MyDefinition.xml object class definition file you created
in Exercise 1: Create the object class definition file (page 181).

To add an object class to an existing definition file

1 Open Classify_Parcels.dwg. Click  ➤ Open  ➤ Drawing.

2 On the Map Explorer tab of the Task pane, right-click Object Classes and
click Attach Definition File.

3 Navigate to the object class definition file you created earlier
(MyDefinition.xml) and open it.

4 On the Map Explorer tab, right-click Object Classes and click Define
Object Class.

5 Select a parcel as the model object for this object class (page 413) and press
Enter.

6 In the Define Object Classification dialog box, specify Parcels as the name
for this object class and check the topmost box in the Object Types list.

7 Click the Properties List tab and check the properties to include in this
object class.

■ Select a set of General properties and assign default values as
appropriate.

■ Select all Geometry and OD:Schema_Parcels properties, but delete
their default values.

8 Click the Class Settings tab, click Create Method and click Polygon.

When you create a parcel for this class, use the Polygon method to create
it.

9 Click Save Definition.

10 Leave Classify_Parcels.dwg open.
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11 Open the Classify_Signals.dwg file. Attach the MyDefinition.xml definition
file and create an object class using the following settings:

■ Name: Signals

■ Properties: Select a set of General properties and assign default values
as appropriate. Select all Geometry and OD:Schema_signals properties,
but delete their default values.

■ Create Method: Point

12 Leave Classify_Signals.dwg open.

Where you are now

You created an object class definition file, defined object classes, and added
the object classes to the definition file.

To continue this tutorial, go to Lesson 3: Classify Objects (page 190).

Lesson 3: Classify Objects
Now that you have defined the object classes, you can assign objects to those
classes. (This process is called “classifying” the objects). Whenever you attach
the object class definition (page 413) file to a map, the object classes are
recognized in that map. If you then query in the classified objects from their
native drawings, the map recognizes that these objects are members of the
class you assigned to them.

Exercise 1: Classify the signal objects
Begin by classifying the objects in the Classify_Signals drawing.

NOTE This exercise uses the Classify_Signals.dwg file you worked with in Exercise
3: Add object classes to the definition file (page 189).

To classify the signal objects

1 If the Classify_Signals drawing is not already open in AutoCAD Map 3D,
open it.

2 Click Create tab ➤ Drawing Object panel ➤ Select Unclassified. 
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Select the unclassified objects (page 416) so you can add them to an object
class (page 413).

3 Press Enter to select all unclassified objects.

4 Right-click the Signals object class in Map Explorer in the Task pane and
click Classify Objects.

Classify the selected objects if they
meet the criteria of the object class.

5 Leave both boxes checked in the Classify Objects dialog box and click
OK.

6 To check that the objects were properly classified, press Esc to clear the
selection. In the Map Explorer tab of the Task pane, right-click the Signals
object class and click Select Classified Objects.
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All the signals are selected.

7 Press Esc again to clear the selection, and then click a single signal to
select it.

8 Right-click the selected signal and click Properties.

9 On the Properties palette, click the Object Class tab and examine the
properties.
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Examine the properties for members
of the Signals object class.

10 Save and close Classify_Signals.dwg.

To continue this tutorial, go to Exercise 2: Classify roads and parcels (page
193).

Exercise 2: Classify roads and parcels
Classify objects in the remaining drawings.

NOTE This exercise uses the Classify_Roads.dwg and Classify_Parcels.dwg files you
worked with in Exercise 2: Define an object class (page 182).

To classify the roads and parcels

1 If the Classify_Roads.dwg drawing is not already open in AutoCAD Map

3D, open it. Click  ➤ Open  ➤ Drawing.
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2 Click Create tab ➤ Drawing Object panel ➤ Select Unclassified. 

3 Press Enter to select all unclassified objects (page 416).

4 Right-click the Roads object class (page 413) in Map Explorer in the Task
pane and click Classify Objects.

5 Leave both boxes checked in the Classify Objects dialog box and click
OK.

6 Save and close Classify_Roads.dwg.

7 If the Classify_Parcels.dwg drawing is not already open in AutoCAD Map

3D, open it. Click  ➤ Open  ➤ Drawing.

8 Instead of selecting all the parcels, drag-select only a portion of them.

Select about one quarter of the parcels.

9 Right-click the Parcels object class in Map Explorer in the Task pane and
click Classify Objects.

10 Leave both boxes checked in the Classify Objects dialog box and click
OK.

11 Save and close Classify_Parcels.dwg.

Where you are now

You classified objects for three object classes.

To continue this tutorial, go to Lesson 4: Create a Map Using Object Classes
(page 194).

Lesson 4: Create a Map Using Object Classes
Now that you saved the object class definitions in a file, you can attach that
file to any map to use the definitions. You can also attach the drawings whose
objects are classified, and query those objects into the map with the definition
file attached to it. The combination of the definition file and the classified
objects in the attached drawings determines that AutoCAD Map 3D treats the
objects as classified.
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Exercise 1: Create a map
Start by creating a map and attaching the MyDefinition.xml object class definition
(page 413) file and the source drawings.

NOTE This exercise uses the MyDefinition.xml object class definition file you created
in Exercise 1: Create the object class definition file (page 181) and the source
drawings you used in Lesson 3: Classify Objects (page 190).

To create a map that contains the object classes you defined

1 In AutoCAD Map 3D, create a map. Click  ➤ New  ➤ Drawing. Select
the map2d.dwt template and click Open.

2 Attach the object definition file by right-clicking Object Classes on the
Map Explorer tab of the Task pane and clicking Attach Definition File.

Attach the MyDefinition.xml
definition file.

3 Select the MyDefinition.xml definition file you created and click Open.

4 On the Map Explorer tab in the Task pane, click Data  ➤ Attach Source
Drawings.
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Attach the drawings containing the
classified objects.

5 Navigate to the folder where you saved the tutorial data. Hold down the
Shift key, click the following drawings, and click Add:

■ Classify_Signals.dwg

■ Classify_Roads.dwg

■ Classify_Parcels.dwg
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Select all three drawing files.

6 Click OK.

NOTE You might see an alert as you work through the remainder of the
tutorial. The alert warns that the association between queried objects in the
current and attached drawings is not retained once the current drawing file
is closed. This message reminds you to save back any changes you make to
the original drawing file. You can safely ignore the alert.

To continue this tutorial, go to Exercise 2: Assign a coordinate system (page
197).

Exercise 2: Assign a coordinate system
Assign a coordinate system to the current map and the attached drawings at
one time.
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NOTE This exercise uses the map you created in Exercise 1: Create a map (page
195).

To assign a coordinate system to the current map and to the attached
drawings

1 Click Map Setup tab ➤ Coordinate System panel ➤ Assign. 

Assign a coordinate system to the current and attached
drawings.

2 Under Current Drawing, for Code, type CA-I (uppercase C, uppercase A,
hyphen, uppercase I). Press Enter. The dialog box displays the description
of this coordinate system.

3 Under Source Drawings, click Select Drawings and select all three attached
drawings. Click Add and then click OK.

4 Under Source Drawings, for Code, type CA-I and press Enter (as in step
2).

5 Click OK.

To continue this tutorial, go to Exercise 3: Query in objects (page 199).
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Exercise 3: Query in objects
Use a Draw Query (page 411) to query in the drawing objects from the three
attached drawings to add them to the map.

NOTE This exercise uses the map you created in Exercise 1: Create a map (page
195).

To query in the objects

1 On the Map Explorer tab of the Task pane, double-click Current Query.

2 In the Define Query Of Attached Drawings dialog box, under Query Type,
do the following:

■ Click Location.

■ Make sure Boundary Type is set to All.

■ Click OK.

■ Under Query Mode, select Draw.

Query in objects from the attached drawings.

■ Click Execute Query.
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3 Click View tab ➤ Navigate panel ➤ Zoom drop-down ➤ Extents. 
The map is centered on the data.

4 Name and save the map.

■ Click  ➤ Save.

■ Navigate to the folder where your tutorial data is stored.

■ Name the map file ObjectClass.dwg.

■ Click Save.

Where you are now

You created a map that uses the object class definition (page 413) file you defined.
You queried in objects to the new map.

To continue this tutorial, go to Lesson 5: Create and Edit Objects Using Object
Classes (page 200).

Lesson 5: Create and Edit Objects Using Object
Classes

You can use object class definitions as a shortcut when you create or change
classified objects. In this lesson, you create and edit objects using object classes.

Exercise 1: Create objects using object classes
When you create an object using object classification, the new object inherits
the basic properties for its object class (page 413) with default values for those
properties. You can change the values as needed.

When you query in objects from a DWG file to a map, any styling information
is lost. Since the points are not styled, you cannot see them in your new map.
To see the signal points, assign a point style to your map.

Once the signals are visible, you create a signal using the Signals object class.

NOTE This exercise uses the map you created in Exercise 1: Create objects using
object classes (page 200).
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To assign a point style to your map

1 If the ObjectClass.dwg file you created in the previous exercise is not still

open, open it. Click  ➤ Open  ➤ Drawing.

2 To assign a point style, at the command prompt enter ddptype.

3 In the Point Style dialog box, select any point style in the second row.
You can use the default point size settings.

Select a point style for the signals.

4 Click OK.

To create a Signals object

1 Zoom in until you can see the signal points easily.

2 On the Map Explorer tab of the Task pane, right-click the Signals object
class and click Create Classified Object.
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Right-click the appropriate object
class to create an object in that
class.

3 Click a position on the map for the point.

4 Press Enter to create a Signals object.

5 Press Esc to end the creation operation.

6 To enter properties for the new Signals object, select the point, right-click
it, and click Properties.
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Use the Properties palette to view or
change the properties for the new
object.

To continue this tutorial, go to Exercise 2: Edit classified objects (page 203).

Exercise 2: Edit classified objects
Use object classes as a quick way to select all objects in a class and change
their properties. This does not change the object class definition itself, only
the properties of the objects in that object class (page 413).

NOTE This exercise uses the map you created in Exercise 1: Create objects using
object classes (page 200).
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To change the color of the classified parcels

1 If the ObjectClass.dwg file you created previously is not still open, open

it. Click  ➤ Open  ➤ Drawing.

2 On the Map Explorer tab of the Task pane, right-click the Parcels object
class name.

3 Click Select Classified Objects.

All objects classified as Parcels are selected.

4 Right-click any of the selected parcels and click Properties.

5 In the Properties palette, click the Pattern Fill Color field (under Pattern
on the Design tab) and choose a different color.
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Change the fill color of all objects in the Parcels
object class using the Properties palette.

6 When prompted to save the changes back to the save set, click Yes to
change the parcel color in the original file. Click No to change it only in
the current map.

Where you are now

You created and edited objects using the object class definitions.
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To continue this tutorial, go to Lesson 6: Generate Metadata for a Classified
Drawing (page 206).

Lesson 6: Generate Metadata for a Classified
Drawing

Metadata is data about data. For example, metadata includes information
about object class definitions, as well as more general information, such as
the coordinate system used by the drawing. When you classify objects in a
drawing, AutoCAD Map 3D generates metadata automatically. You can view
and share this metadata.

Exercise 1: View metadata
If a drawing contains classified objects, its , metadata (page 413) is automatically
generated and displayed when you open the Metadata Viewer the first time.

The metadata is stored inside the drawing itself. Metadata is updated each
time you edit the drawing or reconnect to the attached drawings that contain
classified objects.

NOTE This exercise uses the map you created in Exercise 1: Create objects using
object classes (page 200).

To view metadata

1 If the ObjectClass.dwg file you created previously is not still open, open

it. Click  ➤ Open  ➤ Drawing.

2 Click the Map Explorer tab on the Task pane.

3 Expand the Object Classes item.

4 Right-click an object class (page 413) and click View Metadata.

5 In the Metadata Viewer, scroll down to see the various fields and data.
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Metadata for classified drawings is generated automatically.

To continue this tutorial, go to Exercise 2: Share metadata (page 207).

Exercise 2: Share metadata
You can export metadata (page 413) from your drawing to an XML file with
the extension .mtd. A linking file is also created and placed in the same location
as the MTD file. You can set an Auto Update option in the Metadata Options
dialog box. With this option on, the linking file remembers the location of
the data and keeps the exported metadata current.

NOTE This exercise uses the map you created in Exercise 1: Create objects using
object classes (page 200).

To export metadata

1 In the Metadata Viewer, click Options (in the top-right area of the
Metadata Viewer window).
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2 In the Metadata Options dialog box, click the Preference tab.

3 Select the Auto Update When Selecting Data Source option.

4 Click OK.

5 In the Metadata Viewer, click Export (at the top of the Metadata Viewer
window).

6 In the Export Metadata dialog box, do the following:

■ Select All Items In and select the Object Classes check box.

■ For Location, click Browse and navigate to a folder for the exported
metadata and link files.
For example, navigate to the folder where you copied your tutorial
files.

■ Click Export.

Use object classes to organize the exported metadata.

Where you are now

You generated metadata (page 413) that included object class (page 413)
information. You exported the metadata for the object classes.

To continue this tutorial, go to Lesson 7: Use Object Classes When Exporting
(page 209).
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Lesson 7: Use Object Classes When Exporting
When you export to a spatial data format, such as Autodesk SDF, Oracle, or
SHP, you create feature classes. Feature classes are like object classes: they have
properties that represent the geometry of objects, as well as properties that
represent attribute data. Some database spatial data formats support multiple
feature classes within a single file. These formats include Oracle, SQL Server,
and some file-based data formats, such as Autodesk SDF. Some formats (for
example, SHP) store only a single feature class in each file.

If you have classified objects in your drawing, you can use the object classes
as the basis for the new feature classes. In this lesson, you export the object
classes in your drawing to multiple feature classes in a single Autodesk SDF
file. You then connect to that file in a new drawing to see how the resulting
feature classes appear in a map.

Exercise 1: Export object classes to SDF
In this exercise, you export the object classes in your drawing to multiple
feature classes in a single Autodesk SDF file.

NOTE This exercise uses the map you created in Exercise 1: Create objects using
object classes (page 200).

To export to an Autodesk SDF file using object classes

1 If the ObjectClass.dwg file you created previously is not still open, open
it.

2 Click Output tab ➤ Map Data Transfer panel ➤ As SDF. 

3 In the Export Location dialog box, do the following:

■ Make sure that Files Of Type is set to Autodesk SDF (*.sdf).

■ Navigate to the folder where you copied the tutorial data.

■ For the file name, enter Roads_Parcels_Signals.sdf.

■ Click OK.

4 In the Export dialog box, under Filter Selection, click Select Object Classes.
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5 In the Select Object Classes dialog box, hold down the Ctrl or Shift key
and click all three object classes. Click Select.

6 In the Export dialog box, click the Feature Class tab and do the following:

■ Under Object To Feature Class Mapping, click Create Multiple Classes
Based On Drawing Object.

■ For Drawing Object To Use, select Object Class.

■ Click Select Attributes.

7 In the Select Attributes dialog box, expand the Object Classes item and
select all three object classes. Click OK.

The new SDF file will contain one feature class for each object class (page
413) you selected. The properties of each feature class match the attributes
of its corresponding object class.

8 On the Feature Class tab of the Export dialog box, under Object To Feature
Class Mapping, specify the appropriate Geometry entry:

■ For Roads, select Line.

■ For Parcels, select Polygon.

■ For Signals, select Point.
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Use object classes to create feature classes, specifying the
geometry type for each one.

9 Click OK.

To continue this tutorial, go to Exercise 2: Connect to the resulting SDF file
(page 211).

Exercise 2: Connect to the resulting SDF file
In this exercise, you connect to the new SDF file you created and see the feature
classes that were created from the three object classes.

NOTE This exercise uses the SDF file you created in Exercise 2: Connect to the
resulting SDF file (page 211).
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To connect to an SDF file

1 In AutoCAD Map 3D, create a map. Click  ➤ New  ➤ Drawing. Select
the map2d.dwt template and click Open.

2 In the new map file, in the Task pane, click Data  ➤ Connect To Data.

3 In the Data Connect window, do the following:

■ Under Data Connections By Provider, click Add SDF Connection.

■ For Source File, click the file icon next to the field.

■ Navigate to the SDF file you created in Exercise 1: Export object classes
to SDF (page 209).

■ Select the file and click Open.

■ Click Connect.

Specify the file to connect to.

■ Under Add Data To Map, select all three feature classes listed.
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Select the feature classes and add them to the map.

■ Click Add To Map.

4 Close the Data Connect window.

5 In the Task pane, click the Display Manager tab to see the three feature
classes.

To continue this tutorial, go to Exercise 3: Style the new feature classes (page
213).

Exercise 3: Style the new feature classes
You can use the geospatial features of AutoCAD Map 3D to style the feature
classes.

NOTE This exercise uses the map you created in Exercise 2: Connect to the
resulting SDF file (page 211).
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To style the feature classes

1 If the map you created in the previous exercise is not still open, reopen
it.

2 In Display Manager, click the Parcels layer and click Style.

3 In the Style Editor, click in the Style field.

4 In the Style Polygon dialog box, change the Foreground Color to a light
brown and click OK.

5 With the Style Editor still open, click the Roads layer in Display Manager.

6 In the Style Editor, do the following:

■ Click the browse button next to the Feature Label field.

■ In the Style Label dialog box, from the Property To Display list, select
ST_NAME. Click OK.

■ In the Style Editor, click in the Style field.

■ In the Style Line dialog box, change the Color to a dark gray.

7 With the Style Editor still open, click the Signals layer in Display Manager.

8 In the Style Editor, click in the Style field.

9 In the Style Point dialog box, do the following:

■ Click the browse button next to Symbol and choose the round symbol.

■ Change the Fill Color and Edge Color to a light gray.

10 Close the Style Editor.

The map is now styled with the colors and symbols you chose. The roads are
labeled with their street names. The original data is unaffected by these styling
changes.

Where you are now

You used object classes to export the drawing objects to a geospatial format.

To learn about guidelines to follow when using object classification, go to
Object Classification: Best Practices (page 215).
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Object Classification: Best Practices
When setting up and using object classification, follow these guidelines for
the best results:

■ Use only one object class definition (page 413) file for a project. Object classes
should be general enough that a definition for “roads” is appropriate in
any circumstance. Create subclasses for freeways, parkways, small streets,
and so on.

■ Only one person should edit object class definitions at a time, or one set
of edits might be lost. If the definition file was just edited, quit AutoCAD
Map 3D and restart it to get the updated definitions.

■ Distinguish between the Object Type (on the Applies To tab of the Define
Object Classification dialog box) and the Create Method (on the Class
Settings tab). Object Type determines which existing objects you can add
to this object class (page 413). If the object was not created with the selected
method, you cannot add it. Create Method determines the method used
to create new objects from this class (when you right-click the object class
and choose Create Classified Object).

NOTE If you plan to use this object class with objects from a drawing source,
do not select more than one object type

■ Avoid renaming object classes, because this changes the name only in the
object class definition file. Objects tagged with the object class name are
unchanged. Since these objects point to a name that no longer exists in
the object class definition file, the objects become undefined. You can
search for undefined objects and update their object class name.

■ Avoid including styling options in object class definitions. For example,
you can draw points using a block. You can specify that block if you use
Block as the Create Method for an object class that represents point data.
However, the block will not scale to the map, and might cause more work
than it saves. Instead, create a drawing layer in Display Manager and assign
the point objects to that layer. Style the layer from Display Manager using
the desired block.
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Tutorial: Creating a Map
Book With an Inset

About the Map Book Tutorial
A map book is like an atlas: it takes a single map and divides it into "tiles" by
placing a grid over it. Each square of the grid becomes a map tile. Each tile is
then rendered on a separate page, which you can publish to a plotter or to an
electronic format called DWF. Once you publish a map to DWF, you can share
it with people who do not have a copy of AutoCAD Map 3D. These people can
download Autodesk Design Review (page 409), a free viewer available from
http://www.autodesk.com, to see the maps.

Map books use viewports to organize the information on each page. A viewport
is like a frame on a web page. You can create a custom viewport as an inset (page
412) on one or more of the map book pages. Pan and zoom within that viewport
to display an enlarged detail of the map.

You can also link a regular “key” viewport on the map book to a copy of the
main map file. Then, every tile of the map book displays the overall map in a
small window.

Lesson 1: Prepare the Map
In this lesson, you create a map and add the city boundary and roads for the
city of Redding, California.

6
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Exercise 1: Create a map
When you create a map, you begin by assigning the coordinate system. That
way, AutoCAD Map 3D can convert data you add to align properly within the
map.

To create the map

1 If you have not already done so, copy the sample files for the tutorials
(page 2) to a directory on your hard drive.

2 Start AutoCAD Map 3D.

3 Click  ➤ New  ➤ Drawing. Use the map2d.dwt template (page 416).

4 Assign a coordinate system to the new map.

■ Switch the Task Pane to Map Explorer.

■ Right-click the Current Drawing entry and select Coordinate System.

Set the coordinate system from Map Explorer.

■ Specify the CA-I coordinate system and click OK.

To continue this tutorial, go to Exercise 2: Add data to your map (page 218)

Exercise 2: Add data to your map
Connect to data files representing the city boundaries and roads.
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NOTE This exercise uses the map you created in the previous exercise (page 218).

1 If the map you created is not open in AutoCAD Map 3D, reopen it.

2 Add the city boundary data to your map.

■ Switch the Task Pane to Display Manager.

■ Click Data and choose Connect To Data.

■ In the Data Connect window, under Data Connections By Provider
(on the left), select Add SDF Connection.

■ Under Source File (on the right), click the browse button and navigate
to the sample City_Boundary.sdf file. Click Connect.

Use the Data Connect window to add a feature to the map

■ Under Schema, check the City_Boundary entry and click Add To Map.

3 Add the road data to your map.

■ In the Data Connect window, under Data Connections By Provider
(on the left), select Add SHP Connection.

■ Under Source File (on the right), click the browse button and navigate
to the sample Roads.shp file. Click Connect.

■ Check the Roads entry and click Add To Map.

■ Close the Data Connect window.

4 Save the map using the name MyMap.dwg.
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Where you are now

You created a map and connected to feature sources for the city boundaries
and the roads of Redding, California.

To continue this tutorial, go to Lesson 2: Customize a Map Book Template
(page 220)

Lesson 2: Customize a Map Book Template
AutoCAD Map 3D comes with various map book templates that make it easy
to create a map book. Each template (page 416) contains all the basic map book
elements, which you can customize for a particular purpose.

Exercise 1: Change the printer/plotter for the template
Open an existing map book template (page 416) and begin customizing it by
specifying your printer or plotter.

NOTE This information is used every time you publish your map book to a plotter.
You cannot change these settings at print time.

To assign a printer or plotter to a map book template

1 Open the 8.5x11 map book template.

■ Click  ➤ Open  ➤ Drawing.

■ Change Files Of Type to Drawing Template (*.DWT).
AutoCAD Map 3D automatically changes to the Template folder.

■ Scroll about halfway down the list of templates.

■ Select Map Book Template - 8.5x11 Classic.dwt.

■ Click Open.
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Scroll halfway down the list of templates and select the first map book template.

2 If necessary, zoom out to see the entire template. Click View

tab ➤ Navigate panel ➤ Zoom drop-down ➤ Extents. 

3 Right-click the layout tab labeled Ansi_A and select Page Setup Manager
to specify plotter and paper information.

Right-click the layout tab for the map book
and choose Page Setup Manager.

4 In the Page Setups list, select *Ansi_A* and click Modify.
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5 Select one of the DWF plotter choices from the Name list.

6 Change any other settings you like.

7 Click OK and then Close.

To continue this tutorial, go to Exercise 2: Resize the main viewport (page 222)

Exercise 2: Resize the main viewport

The original template has a large main viewport with adjacent arrows
(page 409) around its edge, and a title block (page 416) with placeholders
you can change.

The template (page 416) contains three types of objects:

■ The large rectangle on the left side of the page layout is the main viewport.
It will display a single map tile (page 416) in the map book.

■ The gray polygons around the edge of the main viewport are adjacent
arrows (page 409). They will contain the names of adjacent tiles in the map
book, so you can find the next section of the map in any direction. The
adjacent arrows are separate objects and do not move with the main
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viewport. You can move them manually. However, they link to the adjacent
map tiles automatically. You do not have to connect them manually.

■ The title block contains placeholder text that you can change. Some of
the text is created from variables, which update automatically when you
save the map file that uses this template. For example, the Filename tag
uses the name you give to the saved map file that uses this template.

NOTE This exercise uses the template you modified in the previous exercise (page
220).

To adjust the main viewport and the adjacent arrows

1 Click the frame of the main viewport once to select it.

2 Drag the blue squares to resize the viewport.

3 Click again to set the new size. Press Esc when you are finished.

4 To move an adjacent arrows (page 409) after you resize the viewport, click
the arrow once to select it.

5 Drag the arrow to a new location and click when it appears in the desired
spot. Press Esc to deselect it.
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The viewport was resized and the adjacent arrows (page 409) were
adjusted accordingly.

6 Do not save the template yet. Leave it open for the next exercise.

To continue this tutorial, go to Exercise 3: Modify the title block (page 224)

Exercise 3: Modify the title block
If your organization has its own title block (page 416), you can insert that block
definition into the template (page 416) file and replace the default one. However,
this exercise assumes that you do not have such a block and explains how to
customize the one included with the template.

The title block definition has properties that define its text and appearance.
You can change the values for these properties. For example, you can specify
the value for text variables or the appearance of the borders of the block.

NOTE The title block consists of several smaller blocks, such as the legend (page
412) and key map viewports. You can explode the title block to resize, modify, or
delete some of its component blocks, but this tutorial does not cover that operation.
In this exercise, you change only the properties of the current title block definition.
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NOTE This exercise uses the template you modified in the previous exercise (page
222).

To change the title block attributes

1 Double-click the frame of the title block to see the Enhanced Attribute
Editor.

You can change any property of the title block

NOTE If you double-click a viewport within the title block by mistake,
right-click inside the viewport and click Minimize Viewport.

2 Change the organization name.

ORGANIZATION_NAME is a text field whose default value is
“Organization Name.” You can replace this default value by typing a
different one.

■ Click the Attribute tab and click the ORGANIZATION_NAME field.

■ For Value, type the name of your organization.

■ In the Enhanced Attribute Editor, click Apply.

3 Change the plot date entry.

P_DATE (plot date) is a variable that can update automatically, based on
a field. In this example, you set P_DATE to the date that the drawing was
last revised.

■ Click the Attribute tab and click the P_DATE field.
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■ Right-click the value (---) and select Insert Field.

Right-click the value to insert a field.

■ In the Field dialog box, under Field Names, select
CurrentSheetRevisionDate.

■ Under Format, select Title Case.

■ Click OK.

4 Specify a different text style.

You can format the text for various elements of the title block.

■ In the Enhanced Attribute Editor, click the Text Options tab.

■ For Text Style, select North Arrow Text.

■ For Justification, select Center.

■ Click Apply.

5 Customize the lines used in the title block.

■ In the Enhanced Attribute Editor, click the Properties tab.

■ Select a different line type, line weight, or color for the title block.

6 Click OK.
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7 Save the modified template.

■ Click  ➤ Save As  ➤ AutoCAD Drawing Template.

■ Specify a new name (for example, Map Book Template - Inset.dwt).
Save the template in the Templates directory if you plan to reuse it.
Otherwise, save it in My Documents.

8 Edit the description when it displays. Leave Save All Layers As
Unreconciled selected.

9 Leave the template file open for the next exercise.

To continue this tutorial, go to Exercise 4: Replace the north arrow block (page
227).

Exercise 4: Replace the north arrow block
AutoCAD Map 3D comes with sample files, including blocks such as north
arrow symbols. You can delete the default north arrow and replace it with
one of the sample blocks.

The template (page 416) also has an area in which you can insert your company
logo as a block. The process would be similar.

NOTE This exercise uses the template you modified in the previous exercise (page
224).

To replace the north arrow in the map book template

1 If the template you modified is not still open, open it again.

2 Click the north arrow block in the template and press Delete.

3 Open the sample file containing the north arrow symbols.

By default, the north arrow file is C:\Program Files\AutoCAD Map 3D
2011\Sample\Symbols\North Arrows.dwg.

4 In the North Arrows.dwg file, click a north arrow symbol.

5 Right-click the selected symbol and click Copy.

6 Close the North Arrows.dwg file and, in the template file, right-click a
blank area and click Paste As Block.
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7 At the Specify Insertion Point prompt, click the location for the new
north arrow.

8 Save and close the template file.

Where you are now

You modified a map book template to use your printer or plotter. You changed
the size of the main viewport and adjusted the adjacent arrows (page 409). You
changed the attributes of the title block (page 416). You replaced the default
north arrow with another one.

To continue this tutorial, go to Lesson 3: Create A Map Book (page 228)

Lesson 3: Create A Map Book
You create a map book within the map file itself—not within the template
(page 416). When you create the map book, you specify the template to use.
In this case, you specify the template you modified in Lesson 2 (page 220) (Map
Book Template - Inset.dwt).

Exercise 1: Create a key map view and a legend
The template (page 416) contains a viewport called a key map. The key map
view displays the same content for every tile (page 416) in the map book. Often,
a key view (page 412) contains the entire mapped area, to provide context for
the smaller area represented by the tile.

You can link the key map viewport to any external drawing. In this exercise,
you save a copy of the current drawing to use as a key map view.

The template also contains a viewport called Legend. You can link this viewport
to an external drawing you use as a legend (page 412), or (if your map contains
a legend), to the internal legend. In this exercise, you generate a legend for
the map to display in the Legend viewport.

1 Open the map you created in Lesson 1: Prepare the Map (page 217).

For example, if you named the map from lesson 1 MyMap.dwg, open that
file.

2 Create a copy of the map to use as a key map view. Click  ➤ Save
As  ➤ AutoCAD Drawing.
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Save the map with a similar name to the original one. For example, if the
original map is MyMap.dwg, save this version as MyMapKeyView.dwg.

3 Close the map file and reopen the original one (MyMap.dwg).

You will use MyMapKeyView.dwg in the next exercise, when you link it
to the Key Map viewport.

4 Generate a legend that you can link to the Legend viewport.

■ Switch the Task Pane to the Display Manager tab.

■ Click Tools  ➤ Create Legend.

■ Click a blank space that is outside the bounding box of the mapped
area.
Make sure there is some space between the map itself and the legend.
That way, you can define the tiled area for the map book without
including the legend in it.

To continue this tutorial, go to Exercise 2: Specify the map book settings (page
229).

Exercise 2: Specify the map book settings
The Create Map Book dialog box guides you through all the settings needed
for a map book. You can save your settings to use for future map books.

NOTE This exercise uses the map you modified in the previous exercise (page
228).

To specify the map book settings

1 On the Display Manager tab of the Task Pane, right-click the
City_Boundary layer and click Zoom To Extents.

2 Save the map file.

You cannot publish a map to any format without saving it first.

3 Switch the Task Pane to Map Book and click New  ➤ Map Book.
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Each item on the left displays settings on the right.

4 In the Create Map Book dialog box, for Source, click Model Space.
Optionally, change the Map Book Name.

5 For Sheet Template, do the following:

■ Click Settings.

■ Click the browse button for Choose A Sheet Template and navigate
to the saved template (page 416) you created (Map Book Template -
Inset.dwt).

■ Leave the layout set to Ansi_A.

■ For Layout Options, check Include A Title Block (Name Or File) and
Include Adjacent Sheet Links (Name Or File).

■ For the title block (page 416), click the down arrow and click Title Block.
For adjacent sheet links, click the down arrow and click
Adjacent_Arrow_4.
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■ Set the scale factor to 5000.

NOTE If you do not set the Scale Factor, the map book will comprise a
large number of tiles (page 416). Be sure to set it to 5000.

6 For Tiling Scheme, do the following:

■ Click By Area.

■ Click Select Area To Tile and drag a rectangle around the extents of
the map.

■ Leave the other settings set to their defaults.

7 For Naming Scheme, click Columns And Rows. Leave the settings set to
their defaults.

8 For Key, click External Reference. Browse to the key view (page 412) map
you created in the previous exercise (page 228) and select it.

The Key Map viewport will display the key map you generated in the
previous exercise.

9 For Legend, click Map Display.

The Legend viewport will display the legend (page 412) you generated in
the previous exercise (page 228).

10 For Sheet Set, click Create New.

Do not generate the map yet. Leave the dialog box open for the next
exercise.

To continue this tutorial, go on to Exercise 3: Preview and generate the map
book (page 231).

Exercise 3: Preview and generate the map book
You can see how the map book will be divided into tiles (page 416) before you
generate it.

NOTE This exercise uses the map you modified in the previous exercise (page
229).
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To preview and generate the map book

1 With the Create Map Book dialog box still open from the previous
exercise, click Preview Tiles.

The preview shows how the tile divisions for the map book.

2 When you are finished examining the preview, press Enter to select the
eXit option and return to the Create Map Book dialog box.

3 Click Generate to create the map book.
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When you generate the map book, the tiles are listed in the Task Pane,
and one layout tab is displayed for each tile.

Each letter represents a row of
tiles, with the numbered tiles for
that row indented below it

One layout tab is created for each of the map book tiles

4 Click one of the new layout tabs to see the portion of the map that it
contains.
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The map tile for the layout tab appears in the main viewport.

■ The title block (page 416) contains the name of your organization.

■ The Legend viewport displays the legend (page 412) for the map.

■ The Map Key viewport displays the map as a whole.

■ The north arrow is the one you added.

■ The File Name is the name of the current map drawing.

5 Hold down the Ctrl key and click one of the adjacent arrows (page 409).

The view changes to show the adjacent tile.

6 To save the map book settings for future use, right-click the map book
name on the Map Book tab of the Task Pane. Click Save Settings. Specify
a name and location for the settings file.

To use these settings for a different map book, follow these steps:

■ Open the map file to publish to a map book.

■ Switch to Map Book in the Task Pane.
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■ Click New  ➤ Map Book From Settings.

■ Select the settings file you saved.

Where you are now

You previewed and generated the map book, producing multiple tiles that
each contain a portion of the original map. You used the layout tabs to view
individual tiles, and the adjacent arrows (page 409) to move between tiles.

To continue this tutorial, go to Lesson 4: Create an Inset (page 235)

Lesson 4: Create an Inset
You will create an inset (page 412) on one tile (page 416) in the map book. The
inset is a new viewport that you set up to display a particular area and zoom
level.

Exercise 1: Draw a viewport for the inset
You can create your own viewports, as well as customizing the ones that appear
on the template (page 416) by default. In this exercise, you will draw a viewport
on a map tile (page 416) to show a zoomed-in detail.

NOTE This exercise uses the map you modified in the previous lesson (page 228).

To create the viewport

1 Click the layout tab for the tile on which the inset (page 412) will appear.

In this example, the inset appears on B-25.

2 At the Command prompt, type vports.

The Command prompt appears as soon as you begin typing anywhere
within the map window.

3 On the New Viewports tab of the Viewports dialog box, in the Standard
Viewports list, select Single and click OK.

4 Place your cursor over the blank area next to the main viewport.

5 Drag to draw the viewport on the layout, and click when it is the size
you want.
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6 Leave the map open and the current layout tab displayed for the following
exercise.

To continue this tutorial, go to Exercise 2: Change the information displayed
in the viewport (page 236)

Exercise 2: Change the information displayed in the
viewport

When you first create the viewport, it displays the entire map. You can zoom
in to display a detail for this map tile (page 416) instead.

NOTE This exercise uses the map you modified in the previous exercise (page
235).

1 The layout tab with the new viewport you created in the previous exercise
(page 235) should still be displayed. If not, reopen it.

2 Double-click inside the new viewport.

3 Use any AutoCAD Map 3D zoom and pan commands to display the area
of interest for this map tile.
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In this example, the roads were styled to display a composite style when the map is
zoomed in. To learn how to do this, see the “Building A Map” tutorial, Lesson 3: Change
the Display by Zoom Level (page 55).

NOTE In a real-world example, your map might have many layers, and the
inset (page 412) might be too crowded with data to be helpful. You can use
the AutoCAD layfrz command to delete undesired layers and simplify the
inset. See the AutoCAD Help for more details.

Where you are now

You created an inset on one map tile and used it to display a close-up view of
a detail of the map.

To continue this tutorial, go to Lesson 5: Publish The Map Book (page 237).

Lesson 5: Publish The Map Book
You can publish a map book to a printer or plotter or to an electronic format
called DWF (Drawing Web Format). In this case, you publish to DWF. You
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can share a DWF file with people who do not have a copy of AutoCAD Map
3D. These people can download a free viewer, Autodesk Design Review (page
409), from http://www.autodesk.com/designreview to view the DWF file.

Exercise 1: Set DWF publishing options
Set the options that control the information published with the map.

NOTE This exercise uses the map you modified in the previous lesson (page 235).

To set DWF options

1 If you closed the map file from the previous exercise (page 236), reopen
it.

2 Click Output tab ➤ Export To DWF/PDF panel ➤ DWF Options. 

3 Select the Publish Map Information check box.

4 Expand the GIS Feature Sources item to see what is included.

If you expand the list all the way, you can see the properties associated
with the features in this map.

5 Check the GIS Feature Sources item.

All subitems are automatically checked.
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The Map Information dialog box
determines which data is published to DWF

Optionally, you can select just a subset of the properties.

6 Click OK.

The first time you set these options, specify a name and location for the
publishing settings. In subsequent publishing sessions, AutoCAD Map
3D uses the last settings file you used.

To continue this tutorial, go to Exercise 2: Set background publishing options
(page 239).

Exercise 2: Set background publishing options
Publishing is faster if you turn off background publishing. Settings you change
in this dialog box remain in effect for all new drawings until you change the
settings again.

NOTE This exercise uses the map you modified in the previous exercise (page
238).

To set background publishing options

1 Click  ➤ Options.

Exercise 2: Set background publishing options | 239



2 Click the Plot And Publish tab.

3 Under Background Processing Options, clear the Publishing check box
for Enable Background Plot When.

4 Click OK.

To continue this tutorial, go to Exercise 3: Publish the map book to DWF
format (page 240).

Exercise 3: Publish the map book to DWF format
Save the map before you publish. You cannot publish to any format without
saving first.

NOTE This exercise uses the map you modified in the previous exercise (page
239).

To publish the map book to DWF format

1 Save the map.

2 On the Map Book tab of the Task Pane, right-click the map book name
(in this example, it is Default-ModelSpace) and click Publish To DWF.

3 Specify a name for the output file.

4 If prompted, choose a sheet set.

5 If you see the message that tells you the job is processing in the
background, click OK.

Notice the animated icon in the lower right corner of the window.

Place your cursor over
the animated icon to
see which page of the
map book is being
published.
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When the job is finished, a message
alerts you to any errors.

You can view the details

Where you are now

You customized a map book template (page 416) and used it to create a map
book. You published the map book to DWF format, so you can share it with
people who do not have a copy of AutoCAD Map 3D. These people can

Exercise 3: Publish the map book to DWF format | 241



download a free viewer, Autodesk Design Review (page 409), to see the maps.
Autodesk Design Review is available from http://www.autodesk.com/designreview.
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Tutorial: Analyzing Data

About the Analyzing Data Tutorial
This tutorial demonstrates the following ways to analyze data in AutoCAD Map
3D:

■ Analyze data visually, using surfaces.
Connect to a surface (DEM) image and style it using a theme to show relative
elevation. Then, connect to a file that shows parcel information and make
the parcels semi-transparent so you can see the raster image below them.
The elevation theme of the raster helps you see the elevation of the parcels.

■ Analyze data with external information using joins.
Join a Microsoft Access database to a parcels layer to see information about
the parcel owners. Joins combine data sources temporarily, without altering
the original data stores. Use the combined data as though it were a single
data source. For example, style a layer based on its joined data, even though
the joined data is not part of the original layer data store. Create calculated
fields using native and joined data.

■ Analyze data by proximity using buffers.
Define a buffer around a street to see which parcels lie within a construction
zone. Select the parcels that adjoin the buffer and save them separately so
you can notify their owners, using the owner information you joined to the
parcels.

Export relevant data to a comma-separated file that you can import into
Microsoft Excel or Access. Use that data to create a report to send to the
owners.

■ Perform a flood analysis with Overlay.

7

243



Overlay a flood zone layer with a layer representing the business zone.
Add a roads layer to see which streets in the business zone lie within the
flood zone. Add a layer representing hospitals to see which areas are the
furthest from help if the area floods.

■ Automate an operation with a workflow.
Expand a predefined workflow that saves Display Manager layers to .layer
files. Use AutoCAD commands to edit the layers first, check in your
changes, and then save the results to .layer files.

Lesson 1: Analyze Data Visually, Using Surfaces
Use Data Connect to attach a DEM file to a map. Style the surface to show the
elevation information it contains.

Exercise 1: Prepare your map file
Create a map file and assign a coordinate system. Color the map background
white so you can better distinguish features when you use color to style them.
All maps you create from now on use the new background color.

To create a map file

1 If you have not already done so, copy the sample files for the tutorials
(page 2) to a directory on your hard drive.

2 Start AutoCAD Map 3D and create a map using the map2d.dwt template.

3 Assign a coordinate system to the new map.

■ Click Map Setup tab ➤ Coordinate System panel ➤ Assign. 
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You can also right-click the current drawing to set
the coordinate system for the map in Map Explorer.

■ Specify the CA-I coordinate system.

4 Click  ➤ Save . In your tutorials folder, name the file
AnalyzeMap1.dwg and click OK.

To change the map background color

1 Click  ➤ Options .

2 In the Options dialog box, click the Display tab.

3 On the Display tab, in the Window Elements area, click Colors.

4 Under Context, select 2D Model Space.

5 Under Interface Element, select Uniform Background.

6 Under Color, select White.

7 Click Apply & Close, and then click OK.

To continue this tutorial, go to Exercise 2: Add a surface to view elevation
data (page 246).
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Exercise 2: Add a surface to view elevation data
A surface is a raster file that contains elevation information. Use theming to
make the surface reflect its elevation.

NOTE This exercise uses the AnalyzeMap1.dwg map you created in the previous
exercise.

To add a surface to the map

1 Click Home tab ➤ Data panel ➤ Connect. 

2 In the Data Connect window, under Data Connections By Provider, click

Add Raster Image Or Surface Connection and click  next to Source
File Or Folder.

3 In the Open dialog box, browse to the ENTERPRISE.dem file, select it, and
click Open.

Look for this file where you copied the sample data.

Connect to the surface file in the Data Connect window.

4 In the Data Connect window, click Connect.
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NOTE The coordinate system for the DEM file is UTM27-10. AutoCAD Map
3D automatically converts the data from that coordinate system to the one
specified for your map.

5 Click Add To Map.

6 Close the Data Connect window to see the surface in your map.

To style the surface

1 In Display Manager, select the ENTERPRISE layer, which contains the
surface.

2 Click  .

3 Create a palette for the theme.

■ In the Style Editor, under Raster Style For 0 - Infinity Scale Range,
click the down arrow in the Style entry. Select Theme (even if it is
already selected).

Click the first Style entry and select Theme.

■ In the Theme dialog box, under Specify A Theme, click Palette and
select USGS National Map Palette.
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Select the USGS National Map palette as the theme
for the surface.

■ Click OK and then click Apply. Close the Style Editor.

4 Add exaggeration to show the differences in elevation more dramatically.

■ In the status bar below your map, click the down arrow next to Vertical
Exaggeration.

■ Select 25x from the list.
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Set the Vertical Exaggeration to 25x.

5 Add contour lines to create a topographic map.

Each contour line connects points of equal elevation on the surface. The
lines identify the elevation at a specific location on the surface, which
can help the viewer clarify and analyze the 3D surface terrain.

■ In Display Manager, right-click the surface layer and click Create
Contour Layer.

Exercise 2: Add a surface to view elevation data | 249



In Display Manager, right-click the surface layer
to create contours.

■ In the Generate Contour dialog box, in the Contour Elevation Interval
list, select 20.

■ Leave the Units set to Meters.

■ In the Major Contour Every list, select 4. This setting makes every
fourth contour line bold.

■ Select Label The Elevation. This labels the major (bold) contour lines
only.

■ For Create Contour As, select polyline.
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The Generate Contour dialog box settings

■ Click OK.

NOTE To label the intervening contour lines, use the Style Editor to change the
style for the new contour layer (not the surface layer itself). You can also use this
method to change the color or style for the contour lines.

■ Select the contour layer in Display Manager and click Style.

■ In the Style Editor, click  next to the Feature Label entry for
"IsMajor=False."

■ Select Elevation as the Property for the label.

■ Click OK.

To continue this tutorial, go to Exercise 3: Add a layer on top of the surface
(page 251).

Exercise 3: Add a layer on top of the surface
You can add a vector feature to a map containing a 3D surface. When you
display the map in 3D, AutoCAD Map 3D automatically drapes the vector on
the 3D surface.
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NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To add roads to the map

1 Click Home tab ➤ Data panel ➤ Connect. 

2 In the Data Connect window, under Data Connections By Provider, select
Add SHP Connection.

3 Click  next to the Source File field and navigate to the folder where
you copied the sample files.

4 In the Open dialog box, select ROADS.SHP and click Open.

5 In the Data Connect window, click Connect.

6 In the Data Connect window, click Add To Map.

7 Close the Data Connect window.

To style the roads in the map

1 In Display Manager, select the Roads layer and click Style.

2 In the Style Editor, click the Style entry.

3 In the Style Line dialog box, change the road color to dark gray.

4 Select a dashed pattern for the lines.

252 | Chapter 7   Tutorial: Analyzing Data



Select a dark gray, dashed pattern for the
roads.

5 Click OK and close the Style Editor.

Your map now contains the styled surface and road layers.

To continue this tutorial, go to Exercise 4: Drape a parcel layer on top of the
surface (page 254).
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Exercise 4: Drape a parcel layer on top of the surface
Now, add a layer that displays parcels in one part of the city of Redding. This
layer contains size, value, and address information about the parcels. It does
not contain information about the owners. You join to a data source that
contains that information later.

When you make the parcels semi-transparent, you can see the other features
underneath.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To add the parcel layer to the map

1 Click Home tab ➤ Data panel ➤ Connect. 

2 In the Data Connect window, under Data Connections By Provider, click
Add SDF Connection.

3 Click  next to the Source File field and navigate to the folder where
you copied the sample files.

4 In the Open dialog box, select Assessor_Parcels.SDF and click Open.

5 In the Data Connect window, click Connect.

6 Click Add To Map.

7 Close the Data Connect window.

8 In Display Manager, select the Parcels layer and click Table.

Information associated with the parcels is displayed, but the information
does not include owner-related data.

Data associated with the Parcels layer is displayed.

9 Close the Data Table.

254 | Chapter 7   Tutorial: Analyzing Data



To style the parcels in the map

1 In Display Manager, select the Parcels layer and click Style.

2 In the Style Editor, click the color in the Style entry.

3 In the Style Polygon dialog box, change the Foreground Transparency
setting to 50%.

4 Change the Foreground Color to a light shade.

Change the foreground transparency for the
parcel layer.

5 Click OK and close the Style Editor.

The parcel layer is draped over the surface. Because it is transparent, you
can see the surface underneath.

Where you are now

You added a surface that contains elevation information, and you used that
information to create a theme that varies color by elevation. You added contour
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lines to identify the elevation levels. You draped a layer of data over the surface
and made it transparent so you could evaluate its elevation based on the
surface beneath it.

The styled surface helps you evaluate parcel elevation.

To continue this tutorial, go to Lesson 2: Analyze Data With External
Information Using Joins (page 256)

Lesson 2: Analyze Data With External Information
Using Joins

Join the parcels layer to a Microsoft Access database that contains owner
information.

To connect to an Access database from AutoCAD Map 3D, first set up an ODBC
connection for that database using a control panel in Windows. Then, connect
to this source using Data Connect, just as you connected to the physical data
sources in your map. The only difference is that you do not add the ODBC
data to the map because it has no spatial properties.
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The database source contains a field that you can match to a field in the Parcels
layer. You can join the data to the parcels and style or analyze all the resulting
data seamlessly.

Exercise 1: Set up an ODBC connection for an Access
database

Set up an ODBC connection for the Microsoft Access database using the
Administrative Tools control panel in Windows.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To set up an ODBC connection for the Access database

1 From your Windows desktop, click Start  ➤  Settings  ➤  Control Panel
and open the Administrative Tools control panel.

2 In the Administrative Tools window, double-click Data Sources (ODBC).

3 In the ODBC Data Source Administrator dialog box, click Add.

4 In the Create New Data Source dialog box, click Microsoft Access Driver
(*.mdb) and click Finish.

5 In the ODBC Microsoft Access Setup dialog box, for Data Source Name,
enter Parcel_Owners.

6 Enter a description, for example, "Parcel owner information."
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Name the data source.

7 Under Database, click Select.

8 In the Select Database dialog box, navigate to the sample files and select
the Assessor.mdb file.

Specify the database for this data source.

9 Click OK in the Select Database, ODBC Microsoft Access Setup, and ODBC
Data Source Administrator dialog boxes.

10 Close the Administrative Tools control panel.

To continue this tutorial, go to Exercise 2: Connect to the Access database
(page 259).
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Exercise 2: Connect to the Access database
Connect to the ODBC data store in Data Connect. You do not add data from
the ODBC source to the map, because it does not contain spatial information.
The data in the Access database becomes available to AutoCAD Map 3D when
you connect to the ODBC source.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To connect to the Access database from AutoCAD Map 3D

1 Click Home tab ➤ Data panel ➤ Connect. 

2 In the Data Connect window, under Data Connections By Provider, click
Add ODBC Connection.

3 Click the button next to the Source field under Add A New Connection.

4 In the Open dialog box, select Parcel_Owners from the list of Data Source
Names and click Select.

Connect to the ODBC data source.

5 Click Connect.
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6 In the User Name & Password dialog box, click Login without entering
anything in the fields. (This database has not been set up for user name
and password protection.)

AutoCAD Map 3D has access to the non-spatial data as soon as you
connect to its source.

7 Close the Data Connect window without adding anything to your map.

To continue this tutorial, go to Exercise 3: Join the data from the ODBC source
to the layer containing the parcels (page 260).

Exercise 3: Join the data from the ODBC source to the
layer containing the parcels

After you connect to an external data source, you can join it to a layer in your
map using the Data Table. This method works as long as the two data sources
share a common property. You can see the results of the join immediately.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To join the ODBC parcel data to the geospatial parcel layer

1 In Display Manager, select the Parcels layer and click Table.

2 At the bottom of the Data Table, click Options  ➤ Create A Join.

In the Create A Join dialog box, the Primary Table Initiating The Join
entry is automatically displayed.

3 For Table (Or Feature Class) To Join To, select the ODBC_1:Fdo:Assessor
layer.

4 For This Column From The Left Table, select APN.

The entry for the corresponding Matches This Column From The Right
Table is automatically displayed.

5 Click OK to display all the data in the Data Table.

6 Scroll to the right to see the owner information.

To continue this tutorial, go to Exercise 4: Use the joined data for calculated
fields and styles (page 261).
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Exercise 4: Use the joined data for calculated fields and
styles

Now that you have joined owner data to the parcels layer, you can use the
joined information to create a calculated field and determine your styles.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To create a calculated field using joined data

1 At the bottom of the Data Table, click Options  ➤ Create A Calculation.

2 In the Create A Calculation window, enter a name for the calculated field,
for example “AcresByArea.”

3 Click Property to see a list of properties for the current layer. Select ACRES.

4 Click the operator for “divided by” (the slash character).

5 Hover over the [value] marker that is inserted to see a tooltip with
choices. Click Enter a Property. Select AREA.

6 Click Validate to make sure that the expression is a valid calculation.

7 When you see “The expression is valid,” click OK to create the calculated
field.

Scroll to the right in the Data Table to see the new field (just to the left
of the joined fields). It is gray, to indicate that it is a calculated field and
cannot be edited. However, you can use it for styling.

You can display information differently at different zoom levels in AutoCAD
Map 3D. Create a style that displays owner names on the parcel layer at a high
zoom level, but not at a lower one. (The parcel owner names come from the
joined data source.)

To create a style using the joined data

1 In Display Manager, select the Parcels layer and click Style.

2 Click the  button in the field under Feature Label.

3 For Property To Display, select Assessor|OWNERLASTNAME.

4 Click OK.
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5 Click Add a Scale Range so that you have two scale ranges, both the same.

6 Set the bounds of the first scale range to 0 to 10000 and the second to
10000 to Infinity.

7 Select the second scale range (10000 to Infinity).

8 Click  in the Feature Label field.

9 Clear the check box for Create A Label (at the top of the dialog box) and
then click OK.

10 Close the Style Editor.

11 Save your map file.

The new Parcels style displays the names of the owners when the view is
zoomed to 10000 or closer. The labels are not displayed when you zoom out
beyond that scale.

Where you are now

You joined information from a Microsoft Access database to a layer containing
parcels. Using the combined data, you created a calculated field. You created
a style that displays parcel owner information at high zoom levels, but does
not display these labels at lower zoom levels.

To continue this tutorial, go to Lesson 3: Analyze Data by Proximity Using
Buffers (page 262)

Lesson 3: Analyze Data by Proximity Using Buffers
Create a buffer that specifies an area within 100 feet of a particular street. Use
it to see which parcels are close to a construction project. Save the affected
parcel data to a separate SDF file.

The two sets of parcels represent the original set of Redding parcels and the
parcels that lie within the construction zone. Compare the two sets by
attaching both SDF data sources to your map as separate layers and styling
them differently.
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Exercise 1: Create a buffer representing a construction
zone

Start by creating the buffer.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To create the buffer

1 If your map is not still displayed, open it. Click  ➤ Open  ➤ 

Drawing.

Navigate to the map you created in the previous lessons. Select it and
click Open.

2 In Display Manager, clear the check boxes next to the surface and contour
layers to hide those layers and see the rest of the process more easily.

3 Right-click the Parcels layer and click Zoom To Extents.

4 Click Analyze tab ➤ Feature panel ➤ Feature Buffer. 

5 In the Buffer Features dialog box, set the buffer distance to 100 feet and
click Merge All Buffers.

6 Click Select Features.

7 Click a road in your map that runs through the parcel area.

8 Press Enter to return to the dialog box.

9 Click OK.
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The buffer is created as a separate layer in your map.

To continue this tutorial, go to Exercise 2: Select the parcels within the
construction-zone buffer (page 264).

Exercise 2: Select the parcels within the
construction-zone buffer

Use the buffer in a query to determine which parcels are within the
construction zone represented by that buffer. Then, export those parcels to
an SDF file for future use.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To find the parcels in the construction zone

1 In Display Manager, right-click the Parcels layer and click Query To Filter
Data.

2 In the Create Query dialog box, click Zoom Extents to zoom the drawing
window to the extents of the parcels layer.

3 In the Create Query dialog box, click Locate on Map and select Touching
Any Part Of  ➤ Polygon.

4 In the Enter Location Boundary prompt, click Select.
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Click Select in the prompt. Click the buffer to select it as the
location condition.

5 At the prompt "Select object," click the buffer polygon.

6 In the Create Query dialog box, click OK.

AutoCAD Map 3D filters the parcels to show only the ones that match the
buffer query you defined.
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Only the parcels that match the filter criteria are displayed in
the map.

To continue this tutorial, go to Exercise 3: Export the construction-zone parcels
to an SDF file (page 266).

Exercise 3: Export the construction-zone parcels to an
SDF file

The map now displays only the parcels that lie within 100 feet of the road
under construction. Select these parcels and save them to an SDF file so you
can easily use this information again.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To export the filtered parcels to an SDF file

1 Right-click the Parcels layer in Display Manager.

2 Click Export Layer Data to SDF.
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Right-click the Parcels layer to export it.

3 Specify a name and location for the file and click Save.

For example, name this file ConstructionParcels to distinguish it from
the other parcel file.

To continue this tutorial, go to Exercise 4: Compare the two parcel layers (page
267).

Exercise 4: Compare the two parcel layers
Remove the filtered parcel layer and connect to both the original and filtered
parcels as separate layers.
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NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To compare the two parcel layers

1 In Display Manager, right-click the Parcels layer and click Remove Layer.

2 Click Home tab ➤ Data panel ➤ Connect. 

3 In the Data Connect window, connect to the SDF file you created, which
contains only the parcels that lie within the construction zone. Add this
data to your map.

Leave the Data Connect window open, but move it to one side so you
can see the Task pane.

4 In Display Manager, select the new Parcels layer, and then click its name.
Enter a new name, for example, ConstructionParcels.

5 In the Data Connect window, connect to the file that contains the original
set of parcels. Add this data to your map and close the Data Connect
window.

The new layer is called Parcels in the Display Manager.

Compare the layers using styles

You can style the two layers differently and use transparency to see how they
compare.

NOTE You can also use Overlay to compare layers. For an example of Overlay,
see Lesson 4: Perform a Flood Analysis with Overlay (page 271) (the following
lesson).

Compare the two layers using styles

1 In Display Manager, right-click the original parcels layer (Parcels) and
click Edit Style.

2 In the Style Editor, set this parcel layer to be semi-transparent (50%
transparency) and a light green color. Leave the Style Editor open.

3 Click the construction-zone parcel layer (ConstructionParcels).

4 In the Style Editor, set this parcel layer to be opaque (0% transparency)
and a medium brown color. Close the Style Editor.

268 | Chapter 7   Tutorial: Analyzing Data



5 In Display Manager, redisplay the surface raster image by selecting its
box and the box for the contour layer.

6 In Display Manager, clear the check box for the buffer layer.

7 In Display Manager, click Draw Order.

8 Make sure the draw order looks like the illustration:

Click Draw Order to change how layers overlay
each other.

Where you are now

Your map now displays the raster image, overlaid with the
roads, the original parcel layer, and the construction-zone
parcels.
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To continue this tutorial, go to Exercise 5: Export the data to CSV for use in
a report (page 270).

Exercise 5: Export the data to CSV for use in a report
Display the Data Table for the construction-zone parcels. Export the data to
a comma-separated file. You can use the data in any way you like. For example,
use it in a report, or to create a mailing list for the owners of the
construction-zone parcels.

NOTE This exercise uses the AnalyzeMap1.dwg map you created and modified in
the previous exercises.

To export the construction-zone parcel data

1 In Display Manager, select the construction-zone parcel layer and click
Table.

2 In the Data Table, right-click the left-most column and click Select All.

3 Click Options (at the bottom of the table) and click Export.

Export property information from the Data Table.

4 Specify a name and location for the file and click Save.

5 Save and close your map file.

Where you are now

You exported information from the Data Table as a comma-separated file that
can be used to generate a report.
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To continue this tutorial, go to Lesson 4: Perform a Flood Analysis with Overlay
(page 271)

Lesson 4: Perform a Flood Analysis with Overlay
In this lesson, you overlay two layers. One layer represents the flood zone in
Redding, California. The other layer represents the enterprise (business) zone
in that city. You add and label road data to see which streets are affected. Then
you add a layer representing local hospitals. Use a buffer to see which streets
are farthest from help in the event of a flood.

Overlay creates a layer representing the area where two existing layers intersect.
Use Overlay to compare two layers that overlap in space.

You can choose from various overlay types, including the following:

■ Intersect shows just the areas that the two layers have in common.

■ Union shows the sum perimeter of the layers.

■ Clip removes areas outside the shared area.

■ Erase removes the shared areas and leaves the rest.

For a complete description of the overlay types, see Overlaying Two Feature
Sources.

Exercise 1: Add the layers to compare
To begin an overlay analysis, connect to the layers you are comparing and
add them to a map.

To add the layers to compare

1 If you have not already done so, copy the sample files for the tutorials
(page 2) to a directory on your hard drive.

2 Start AutoCAD Map 3D and create a map using the map2d.dwt template.

3 Assign a coordinate system to the new map.

■ Click Map Setup tab ➤ Coordinate System panel ➤ Assign. 
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You can also right-click the current drawing to set
the coordinate system for the map in Map Explorer.

■ Specify the CA-I coordinate system.

4 Connect to the first data store.

■ Click Home tab ➤ Data panel ➤ Connect. 

■ In the Data Connect window, under Data Connections By Provider,
select Add SDF Connection.

■ Click  next to the Source File field and navigate to the folder where
you copied the sample files.

■ In the Open dialog box, select FLOODZONE.SDF and click Open.

■ In the Data Connect window, click Connect.

■ In the Data Connect window, click Add To Map.

5 Connect to the second data store.

■ With the Data Connect window still open, under Data Connections
By Provider, select Add SDF Connection again.

■ Click  next to the Source File field and navigate to the folder where
you copied the sample files.

■ In the Open dialog box, select E_ZONE.SDF and click Open.
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■ In the Data Connect window, click Connect.

■ In the Data Connect window, click Add To Map.

6 Click  ➤ Save As. In your tutorials folder, name the file
AnalyzeMapOverlay.dwg and click OK.

To continue this tutorial, go to Exercise 2: Use an overlay to compare two
layers (page 273).

Exercise 2: Use an overlay to compare two layers
Compare the two layers you added in the previous exercise. The overlay shows
you which parts of the enterprise zone lie within the flood zone.

NOTE This exercise uses the AnalyzeMapOverlay.dwg map you created in Exercise
1: Add the layers to compare (page 271).

To use an overlay to compare the two layers

1 Analyze tab ➤ Feature panel ➤ Feature Overlay

2 In the Sources and Overlay Type window of the Overlay Analysis dialog
box, do the following:

■ For Source, select E_zone (Polygons).

■ For Overlay, select floodzone (Polygons).

■ For Type, select Intersect.

■ Click Next.

3 In the Set Output And Settings window of the Overlay Analysis dialog
box, do the following:

■ Enter a location for the overlay layer SDF file.

■ Enter a name for the layer. This name appears in Display Manager.

■ For Sliver Tolerance, select Don’t Remove Slivers.
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Slivers are tiny polygons that can result from the overlay procedure.
If you want to remove slivers, click Suggest to see a reasonable setting
for sliver removal.

■ Leave the remaining settings as they are and click Finish.

The map now displays the two original layers
and a new layer, representing the overlay.

4 Click the Display Manager tab on the Task pane.

5 Deselect the boxes for the original flood zone and enterprise zone layers,
so that only the overlay layer displays in the map.
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Hide all the layers except the
overlay.

6 Save the map.

To continue this tutorial, go to Exercise 3: Add and style a road layer (page
275).

Exercise 3: Add and style a road layer
You can see the area of the enterprise zone that lies within the flood zone.
However, it is hard to identify specific streets without a road map. In this
lesson, you add a road layer and label it with street names. That way, you can
identify the streets in the flood zone more easily.

NOTE This exercise uses the AnalyzeMapOverlay.dwg map you created and modified
in Exercise 2: Use an overlay to compare two layers (page 273).

To add roads to the map

1 Click Home tab ➤ Data panel ➤ Connect. 

2 In the Data Connect window, under Data Connections By Provider, select
Add SHP Connection.
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3 Click  next to the Source File Or Folder field and navigate to the
folder where you copied the sample files.

4 In the Open dialog box, select ROADS.SHP and click Open.

5 In the Data Connect window, click Connect.

6 In the Data Connect window, click Add To Map.

7 Close the Data Connect window.

To style the roads in the map

1 In Display Manager, select the Roads layer and click Style.

2 In the Style Editor, click the Style entry.

3 In the Style Line dialog box, change the road color to black and click OK.

4 In the Style Editor, click the Feature Label entry.

5 For Property To Display, select ST_NAME and click OK.

6 Close the Style Editor.
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The roads display their street names and lie on top of the
overlay layer.

To continue this tutorial, go to Exercise 4: Add emergency response points
(page 277).

Exercise 4: Add emergency response points
Add a layer to the map that represents emergency response centers. In this
case, you add a point layer that represents local hospitals.

NOTE This exercise uses the AnalyzeMapOverlay.dwg map you created and modified
in Exercise 3: Add and style a road layer (page 275).
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To add the points representing emergency response centers

1 Click Home tab ➤ Data panel ➤ Connect

2 In the Data Connect window, under Data Connections By Provider, select
Add SDF Connection.

3 Click  next to the Source File field and navigate to the folder where
you copied the sample files.

4 In the Open dialog box, select HOSPITAL.SDF and click Open.

5 In the Data Connect window, click Connect.

6 In the Data Connect window, click Add To Map.

To continue this tutorial, go to Exercise 5: Find streets that are far from a
hospital (page 278).

Exercise 5: Find streets that are far from a hospital
Use a buffer to find areas of the enterprise zone that are within the flood zone
and are also more than 5 miles from a hospital. Use the hospital points as the
buffer origin and set the buffer distance to 5 miles.

NOTE This exercise uses the AnalyzeMapOverlay.dwg map you created and modified
in Exercise 4: Add emergency response points (page 277).

To use a buffer to see which streets are far from a hospital

1 Click Analyze tab ➤ Feature panel ➤ Feature Buffer. 

2 In the Create Buffer dialog box, click Select Features.

3 In your map, click each of the squares representing the two hospitals.
Press Enter when both are selected.

You return to the Create Buffer dialog box, which now indicates that two
features are selected.

4 In the Create Buffer dialog box, set Distance to 5 and Units to Miles. Click
OK.
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Where you are now

The map now displays two large circles, each with a five-mile radius.
The center of each circle is a hospital. Areas outside the circles are more
than 5 miles from either hospital. The street name labels help you
determine which areas are most vulnerable when a flood occurs.

To continue this tutorial, go to Lesson 5: Edit a Predefined Workflow (page
279).

Lesson 5: Edit a Predefined Workflow
A workflow automates a set of processes, much like a macro. AutoCAD Map
3D contains several predefined workflows. In this lesson, you expand a
predefined workflow to include more processes.

Lesson 5: Edit a Predefined Workflow | 279



Exercise 1: Automate grouping layers
A workflow automates a set of processes. You can specify the parameters for
the processes, or fill them in when you (or others) run the workflow.

In this lesson, you edit the predefined workflow that creates Display Manager
layers from a folder full of SDF files and saves them to .layer files. You create
a group to hold the layers, and you move the layers into the new group.

To edit the workflow

1 In AutoCAD Map 3D, create a map.

■ Click  ➤ New  ➤ Drawing.

■ Select the map2d.dwt template and click Open.

2 Click Tools tab.

3 On the Workflow panel, select the Batch Save Layers workflow from the
drop-down list.

If you do not see the workflow listed, click Open Workflow From File
and navigate to the sample workflows. By default, these files are stored
in C:\Program Files\Autodesk\AutoCAD Map 3D 2011\Sample\Workflow.
Select BatchSaveLayers.xoml.

4 Click  (Edit).

5 In the Workflow Designer, make sure the AutoCAD Map 3D toolbox is
expanded in the activity panel on the right.
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Expand the AutoCAD Map 3D activities on the right. Click Fit To Screen Size to see
all activities at once.

6 Double-click the Expose Directory Contents activity to open the input
editor.

This activity searches the specified folder for files based on the specified
filter, in this case, for all SDF files.

7 Specify a folder containing SDF files.

Select a folder that contains two or three SDF files. If you do not have a
folder of SDF files, you can use the sample SDF files that come with the
tutorials to create one.
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8 Drag the Add Group activity from the activity panel and place it just
before the LoopAddLayers activity. (Since you need only a single group,
you place it outside the LoopAddLayers activity.)

LoopAddLayers is a ForEach activity, which iterates a specified action on
a specified collection of items. This type of activity is found in the Utility
toolbox.

In this case, the ForEach activity has been renamed “LoopAddLayers” to
describe what it does. The activity examines each SDF file in the folder
designated in the Expose Directory Contents activity. For each iteration,
it connects to an SDF file and adds a feature layer to Display Manager.

The new Add Group activity creates a group to hold the new layers. Since
the LoopAddLayers activity adds layers to the group, the group must be
created before the looped activity begins.

9 Double-click the new Add Group activity to see its input editor. Set its
parameters as follows:

■ Name the new group SDFLayers.

■ Under Optional Parameters, name the activity Add SDFLayersGroup.
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Drag the Add Group activity just above the LoopAddLayers activity and change its
parameters.

10 Expand the LoopAddLayers activity by clicking its plus sign.

11 Drag the Change Feature Layer Properties activity from the activity panel
and place it inside the LoopAddLayers activity, under Create Layer.

Because you want to change the Group property for each layer you add,
place this activity inside the ForEach activity called “LoopAddLayers.”

12 Double-click the new Change Feature Layer Properties activity and set its
parameters as follows:

■ For Layer, select the output of the Create Layer activity.
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By selecting the output of a previous activity, you are “binding” the
current activity to its predecessor. The result of the previous activity
does not yet exist in the current map. Binding allows you to specify
a layer that will be created when the workflow is run.

Click the down arrow next to the Layer field and, under Results Of
Previous Actions, expand the Create Layer activity and select Layer.

■ For Group, select the output of the Add SDFLayers Group activity.
Click the down arrow next to the Group field and, under Results Of
Previous Actions, expand the Add SDFLayers Group activity and select
Group.

Drag the Change Feature Layer Properties activity inside the LoopAddLayers activity
and place it just after Create Layer. Change its parameters to specify the layers to
change and the group for the layers.

284 | Chapter 7   Tutorial: Analyzing Data



■ Under Optional Parameters, name the activity Add SDF Layers to
Group.

13 Save the edited workflow with a different name.

■ Use Save As  instead of Save so you do not overwrite the
predefined workflow.

■ Enter a location and a name for the workflow. Call the new workflow
Batch Save Layer Expanded.

■ Click Save.

To continue this tutorial, go to Exercise 2: Automate AutoCAD commands
(page 285).

Exercise 2: Automate AutoCAD commands
To complete the workflow definition, add the layers to a group and automate
an AutoCAD command. Then save and test the workflow.

NOTE This exercise uses the workflow you modified in Exercise 1: Automate
grouping layers (page 280).

To complete the workflow definition

1 If the workflow you started in Exercise 1: Automate grouping layers (page
280) is not still open, open it.

2 Drag the Run AutoCAD Command activity from the activity panel and
place it just after the LoopAddLayers activity in the workflow.

Use a command line option to save the current map as a separate DWG
file. You can run any command that you can enter on the command line.

Because this activity applies to the entire map, it does not have to loop.
Therefore, you place it outside the LoopAddLayers activity

3 Double-click the Run AutoCAD Command activity and set its parameters
as follows:

■ For Command, enter mapexportcurrentmaptodwg.

■ Under Optional Parameters, change the Display Name to Save The
Map As A DWG File.
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Add the Run AutoCAD Command activity just before the LoopSaveLayers activity.
Enter the command name.

When you run the workflow, it prompts you for a location and file name
for the DWG file. If you wanted to, you could specify those parameters
as part of the workflow.

4 Expand the LoopSaveLayers activity.

This activity saves each layer in the current map as a .layer file in the
specified folder

5 Double-click the Save Layer File activity and specify a folder for the .layer
files.
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Change the output directory for the Save Layer File activity.

6 Save the workflow.

7 Leave the Workflow Designer open.

To continue this tutorial, go to Exercise 3: Run the workflow (page 287).

Exercise 3: Run the workflow
When you run the workflow, AutoCAD Map 3D lists the SDF files in the
designated folder. Then it creates a Display Manager group to hold the layers
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that it creates. It connects to the SDF files in the designated folder. For each
drawing in the designated folder, it connects, adds a layer to Display Manager,
and moves the layers into the new group.

It saves the current map as a DWG file (converting all features to drawing
objects). Then it saves each Display Manager layer to a .layer file, which can
be shared with other AutoCAD Map 3D users or loaded into Autodesk
MapGuide.

NOTE This exercise uses the workflow you modified in Exercise 2: Automate
AutoCAD commands (page 285).

To run the workflow

1 Open the workflow from Exercise 2: Automate AutoCAD commands (page
285) in the Workflow Designer (if it is not open already).

■ In the list on the Tools tab, Workflow panel, select the workflow you
created.

■ Click  (Edit Workflow).

2 In the Workflow Designer, click  .

Green check marks appear in the upper-right corners of each workflow
step. These check marks indicate that the activity has successfully
executed.

3 Close the Workflow Designer by clicking the x in its title bar.

The layers are added to the map, as well as to the new Display Manager
group. You are prompted for a name and location for the DWG file. The
.layer files are saved to the location specified in the activity.
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Where you are now

The layers are added to the map and are stored in the group you created.
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Tutorial: Working with
Survey Data

About the Survey Data Tutorial
AutoCAD Map 3D has options for adding and organizing survey point data and
working with point cloud (LiDAR) survey data.

In this tutorial, you will do the following:

■ Enter the location of new features based on field-collected measurements.
You use coordinate geometry commands, abbreviated as COGO, to calculate
the position of the new features.

■ Import electronically stored point data.
You organize the data into point groups, export it to a geospatial format,
and then connect to that geospatial data file.

■ Create a point cloud from LiDAR data.
You create indexed point cloud data stores, and add point clouds to your
map using the Point Cloud Manager.

■ Work with point cloud data.
Create a map with only the point cloud data you need. Style the point cloud
by classification to visualize the data more effectively. Then apply a
classification filter to isolate the ground points. Apply a spatial filter to isolate
the area under development, and export the modified point cloud to LAS
format.

■ Create a surface from point cloud data.
Create a raster-based surface to visualize the area.

8
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Lesson 1: Use COGO to Enter Field Measurements
Sometimes a field worker has only a measuring tape or pocket compass
available when determining the location for a new feature. Other times, the
feature to record is behind a fence or on an unstable slope. In these situations,
you may receive swing-tie measurements that must be translated into specific
locations in existing maps.

Use the Distance/Distance and Bearing/Bearing COGO input methods to
indicate locations described by the swing-tie measurements accurately.

Exercise 1: Set up your work environment
Copy the sample data to a local drive and switch to the Tool-Based Ribbon
workspace.

To set up your work environment

1 Prepare your sample data (page 2).

NOTE If you plan to work through Lesson 3: Creating a point cloud from
LiDAR data (page 316), Lesson 4: Work with Point Cloud Data (page 322), and
Lesson 5: Create a Surface From Point Cloud Data (page 329), download some
sample LiDAR files from http://www.autodesk.com/map3d-documentation.

2 Create a folder for your saved maps (page 3).

3 Start AutoCAD Map 3D.

4 Set up the tutorial window (page 4).

5 Switch to the Tool-Based Ribbon workspace (page 4).

To continue this tutorial, go to Exercise 2: Find a location using two distances
(page 292).

Exercise 2: Find a location using two distances
A field surveyor has specified the location for a new streetlight. It is 32.4 feet
from one house and 41.1 feet from another house. In this exercise, you open
the map showing the area in question. Using the Distance/Distance COGO
tool, you find the specified location on your existing drawing.
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Because COGO commands are used with object creation commands, start the
Insert command to create a Streetlight block. When it is time to specify the
location for that block, use the COGO command to calculate the insertion
point.

NOTE This exercise uses the files you copied in Exercise 1: Set up your work
environment (page 292).

To locate the new streetlight using Distance/Distance

1 Open the sample drawing cogotools.dwg.

2 Click View tab  ➤ Views panel  ➤ Named View.

3 In the View Manager dialog box, under Model Views, select the named
view dd.

Select the dd view under Model Views and click OK.

The drawing zooms to a small set of houses. Two of them are outlined
in red. You will measure from these two red houses.
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Measure from the two red rectangles (which represent houses) on the
right side of the pink line.

4 At the Command prompt, enter insert to insert a block.

The Command
prompt appears
as soon as you
begin typing
anywhere in your
map.

5 In the Insert dialog box, do the following:

■ Make sure Name is set to StLight.

■ Under Insertion Point, select Specify On-screen.
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■ Click OK.

6 Click Home tab  ➤ Draw panel  ➤ Cogo Input.

Once you start an insert command, you can use the COGO tools to specify the insertion
points for the command.

7 In the Cogo Input dialog box, do the following:

■ Under Routines, select Distance/Distance.

■ Under Input, for Specify Point 1, click the icon to the right of the first
set of input fields.

8 In the map, click the northwest corner of the lower right house.

Click the insertion point in the
map.

The Cogo Input dialog box is redisplayed. The X and Y measurements
under Specify Point 1 represent the point you clicked.
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9 In the Cogo Input dialog box, do the following:

■ In the first Distance box, enter 41.1.
The new point will be 41.1 feet from the point you specified. However,
the insert command needs another point to determine the exact
location.

■ Under Input, for Specify Point 2, click the icon to the right of the
input fields.

10 In the map, click the southwest corner of the upper right house.

The map now displays two surveyor icons, indicating the two points you
clicked.

11 In the Cogo Input dialog box, do the following:

■ In the second Distance box, enter 32.4.

■ Click Calculate.
Two circles, with their centers at the points you specified and with
radii equal to the distances you specified, appear in the map. They
intersect at two points. You will indicate which intersection is the
correct location for the new point.

When Intersection 1 is selected, a pin icon appears at that location.
If you switch to Intersection 2, the pin moves to the other intersection.

■ Select Intersection 1 for the new point.
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■ Click Create Point.
The new streetlight is inserted at the point you selected.

Leave the drawing open for the next exercise.

To continue this tutorial, go to Exercise 3: Find a location using two bearings
(page 297).

Exercise 3: Find a location using two bearings
This time, the target location lies across a busy intersection. Therefore, the
field surveyor specified the location of the streetlight using bearing input,
rather than distances. Using the Bearing/Bearing COGO tool, you find the
specified location on your existing drawing.

NOTE This exercise uses the files you copied in Exercise 1: Set up your work
environment (page 292).

To locate the streetlight using Bearing/Bearing

1 If the sample drawing cogotools.dwg is not still open, reopen it.

2 Click View tab  ➤ Views panel  ➤ Named View.

3 In the View Manager dialog box, under Model Views, select the named
view bb.

4 At the Command prompt, enter insert to insert a block.

5 In the Insert dialog box, do the following:

■ Make sure Name is set to StLight.

■ Under Insertion Point, select Specify On-screen.

■ Click OK.

6 Click Home tab  ➤ Draw panel  ➤ Cogo Input.

7 In the Cogo Input dialog box, do the following:

■ Under Routines, select Bearing/Bearing.

■ Under Input, for Specify Point 1, click the icon to the right of the first
set of input fields.
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For Bearing/Bearing, specify two points in the map.

8 In the map, click the pale blue circle at the east corner of the pavement
at the bottom of the map.

The blue circle is at the far right of the blue rectangle (which represents a house).

9 In the Cogo Input dialog box, do the following:

■ In the first Quadrant box, select NW.

■ In the first Bearing box, enter 7.
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■ Under Input, for Specify Point 2, click the icon to the right of the
second set of input fields.

10 In the map, click the northeast corner of the pale blue house.

11 In the Cogo Input dialog box, do the following:

■ In the second Quadrant box, select NE.

■ In the second Bearing box, enter 43.
The map now displays a pin icon at the point at which the vectors
from each point intersect. In this case, there is only a single
intersection.

■ Click Calculate.

■ Click Create Point.

12 Close the drawing without saving your work.

Where you are now

You added two streetlights, using field-collected data as input. You used the
Distance/Distance and Bearing/Bearing COGO commands to specify the
location of the two new streetlights.

To continue this tutorial, go to Lesson 2: Add field-collected point data to a
map (page 300).
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Lesson 2: Add field-collected point data to a map
You may receive point data in the form of an ASCII file, Excel spreadsheet, or
LandXML file. A single such file can contain data for various point types. In
this lesson, you import an ASCII point file that contains point data for
hydrants, valves, sewer manholes, and inlets (catch basins). You add this data
to a map that shows the city of Redding, and then group the points by type.
You export the point groups to an SDF file, so they can be used as spatial data
in future maps. Finally, you connect to the data, where each set of points is
a separate feature class that can be styled separately.

Exercise 1: Create the map
Create a map showing the city boundaries and roads in Redding to provide
context for the point data you import.

To create the map

1 Click  ➤ New  ➤ Drawing to create a map.

2 Assign the coordinate system CA-I to the new map.

■ In the Task Pane, switch to the Map Explorer tab.

■ Right-click Current Drawing and click Coordinate System.

■ For Code, enter CA-I.

■ Click OK.

3 Connect to the SDF file City_Boundary.sdf.

■ In the Task Pane, click Data  ➤ Connect To Data.

■ In the Data Connect window, under Data Connections By Provider,
click Add SDF Connection.

■ For Source File, click the file icon and navigate to the sample file
City_Boundary.sdf.

■ Click Connect.

■ Click Add To Map.
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4 Connect to the SHP file Roads.shp.

■ In the Data Connect window, under Data Connections By Provider,
click Add SHP Connection.

■ For Source File, click the file icon and navigate to the sample file
Roads.shp.

■ Click Connect.

■ Click Add To Map.

■ Close the Data Connect window.

5 Style the layers to make the data easier to see.

■ In the Task Pane, switch to the Display Manager tab.

■ Select the City_Boundary layer and click Style.

■ In the Style Editor, click in the Style field and change the Foreground
Color to a light green.

■ Click OK, but leave the Style Editor open.

■ In Display Manager, select the Roads layer.

■ In the Style Editor, click in the Style field and change the Color to
black.

■ Click OK, and close the Style Editor.

6 Save the map.

To continue this tutorial, go to Exercise 2: Import the point data (page 301).

Exercise 2: Import the point data
All imported survey data must be added to a special survey data store. This
data store is saved in SDF format, but you cannot edit its schema. Create a
survey data store for the imported point data, and then import the points.

NOTE This exercise uses the map you created and modified in Exercise 1: Create
the map (page 300) and a sample data file you copied in Exercise 1: Set up your
work environment (page 292).
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To import the point data

1 In the Task Pane, switch to the Survey tab.

2 On the Survey tab, click Data  ➤ New Survey Data Store.

Create a special SDF data store to
hold the imported point data.

3 In the New Data Store dialog box, do the following:

■ Click the browse button next to File Location.

■ Specify a folder and filename for the new data store.
For example, save it to My Documents and call it SurveyPoints.sdf.

■ Set the Coordinate System to CA-I.

■ Click OK.

Specify the location, name, and coordinate
system for the new data store.
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4 In the Task Pane, click Data  ➤ Import ASCII Points.

5 In the Import ASCII Points dialog box, do the following:

■ Click the browse button next to File Location and select
redding_points.csv.
The dialog box displays the X and Y data for the points. This data
contains no elevations.

■ Under Formatting, for Select Formatting, select PENZD (Comma
Delimited).

■ Under Coordinate System Assignment, for Enter Code, enter CA-I (if
it does not already appear).

■ Click OK.

Specify the points data file and its formatting, and assign the
appropriate coordinate system.

To continue this tutorial, go to Exercise 3: Organize the points (page 304)
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Exercise 3: Organize the points
The points you imported have multiple types. Create a survey project
containing point groups for each type of point in the imported data.

NOTE This exercise uses the map you created and modified in Exercise 1: Create
the map (page 300).

To organize the points

1 In the Task Pane, on the Survey tab, right-click Survey Data Store and
click New Project.

Create a project for your point
groups.

Name the new survey project Water.

2 For each new point group, right-click the new Water project and click
New Point Group.
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Create one point group for each
type of point in the data file.

Create point groups for hydrants, valves, manholes, and inlets.

When you finish creating point
groups, the Survey tab should look
like this.
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3 Select the Ungrouped Points node on the Survey tab and click Table.

Click Ungrouped Points, then click
Table, to see the Data Table for
the imported points.

4 In the Data Table, sort the rows by Description.

(Click the Description header once to sort its contents in ascending order)

5 Select all the Inlets entries.

■ Click in the left-most column (to the left of ObjectId) for the first
Inlets entry.

■ Scroll down to the last Inlets entry.

■ Hold down the Shift key and click the left-most column for the last
Inlets entry.
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Select all Inlets entries. If Auto-Zoom is on, the drawing zooms
in to show the selected Inlets points.

6 Right-click the left-most column header (to the left of ObjectId) and click
Copy Points.
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Do not press Ctrl + C to copy the points. Only the Copy Points
command moves the point data from one point group to
another.

7 Switch the Data pulldown (at the top of the Data Table) from the
Ungrouped Points point group to the Inlets point group.
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Switch the Data pulldown to the Inlets point group you created.

8 In the empty Inlets point group, right-click the left-most column header
again and choose Paste Points.

9 Switch the Data pulldown back to Ungrouped Points.

10 Repeat steps 4-8 for the hydrants, manholes, and valves.

11 When you have finished copying the points into their point groups, close
the Data Table.

To continue this tutorial, go to Exercise 4: Convert the points to spatial data
(page 309).

Exercise 4: Convert the points to spatial data
Even though the point data itself was imported into an SDF data store, the
points in the drawing are now DWG objects. You can leave them that way,
or you can convert them to point features in a spatial data store. You can also
export points to an ASCII or LandXML file.

In this case, you create an SDF data store for the points and export them to
that format. SDF is a portable and convenient format, which you can share
with others easily. Also, since SDF files can contain multiple feature classes,

Exercise 4: Convert the points to spatial data | 309



you can export all the point groups to a single SDF file. The operation
maintains the groupings you created.

Unlike the data store you created when you imported the points, this SDF file
is a regular SDF data store, whose schema you can edit.

NOTE This exercise uses the map you created and modified in Exercise 1: Create
the map (page 300).

To convert the point data to spatial data

1 Switch to the Map Explorer tab of the Task Pane.

2 Click Schema  ➤ Create SDF.

Create an SDF file for the point
data.

3 When prompted, specify a name and location for the SDF file and click
Save.

4 When prompted, specify the CA-I coordinate system for the SDF file and
click OK.

The Schema Editor is displayed.

5 In the Schema Editor, enter a schema name, for example, Water.
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Enter a Schema Name, for example, Water.

6 Click OK to save the new SDF schema.

Confirm your changes when prompted.

You created a schema to hold the exported point data. When you create
a schema, you automatically connect to it. You are now connected to
the original survey data store and the new target data store. You can use
Bulk Copy to move the data from one source to another.

7 Switch back to the Survey tab of the Task Pane.

8 Click Data  ➤ Export Points.
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The Export Points command on the
Survey tab displays the Bulk Copy
window.

9 In the Bulk Copy window, do the following:

■ For Source, select the Hydrants point group.

■ For Target, select the new SDF data store you created.

■ Under Select Items To Copy, select SurveyPoint in the left-hand list.
The list on the Target side updates to show the fields from the Source
side.

■ In the right-hand list, click the SurveyPoint entry and replace the text
"SurveyPoint" with "Hydrants."
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Copy the data from the Hydrants point group you created to a feature class called
“Hydrants” in the new SDF file.

■ Click Copy Now.

■ Click Continue on the confirmation message.

■ Click OK on the Bulk Copy Results dialog box, which informs you
that the operation is complete.
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The Hydrant points are copied to a new Hydrants feature class in the target SDF file.

10 Leave the Bulk Copy window open, and the Target set to the same SDF
file.

11 Repeat the copy operation, replacing the Source with each of the
remaining point groups until you have copied all the data to the SDF file.
When you have finished copying all four point groups, close the Bulk
Copy window.

To continue this tutorial, go to Exercise 5: Connect to the exported point data
(page 314).

Exercise 5: Connect to the exported point data
Now that the point data has been exported to SDF format, you can connect
to it as you would any other SDF file. Each point group is stored as a separate
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feature class. When you connect to the SDF file, you can choose which of
these classes to add to your map. Each class is displayed as a separate layer in
Display Manager.

NOTE This exercise uses the map you created and modified in Exercise 1: Create
the map (page 300).

To connect to the exported point data

1 Create a map and assign the CA-I coordinate system to it.

2 Switch to the Display Manager tab of the Task Pane.

3 Click Data  ➤ Connect To Data.

4 Under Data Connections By Provider, click Add SDF Connection.

5 For Source File, click the file icon and select the SDF file you created with
Bulk Copy.

6 Click Connect.

Each of the point groups is listed as a feature class.
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NOTE There is also a default "FeatureClass1" entry, which you can ignore.

7 Select the four feature classes you created (Hydrants, Inlets, Manholes,
and Valves) and click Add To Map.

8 Switch to the Display Manager tab to see the resulting layers.

Where you are now

The four feature classes appear as layers in the Display Manager and the points
appear in the map. You can view each one separately in the Data Table and
style each one with a different symbol.

To continue this tutorial, go to Lesson 3: Creating a point cloud from LiDAR
data (page 316).

Lesson 3: Creating a point cloud from LiDAR data
In this lesson, you create indexed point cloud data stores and add point clouds
to your map using the Point Cloud Manager.

Point clouds are large data sets composed of 3D point data. Aerial LiDAR (Light
Detection And Ranging) laser scanners are the most common instruments
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used to collect geographic point cloud data. You manage point cloud data sets
using the Point Cloud Manager, and create digital elevation models (DEMs)
from point cloud data with the Create Surface Manager.

This lesson uses sample data files provided by Ambercore. The sample data
files are for non-commercial use only. You will use these files:

■ 031G05G092.las

■ 031G05G093.las

■ 031G05G094.las

■ 031G05G105.las

■ 031G05G106.las

■ 031G05G107.las

Because LiDAR files are large, the sample files are posted on the Autodesk
website, http://www.autodesk.com/map3d-documentation.

Geographic LiDAR data is most commonly available in LAS (LiDAR Aerial
Survey) or ASCII (.xyz) format. LAS is an industry standard file format defined
by the American Society of Photogrammetry and Remote Sensing that includes
a system of point classification. A processed LAS file may have points classified
as bare earth, high or low vegetation, building, and so on. Because LAS files
are produced from aerial surveys, they tend to contain long swaths or strips
of terrain data. The survey planes generally fly a long distance in one direction
collecting data, then fly back collecting data along a parallel path. This process
is often repeated many times. You may need to combine these survey swaths
and filter them by location to get the point cloud data relevant to your map.

For example, you can create a DEM for an area under development. You have
access to point cloud data collected from several aerial LiDAR scans. In this
lesson, you bring in point cloud data from LiDAR Aerial Survey (LAS) data to
view it. You combine the scans that include the area under development into
a single point cloud. You convert the data to an indexed point cloud data
store, and add it to your map. After your point cloud has been added to your
map, you use the filtered point cloud data to create a DEM of the development
site. Finally, use the features of the Display Manager to visualize the DEM
surface.
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Exercise 1: Download the sample data
The sample data files for this lesson are approximately 120 MB. For that reason,
they are stored on the autodesk.com website. Download the sample data files
for this lesson into a local folder.

To prepare the sample files

1 Download the LiDAR data from
http://www.autodesk.com/map3d-documentation.

2 Unzip the contents into a folder on your local computer.

Make sure that all the data files are in the same folder.

To continue this lesson, go to Exercise 2: Create a map (page 318).

Exercise 2: Create a map
This sample data represents an area in Northern California. Create a map with
the CA-I coordinate system.

To create the map

1 Click  ➤ New  ➤ Drawing to create a map.

2 In the Task Pane, switch to the Map Explorer tab.

3 Right-click Current Drawing and click Coordinate System.

4 For Code, enter CA-I.

5 Click OK.

To continue this tutorial, go to Exercise 3: Create indexed point cloud data
stores from LiDAR data (page 319).
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Exercise 3: Create indexed point cloud data stores from
LiDAR data

Bring LiDAR data in LAS format into your map and use it to create point cloud
data stores. A point cloud data store is an index (.isd) file that AutoCAD Map
3D refers to when it creates point cloud objects.

In this exercise, you bring in six LAS files and use them to create four point
cloud data stores. You merge three of the files into a single point cloud data
store, and group the other three into a point cloud group. Merging LAS files
into a single point cloud data store allows you to apply a spatial filter that
spans all three source files. Creating a point cloud group allows you to organize
and style your point clouds as a group. The data remains in separate point
cloud data stores.

NOTE This exercise uses the map you created and the sample data you
downloaded in Exercise 2: Create a map (page 318).

To create point cloud data stores

1 In the Task Pane, click Tools  ➤ Create Point Cloud Index. The Point
Cloud Manager appears.

2 In the Point Cloud Manager, click Add File.

3 Navigate to the local folder containing the sample data, and select these
six LAS files, then click Open:

■ 031G05G092.las

■ 031G05G093.las

■ 031G05G094.las

■ 031G05G105.las

■ 031G05G106.las

■ 031G05G107.las

4 In the Point Cloud Manager, click Create Group.

A new Merge Group appears.

5 Click and drag 031G05G105.las, 031G05G106.las, and 031G05G107.las
into the new merge group.
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6 Click the Coordinate System field for the merge group and enter CA-I to
assign the CA-I coordinate system to the point cloud data store.

7 Click the Coordinate System field for each of the remaining LAS files and
enter CA-I.

8 Select the three LAS files and the merge group, and click Generate Index.

AutoCAD Map 3D creates the point cloud data stores.

A green working symbol appears next to the file name while the file is
being processed. A green check mark appears when it is complete. When
AutoCAD Map 3D is finished generating the point cloud data stores, you
can add them to your map.

Where you are now

You brought six LAS files in to the Point Cloud Manager. You combined three
of them into a merge group, and converted them to point cloud data stores.

To continue this tutorial, leave the Point Cloud Manager open and go to
Exercise 4: Add a point cloud to your map using the Point Cloud Manager
(page 321)
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Exercise 4: Add a point cloud to your map using the Point
Cloud Manager

When you add a point cloud to your map from the Display Manager, AutoCAD
Map 3D performs two actions. First, it adds a point cloud drawing object to
your map as a standard AutoCAD drawing object. Second, it adds a point cloud
layer to the Display Manager. If you remove the Display Manager layer, the
point cloud drawing object still appears in your map.

You can select multiple files in the Point Cloud Manager and then click Add
To Map. AutoCAD Map 3D creates a point cloud group in the Display Manager.
You can add or remove files from the point cloud group using drag and drop.

NOTE This exercise uses the point cloud data stores you created in Exercise 3:
Create indexed point cloud data stores from LiDAR data (page 319).

To add a point cloud to your map from the Point Cloud Manager

1 Select all three individual LAS files in the Point Cloud Manager, then
click Add To Map.

AutoCAD Map 3D adds three point cloud drawing objects to your map,
and also adds a point cloud group to the Display Manager.

2 Select the merge group and click Add To Map.

AutoCAD Map 3D adds a single point cloud drawing object to your map,
and also adds a point cloud layer to the Display Manager.
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To continue with this tutorial, go to Lesson 4: Work with Point Cloud Data
(page 322).

Lesson 4: Work with Point Cloud Data
Once you have merged the point cloud data that includes the development
site, create a map that includes only the point cloud data you need. Style the
point cloud by classification to visualize the data better, then apply a
classification filter to isolate the ground points. Once you have the ground
points isolated, apply a spatial filter to isolate the area under development.
Finally, export the modified point cloud to LAS format to share your data with
others.

Exercise 1: Create a map
Create a map with the CA-I coordinate system.
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To create the map

1 Click  ➤ New  ➤ Drawing to create a map.

2 In the Task Pane, switch to the Map Explorer tab.

3 Right-click Current Drawing and click Coordinate System.

4 For Code, enter CA-I.

5 Click OK.

To continue with this tutorial, go to Exercise 2: Add a point cloud to your
map (page 323).

Exercise 2: Add a point cloud to your map
Add the merged point cloud data store to your map from the Display Manager.

NOTE This exercise uses the merged point cloud data store you created in Lesson
3: Creating a point cloud from LiDAR data (page 316).

To add a point cloud to your map from the Display Manager

1 In the Display Manager, click Data  ➤  Add Point Cloud Data.

The Select an ISD File dialog box appears.

2 Select the merged point cloud data store you created in lesson one.

3 Click Open.

AutoCAD Map 3D adds a point cloud drawing object to your map, and
also adds a point cloud layer to the Display Manager.

To continue this tutorial, go to Exercise 3: Style a point cloud (page 323).

Exercise 3: Style a point cloud
The point cloud data you added to your map is shown as a single layer in the
Display Manager. However, that layer contains four different kinds of points:
low vegetation, high vegetation, low point (noise), and reserved. Each one is
a point cloud classification. You can create a style that shows each point
classification differently, even though they are stored on a single layer.
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Because the point cloud data stores do not contain any points classified as 2:
Ground, you use 3: Low Vegetation as a close approximation of ground points.

Style the point cloud by classification, then change the style for low vegetation
points.

NOTE This exercise uses the point cloud data you added to your map in Exercise
2: Add a point cloud to your map (page 323).

To style a point cloud by classification

1 In the Display Manager, right-click the point cloud layer and select Style
By  ➤ Classification.

2 In the Point Cloud ribbon tab, on the View panel, drag the Point Display
slider to the right to view more points.

The Point Cloud ribbon tab is a contextual tab. It appears only when you
have selected a point cloud layer in the Display Manager.

3 To change the style for the ground points, in the Point Cloud ribbon tab,
on the Style panel, click Set Style.

The Point Cloud Style dialog box appears.

4 In the Point Cloud Style dialog box, change the color for 3: Low
Vegetation to medium brown (195, 95, 0):
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5 Click OK.

Where you are now

You have styled the data in your point cloud according to its LiDAR
classification, and changed the default color for the 3: Low Vegetation class.

To continue this tutorial, go to Exercise 4: Filter a point cloud (page 326).
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Exercise 4: Filter a point cloud
You can filter a point cloud in the Display Manager and in the Point Cloud
Manager. Filtering your data in the Display Manager allows you to view selected
points without removing any data from your point cloud data store. Filtering
points in the Point Cloud Manager creates a point cloud data store containing
only those points you select.

In this exercise, you view all the low vegetation points in the Display Manager.
Then you use the Point Cloud Manager to create a point cloud data store
containing only those low vegetation points. Finally, you apply a spatial filter
to your new point cloud data store. The spatial filter allows you to display
only those points within a specific area of your map.

NOTE This exercise uses the point cloud you styled in Exercise 3: Style a point
cloud (page 323).

To filter a point cloud

1 In the Display Manager, right-click the point cloud layer and select Filter
Point Cloud.

The Filter Point Cloud dialog box appears.

2 In the Filter Point Cloud dialog box, select Filter By: Classification, then
select 3: Low Vegetation.

3 Click Apply Filter.

Now you see only the low vegetation points in your map.

4 Create a point cloud data store that includes only the low vegetation
points. In the Point Cloud tab, on the Create panel, click Index File.

The Point Cloud Manager appears, with the point cloud data store file
as a data source:
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5 In the Output field, enter a new name for the filtered point cloud data
store, such as “Filtered Point Cloud.”

6 Click Generate Index.

7 When the new point cloud data store has been generated, click Add to
Map.

8 In the Display Manager, turn off the original point cloud layer.

9 Select the new filtered point cloud layer, then select Style By  ➤ 

Classification.

All the points have the style you specified for the low vegetation class in
Exercise 3: Style a point cloud (page 323).

10 Right-click the new filtered point cloud layer, then select Filter Point
Cloud.

The Filter Point Cloud dialog box appears.

11 In the Filter Point Cloud dialog box, select Filter By: Spatial.

12 Click Locate on Map  ➤ Circle.

13 Define a circle in the center of your point cloud that reaches the top and
bottom borders.

14 Click Apply Filter.
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Where you are now

You have created a point cloud data store containing only the low vegetation
points, and filtered the new point cloud by location on the map.

To continue with this tutorial, go to Exercise 5: Export point cloud data (page
328).

Exercise 5: Export point cloud data
You can export point cloud data to LAS or ASCII (space-delimited .xyz) formats.
You can also export point cloud data to an SDF data store. In this exercise,
you export your filtered point cloud to LAS format. Exporting to LAS format
allows you to share your modified data with others across various platforms
and systems.

NOTE This exercise uses the new filtered point cloud data store you created in
Exercise 4: Filter a point cloud (page 326).
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To export point cloud data to a LAS file

1 In the Display Manager, right-click the filtered point cloud layer and
select Export Point Cloud.

The Export Point Cloud dialog box appears.

2 In the Export Point Cloud dialog box, select File of Type: LiDAR v1.2
(*.LAS).

3 Specify a file name and location.

4 Click Save.

To continue this tutorial, go to Lesson 5: Create a Surface From Point Cloud
Data (page 329).

Lesson 5: Create a Surface From Point Cloud Data
Now that you have isolated a close approximation to the ground for the
development site, you can create a raster-based surface to visualize the area.

NOTE This lesson uses the map and data you created in Lesson 4: Work with Point
Cloud Data (page 322).

Exercise 1: Create a surface
Create a surface from your filtered point cloud layer and add it to your map
using the Create Surface Manager. When you add a surface to your map from
the Create Surface Manager, AutoCAD Map 3D performs three actions. First,
it creates a raster surface and adds it to your map. Second, it adds a raster layer
to the Display Manager. Third, it creates a raster connection to the surface file
in Data Connect.

By default, AutoCAD Map 3D creates a GeoTIFF raster surface. You can also
create an ESRI ASC surface. In this exercise, you use the default GeoTIFF file.

NOTE This exercise uses the new filtered point cloud data store you created in
Exercise 4: Filter a point cloud (page 326).

1 In the Display Manager, select the filtered point cloud layer, then click
Point Cloud tab  ➤ Create panel  ➤ Surface.

Lesson 5: Create a Surface From Point Cloud Data | 329



The Create Surface Manager appears. The filtered point cloud data store
is the source file, and the Spatial filter is applied.

2 Click Generate Surface.

3 After AutoCAD Map 3D has finished generating the surface, click Add to
Map.

AutoCAD Map 3D adds the surface to your map, a raster layer to the
Display Manager, and a raster data connection. The point cloud layer is
still in your map, though it may be obscured by the surface.

Where you are now

You have created a surface for the development area from the filtered point
cloud data you created in lesson two.

To continue with this tutorial, go to Exercise 2: Style the surface (page 331).
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Exercise 2: Style the surface
Style the raster surface using features in the Display Manager. You apply a
theme to the raster surface based on height. A theme is a type of style applied
across a range of values in your data.

NOTE This exercise uses the surface you created in Exercise 1: Create a surface
(page 329).

To style the raster surface

1 In the Display Manager, select the raster layer, then click Style.

The Style Editor appears.

2 In the Style Editor, in the Style column, click the field and select Theme.

The Theme dialog box appears.

3 In the Theme dialog box, in the Create Thematic Rules Based on a
Property section, select Height as the theme property.

4 In the Specify a Theme section, click Palette, then select the Contour
Palette.
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5 Click OK.

6 In the Style Editor, click Apply.

AutoCAD Map 3D applies the theme to the surface.

7 Switch to 3D mode on the status bar to view the surface in 3D.
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Where you are now

You have applied a theme based on height to your surface and viewed it in
3D.
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Tutorial: Managing Data
From Different Sources

About the Managing Data Tutorial
An AutoCAD Map 3D map can contain many types of information, including
DWG objects you query in from drawing files and features from multiple
geospatial data sources:

■ Oracle, SQL Server, MySQL, and ArcSDE database stores

■ SDF and SHP files

■ ODBC databases

Once you add data to your map, you can convert it from one data format to
another. For example, you can do the following:

■ Make DWG data available in a geospatial format for other organizations.

■ Move data for your organization into a geospatial environment.

■ Bring geospatial data into a drawing file.

■ Use options that are available only for drawing data or only for geospatial
data, and then return the data to its native format.
For example, you can import geospatial data to convert it to DWG format
and then use drawing cleanup commands (which are not available for
geospatial data). You can convert DWG data to geospatial format and use
the split/merge commands to assign attribute data to the split or merged
features. These commands are not available for drawing objects.

9
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■ Save a map in DWG format so AutoCAD users (without access to AutoCAD
Map 3D) can edit map data.

Select the appropriate method to move data into or out of a map:

Update OptionsMethod

If you change the objects, you can update
the original drawing or not.

Attach a drawing to your map and then
query in the objects to use.

You can maintain a live connection to the
data, or work offline and update your data
store when you finish.

Connect to geospatial (FDO) data.

When you use this option, you do not af-
fect the original data store. Changes in that
data store do not change your map.

Import data into your map, automatically
converting it to DWG format. Importing
inserts a "snapshot" of the data. You can
import from various geospatial sources.

The original data is unchanged.Export drawing objects to various formats.
No geospatial features are exported, but
you can save all the features and objects
in your map to AutoCAD DWG format and
then export it.

The original geospatial data source is un-
changed.

Use Bulk Copy to convert geospatial data
to another geospatial format.

The original DWG data is unchanged.Export your map or individual drawing
layers to the Autodesk SDF format, or to
SHP, ArcSDE, or Oracle. Then use Bulk
Copy to move it to other formats.

Converting Drawing Layers to Feature Classes

In an AutoCAD drawing, you can use layers to organize information. For
example, an AutoCAD drawing can contain separate layers for roads, parcels,
and so on. Geospatial data stores use schemas for this purpose. In a schema,
each feature class can serve the same purpose as a drawing layer.

SDF is a proprietary Autodesk format. It supports a schema that can include
multiple feature classes within a single file, the same way that a single drawing
can include multiple drawing layers. In this tutorial, you create an SDF file
with a schema whose feature classes reflect the layer structure of a drawing
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file. Each layer in the drawing file becomes a feature class in the SDF file. when
you export it.

Use the Export dialog box to map each layer to a target feature class. You can
also convert object data to geospatial attribute data. Once you set up the
mapping, you can save your settings as a profile, allowing you to use the
settings over and over again.

Using the Resulting SDF File

Once the data is stored in the SDF file, you can connect to that SDF data store.
Add the SDF features to a map as Display Manager layers.

One advantage of geospatial data stores is the ease with which you can control
attribute data (called “properties” for feature classes). In this tutorial, you add
a constrained (page 410) property to a feature class in the SDF schema.

A constrained property can have only one of a set of predefined values, or
only values within a particular range. For example, you can define a Zoning
property whose values can be only Residential, Commercial, or Public.

Moving SDF Data to a Different Geospatial Format

Once data is in a geospatial format, you can use Bulk Copy to move it to a
different geospatial format. For example, you can copy SDF data to a set of
SHP files.

Converting the Data to DWG Format

If needed, you can reimport your changes in DWG format. If you create a
template file specifying the original layers for the data, you can place each
feature class into its appropriate drawing layer. The data then uses the styling
information for the drawing layer, rather than the styling you applied to the
Display Manager layer.
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Lesson 1: Convert Drawing Layers to Feature
Classes

The Autodesk SDF format supports a schema that can include multiple feature
classes within a single file. In this tutorial, you create an SDF file with a schema
whose feature classes reflect the layer structure of a drawing file. Each layer
in the drawing file becomes a feature class in the SDF file. Each feature class
has properties that match the object data fields for the original layer.

Converting drawing layers to feature classes involves the following steps:

■ Examine the original drawing layers.

■ Examine the original object data.

■ Export the drawing layers to the new SDF file.
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Exercise 1: Examine the original drawing layers
You create an SDF file with a schema whose feature classes reflect the layer
structure of a drawing file. Examine the original drawing layers, so you can
check the resulting SDF file to see if it is structured correctly.

To examine the drawing layers

1 If you have not already done so, copy the sample files for the tutorials
to a directory on your hard drive. See Lesson 1: Get Ready to Use the
Tutorials (page 1).

2 Start AutoCAD Map 3D.

3 Click  ➤ Open  ➤ Drawing. Open the sample map called
DWGMap.dwg.
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The DWGMap.dwg drawing has multiple drawing layers.

4 In the Tool-based Ribbon Workspace, click  Home tab ➤ AutoCAD Layers
panel ➤ Layer Properties. Examine the drawing layer information.
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The layers in the drawing are listed, along with their properties.

To continue this tutorial, go to Exercise 2: Examine the object data (page 341)

Exercise 2: Examine the object data
The drawing layers in your DWG file become the feature classes in the new
schema. The object data properties in the drawing determine the properties
for each feature class. Use the Properties palette to see the object data.

NOTE This exercise uses the DWGMap.dwg map file you opened in Exercise 1:
Examine the original drawing layers (page 339).

To view the object data fields

1 In the map, zoom in close enough to see individual objects.

Use the zoom commands on the View tab.

2 Select one of the pink polylines in the map.

The Quick Properties panel displays a short list of properties.

3 Close Quick Properties, right-click the polygon, and click Properties.

4 Notice that the color for these polylines is ByLayer. Check the lower area
of the Design tab of the Properties palette to see the object data.

The pink polylines represent parcels and have object data related to
address, area, value, and so on.
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You might see different information, depending on which
polyline you selected.

5 Press Esc to deselect the polyline.

6 Pan, if necessary, to see the red lines in the upper left-hand corner of the
map.

7 With the Properties palette still open, select a red line.

The red line represents a waterline. Notice that the color for this line is
not ByLayer. Within the layer, color has been used to indicate a particular
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type of waterline. In this case it indicates size. Red waterlines have a
diameter from 26 through 48 inches.

8 Deselect the red line and pan to the lower right side of the drawing.

9 Select a green line.

The green line is also a waterline, but it is a different size. Green waterlines
are from 13 through 24 inches in diameter. Blue waterlines are from 1
through 12 inches in diameter.

10 Press Esc to ensure that no objects are selected.

The Properties palette displays “No selection” in the top field when you
deselect all objects.

11 Close the Properties palette.

To continue this tutorial, go to Exercise 3: Export the drawing layers to SDF -
Select the layers (page 343)

Exercise 3: Export the drawing layers to SDF - Select the
layers

In this exercise, you export the drawing layers from the original DWG file to
a new SDF file. The original drawing layers become geospatial features with
properties that reflect the object data and AutoCAD properties.

Use the Export dialog box to map each layer to a target feature class and
convert object data and properties to geospatial attribute data. Once you set
up the mapping, you can save your settings as a profile, allowing you to use
the settings over and over again.

You cannot maintain styling information when you export drawing objects
to SDF, but you can include object attributes. When you export the Waterline
layer, you map the Color attribute to a SIZE property.

The Export dialog box has three tabs. The following exercises describe the
steps to take on each tab.

NOTE This exercise uses the DWGMap.dwg map file you opened and modified in
Exercise 1: Examine the original drawing layers (page 339).
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To select the layers to export to SDF

1 Click Output tab ➤ Map Data Transfer panel ➤ As SDF. 

2 In the Save dialog box, specify a location and a name for the new SDF
file and click OK.

Make a note of the file name and location, so you can connect to this
file later.

3 In the Export dialog box, on the Selection tab, click Select All.

4 Leave the Export dialog box open for the next exercise.

To continue this tutorial, go to Exercise 4: Export the drawing layers to SDF -
Map object data to feature class properties (page 344).

Exercise 4: Export the drawing layers to SDF - Map object
data to feature class properties

Use the Feature Class tab to map the properties for each layer to its resulting
feature class in the SDF file. You can specify some attributes as shared
properties: all resulting feature classes have these properties. For example,
Lineweight and Linestyle would apply to every feature class. You can specify
other attributes as specific to a particular feature class. For example, Address
would apply to Parcels only.

NOTE This exercise uses the DWGMap.dwg map file you opened and modified in
Exercise 1: Examine the original drawing layers (page 339).

To specify the properties for the SDF feature classes

1 In the Export dialog box, on the Feature Class tab, click Create Multiple
Classes Based On A Drawing Object. For Drawing Object To Use, select
Layer.
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The table in the dialog box updates to show the layer names and
feature class names to use.

2 Deselect layer 0.

3 Click Select Attributes.

Attributes you specify here are assigned to every feature class in the SDF
file. So select only attributes that are appropriate for all. For example, you
can select general properties, which include things like Lineweight, but
not object data properties, which are specific to each feature class.

4 In the Select Attributes dialog box, expand the Object Properties item
and the AcDbEntity and General items.

5 Select the boxes for Lineweight and Linetype and click OK.
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Expand the parent items to select a subset of
properties.

6 In the Export dialog box, under Feature Class in the grid area, click the
cell for the first layer, Parcels.

A  button appears at the right side of the grid cell.

7 Click  for the Parcels Feature Class cell.

8 In the Feature Class Property Mapping - Parcels dialog box, click Select
Attributes.

9 Expand the Object Data item and select Parcels.

The resulting Parcels feature class has the object data fields for the Parcels
layer, but not for any other layer.

10 Click OK twice to return to the Feature Class tab.

11 Click in the Geometry cell for Parcels and change the entry to Polygon.

12 Repeat steps 6 through 11 for the remaining two feature classes, using
the following table as a guideline.

GeometryFeature ClassDrawing Property

LineRoadsRoads

LineWaterlinesWaterlines
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13 Leave the Export dialog box open for the next exercise.

To continue this tutorial, go to Exercise 5: Export the drawing layers to SDF -
Map drawing properties to feature class properties (page 347).

Exercise 5: Export the drawing layers to SDF - Map
drawing properties to feature class properties

The Feature Class tab lets you map AutoCAD drawing properties to properties
in the SDF feature classes as well. If you have used color, lineweight, or line
type to represent object characteristics within a layer, you can map these
properties to the characteristics they represent. In this drawing, you map color
to a waterline size. You can map each waterline color to a separate feature
property.

NOTE This exercise uses the DWGMap.dwg map file you opened and modified in
Exercise 1: Examine the original drawing layers (page 339).

To map drawing properties to feature class properties

1 On the Feature Class tab of the Export dialog box, click in the Feature
Class cell for Waterlines.

2 Click the  button that appears in the cell.

3 In the Feature Class Property Mapping - Waterlines dialog box, click Select
Attributes.

4 Expand the Properties item at the top of the list.

5 Select COLOR and click OK.

6 In the Feature Class Property Mapping - Waterlines dialog box, in the
Feature Class Properties cell for COLOR, enter Size.

In the exported SDF file, waterline objects with a COLOR property have
a Size property instead.

7 Click the .COLOR cell to see the  button.

8 Click the .COLOR  button.

9 In the New Property Data Type dialog box, change the Data Type to String
and click OK.
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The new Size property has a value that consists of a text string.

10 In the Property Value Mapping dialog box, select the box for each color
(on the left side of the dialog box).

Specify what each color means. The text string you type is the value for
the Size property of each waterline. Red lines become Large waterlines in
the SDF file.

11 Classify the waterline sizes as Small, Medium, and Large. Use this table
as a guideline:

SizeColor

LargeRed

MediumGreen

SmallBlue

348 | Chapter 9   Tutorial: Managing Data From Different Sources



Map the .COLOR property values to the feature class properties.

12 Click OK twice to return to the Export dialog box.

13 Leave the Export dialog box open for the next exercise.
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To continue this tutorial, go to Exercise 6: Export the drawing layers to SDF -
Set export options (page 350).

Exercise 6: Export the drawing layers to SDF - Set export
options

As the final step in the export operation, set the export options. Save your
settings as a profile so you can quickly execute this export operation again
later.

NOTE This exercise uses the DWGMap.dwg map file you opened and modified in
Exercise 1: Examine the original drawing layers (page 339).

To specify options for the export operation

1 In the Export dialog box, on the Options tab, select Treat Closed Polylines
As Polygons.

Selecting this option insures that polygon objects drawn as closed
polylines are still treated as polygons in the exported file.

2 Under Saved Profiles, click Save.

3 Specify a location and name for these export settings and click Save.

4 In the Export dialog box, click OK to export the data.

The Export Progress dialog box displays the status of the export operation.

5 Close the map file.

Where you are now

You exported DWG layers to Autodesk SDF format, creating feature classes
that reflect the layers and object data in your original drawing file.

To continue this tutorial, go to Lesson 2: Use the Resulting SDF Files (page
350).

Lesson 2: Use the Resulting SDF Files
Connect to the SDF file you created and edit the objects in the map as
geospatial features.
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Geospatial features have options in AutoCAD Map 3D that drawing objects
do not have. For example, you can add properties to the feature classes in your
SDF file. In this lesson, you add a constrained (page 410) property. Constrained
properties can have only the values you specify: values within a particular
range or within a list you specify.

NOTE If you import the SDF file instead of connecting to it, the data comes back
in as drawing objects instead of geospatial data. Connecting to the data leaves it
in its current format.

This lesson involves the following steps:

■ Create a map.

■ Connect to the new SDF data.

■ Add a property.

Exercise 1: Create a map
Create a map file.

To create a map file

1 Create a map using the map2d.dwt template.

2 Assign a coordinate system to the new map.

■ Switch the Task pane to Map Explorer.

■ Right-click the Current Drawing entry and click Coordinate System.

■ Specify the CA-I coordinate system.
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Set the coordinate system for a new map from Map
Explorer.

3 Save your file.

To continue this tutorial, go to Exercise 2: Connect to the new SDF data (page
352).

Exercise 2: Connect to the new SDF data
Connect to the SDF file you created.

NOTE This exercise uses the map you created in the previous exercise, and the
SDF file you saved in Lesson 1: Convert Drawing Layers to Feature Classes (page
338).

To connect to the new SDF file

1 In Display Manager, click Data  ➤ Connect To Data.
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Switch to Display Manager to connect to
data.

2 In the Data Connect window, under Data Connections By Provider, click
Add SDF Connection.

3 Click  next to Source File under Add A New Connection.

4 Open the SDF file you created in Lesson 1: Convert Drawing Layers to
Feature Classes (page 338).
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Connect to the SDF file you created.

5 Click Connect.

6 Select all the feature classes.
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Each layer from your original map is listed as a separate
feature class.

7 Click Add To Map.

8 Close the Data Connect window.

To continue this tutorial, go to Exercise 3: Edit the schema (page 355).

Exercise 3: Edit the schema
In this lesson, you examine the feature classes you created. You view the
attribute data in the Data Table. Then, you add a feature class property using
the Schema Editor.

NOTE This exercise uses the map you modified in Exercise 2: Connect to the new
SDF data (page 352).
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To examine the attribute data

1 In the Task pane, switch to the Display Manager tab, select the Waterlines
layer and click Table.

NOTE In this example, the Data Table was undocked by dragging it away
from the edge of the window.

The general properties and the object data specific to Waterlines appear in the Data
Table.

2 In the Data Table, examine the properties for the Waterlines layer.

The .COLOR properties have been translated to a new Size property.

3 Close the Data Table.

To continue this tutorial, go to Exercise 4: Add a property (page 356).

Exercise 4: Add a property
A set of feature classes and their properties is called a schema. The schema
can have properties that are constrained (page 410). The constraints determine
which objects you can add to a particular feature class. For example, to be
added to the Roads feature class, an object must be a line. Properties are like
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attributes—they are characteristics of all objects in the feature class. For
example, a Roads feature class property can specify the number of lanes it has,
or its speed limit. The values vary, but all Roads features have a speed limit
and a certain number of lanes.

You cannot change the schemas for all data source types, but you can edit the
schemas for SDF files. In this lesson, you edit an SDF schema to add a property
to the Roads feature class. The new property is constrained, so only certain
values are valid for it.

NOTE This exercise uses the map you modified in Exercise 2: Connect to the new
SDF data (page 352).

Properties that are constrained to ranges of values

You can specify that only values within a particular range are valid. You can
include or exclude each extreme of the range: the lowest possible value and
the highest. For example, you can make a range 1 - 100 inclusive. You can
specify a range of any value higher than 1 and lower than 100, but not 1 or
100. You can specify any combination.

To add a property to the Roads feature class that is constrained by range

1 Switch the Task pane to Map Explorer.

2 Select the SDF data source at the top of the pane.

3 Click Schema  ➤ Edit Schema.

Edit the SDF schema.
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4 In the Schema Editor, expand the schema tree on the left to see the three
feature classes.

5 Select the Roads feature class.

6 Click New Property at the top of the window.

Property1 appears on the left, under the existing properties.

7 Specify the characteristics of the new property using the information
shown in this illustration:

Create a property with these values. The last four fields appear
after setting the Constraint Type.

These values create a property that represents the number of lanes for a
road. The value must be a whole number from 1 through 5, inclusive.
There is no default value for this property.

By setting Min Value Included and Max Value Included to true, the
highest and lowest values in the range are acceptable entries.

8 Click Apply and confirm your changes.
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The "Property1" entry on the left is updated to show the new name.

9 Click OK and confirm your changes to close the Schema Editor.

To continue this tutorial, go to Exercise 5: Populate the new property with
values (page 359).

Exercise 5: Populate the new property with values
After you add a property to a feature class, you enter the values for that
property for each feature in the feature class.

NOTE This exercise uses the map you modified in Exercise 2: Connect to the new
SDF data (page 352).

To populate the new properties with data

1 Expand the SDF entry in Map Explorer until you see its three feature
classes. Select Roads and click Table.

2 In the Data Table, scroll all the way to the right to see the new property.

3 Enter the number of lanes for a few roads.

If you enter a value that is outside the allowable range and click outside the field, a
warning is displayed.
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4 Close the Data Table.

Where you are now

You connected to the SDF file you created earlier and added a new property
to its schema. You entered values for the new property in the Data Table.

To continue this tutorial, go to Lesson 3: Move SDF Data to a Different
Geospatial Format (page 360).

Lesson 3: Move SDF Data to a Different Geospatial
Format

Use Bulk Copy to move the Roads data in your map from the SDF format it
currently uses to ESRI SHP format.

While SDF files can contain multiple feature classes, each SHP file can contain
only a single feature class. The Bulk Copy operation creates a set of new SHP
files in a folder that you create.

NOTE You can use Bulk Copy to move data between geospatial formats, but you
cannot use it to move data to or from DWG format.

NOTE This exercise uses the map you created with the map2d.dwt template and
modified in Lesson 2: Use the Resulting SDF Files (page 350).

Exercise 1: Connect to a new SHP file folder
Create a new, empty folder to contain the SHP files. To convert and copy data
to the SHP format, you must be connected to this folder. You use Data Connect
to establish connections to data stores, even when you do not add anything
to the map from the data store.

NOTE This exercise uses the map you created with the map2d.dwt template and
modified in Lesson 2: Use the Resulting SDF Files (page 350).

To create and connect to the folder

1 Use Windows Explorer to navigate to the location where you copied your
sample tutorial files.

2 Create a folder for the SHP files.
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3 In AutoCAD Map 3D, switch the Task pane to Display Manager.

4 Click Data  ➤ Connect To Data.

5 On the left side of the Data Connect dialog box, click Add SHP
Connection.

6 On the right side of the Data Connect dialog box, click the folder icon
(not the file icon). Select the folder you created and click OK.

Click the folder icon next to Source File Or Folder.

Click Connect and close the Data Connect window without adding
anything to your map.

To continue this tutorial, go to Exercise 2: Use Bulk Copy to move an SDF
layer to SHP format (page 361).

Exercise 2: Use Bulk Copy to move an SDF layer to SHP
format

Copy the Roads layer from SDF format to SHP format using the Bulk Copy
feature.

NOTE This exercise uses the map you created with the map2d.dwt template and
modified in Exercise 1: Connect to a new SHP file folder (page 360).
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To copy the Roads layer to SHP format

1 In the Task pane, switch to Map Explorer. Select the SDF_1 schema.

2 Click Tools  ➤ Bulk Copy.

Use Bulk Copy to convert data from
one geospatial format to another.

3 On the left side of the Bulk Copy dialog box, for Source, select the SDF_1
connection.

4 In the list that displays on the left side of the window, select the box for
Schema1.

5 On the right side of the Bulk Copy window, for Target, select the SHP_1
connection.

6 Under Ignore The Following Errors During The Copy Process, select all
the items.

7 Click Copy Now.

NOTE If you see messages indicating that some property names are too long,
shorten them and click Copy Now again.
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Copy the data from SDF format to SHP format.

8 On the Continue Bulk Copy message, click Continue Bulk Copy.

The data from the SDF file is copied to the new SHP file.

9 Click OK on the Bulk Copy Results message and close the Bulk Copy
dialog box.

10 Close the drawing.

11 Open the folder you created for the SHP files. It contains a set of files for
each feature you copied.

Where you are now

You copied the data from your SDF layers to SHP format.

To continue this tutorial, go to Lesson 4: Import SDF Files as DWG Layers
(page 364).
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Lesson 4: Import SDF Files as DWG Layers
You moved some DWG data to SDF format and from there to SHP format, so
you can distribute it to people who use geospatial data.

You can move the data back into DWG format as needed. For example, if
other people change the data, you can reimport it so you have the latest
version. When you import SHP or SDF files, data is added to your map as
drawing objects, not as geospatial data.

Exercise 1: Create a template for the imported material
When you import the SDF file into a map, you convert the data to DWG objects.
(If you connected to the SDF file, the objects would remain in SDF data format.)

To maintain the formatting of the original DWG objects that you exported
to SDF, create a template that duplicates that formatting.

Use the original drawing file as the basis for the template. That way, the
template automatically specifies the layers for the SDF feature classes.

NOTE This exercise uses the DWGMap.dwg map file you opened in Lesson 1:
Convert Drawing Layers to Feature Classes (page 338).

To create a template for the imported material

1 Open the original DWG file you exported to SDF.

■ Click  ➤ Open  ➤ Drawing.

■ Select the sample map called DWGMap.dwg

2 Save the drawing as a template (.dwt) file. Click  ➤ Save As  ➤ 

AutoCAD Drawing Template.

Name the file DWGImportTemplate.dwt.

When prompted, enter a description of the template and leave the other
settings set to their default values.

3 In the new template file, delete all the drawing objects so that the drawing
is empty.

Press Ctrl+A or use Zoom Window to select all the objects. Then press
the Delete key.
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4 Save and close the template drawing file.

5 Create a map using the DWGImportTemplate.dwt template.

■ Click  ➤ New  ➤ Drawing.

■ Select the DWGImportTemplate.dwt template.

■ Click Open.

You do not have to assign a coordinate system to this new map, because
the template specifies that information.

To continue this tutorial, go to Exercise 2: Import the SDF layers (page 365)

Exercise 2: Import the SDF layers
When you connected to the SDF file you created earlier in this tutorial, you
brought in its data as geospatial features. Each feature class was a separate
Display Manager layer. However, in this lesson you import the SDF data as
drawing objects, and each feature class becomes a separate drawing layer.

NOTE This exercise uses the map you created with the DWGImportTemplate.dwt
template and the SDF file you created in Lesson 1: Convert Drawing Layers to
Feature Classes (page 338).

To import SDF layers

1 In the Tool-based Ribbon Workspace, click Home tab ➤ Data panel ➤ Map
Import .

2 Change the Files Of Type to Autodesk SDF (*SDF).

3 Navigate to the SDF file you created, select it, and click OK.

4 In the Import dialog box, check Import Polygons As Closed Polylines.

5 Check that each Input Layer maps to the appropriate Drawing Layer.
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Be sure to select the correct drawing layer.

The drawing template has the original drawing layers defined. Since these
layers were the source for the feature classes you are importing, they are
mapped appropriately.

6 Map the Size property to object data.

■ Click in the Data cell for Waterlines.

■ Click the  button that appears.

■ In the Attribute Data dialog box, click Create Object Data.

■ For Object Data Table To Use, select Waterlines (not
(Schema1_Waterlines).

■ Click Select Fields.

■ In the Object Data Mapping dialog box, select Size and, under Target
Fields, enter Size in the corresponding cell.

■ Click OK to exit the three dialog boxes.
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If you are asked to confirm your actions, click Yes.

7 Click Map Setup tab ➤ Map panel ➤ Zoom Drawing Extents. 

You can now work with the objects as you would any DWG data.

To continue this tutorial, go to Exercise 3: Use display layers to assign object
properties (page 367)

Exercise 3: Use display layers to assign object properties
You can create display layers for each drawing layer in your new drawing. In
addition, you can create separate display layers for each waterline size. By
displaying a single display layer at a time, you can select the various sets of
objects and assign the proper colors to them.

NOTE This exercise uses the map you created with the DWGImportTemplate.dwt
template and the SDF file you modified in Exercise 2: Import the SDF layers (page
365).

To use display layers to assign object properties

1 Create a display layer for the Parcels layer.

■ In the Task pane, switch to Display Manager. Click Data  ➤ Add
Drawing Data  ➤ Query Current Drawing.

■ In the Define Query Of Current Drawing dialog box, click Property.

■ In the Property Condition dialog box, select Layer and set the Value
equal to Parcels.

■ Click OK to close each dialog box.

■ In Display Manager, select the default display layer name (Current
Drawing Element) and change it to Parcels.

2 Repeat the procedures in step 1 to create a display layer for Roads.

Select the new display layer name (Current Drawing Element) and name
it Roads.

3 Repeat the procedures in step 1 to create a display layer for Waterlines.
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Select the new display layer name (Current Drawing Element) and name
it Waterlines.

4 Create a display layer for waterlines whose Size property is set to Large.

■ In Display Manager, click Data  ➤ Add Drawing Data  ➤ Query
Current Drawing.

■ In the Define Query Of Current Drawing dialog box, click Data.

■ In the Data Condition dialog box, select Object Data.

■ For Tables, select Waterlines.

■ Select Size.

■ For Value, enter Large.

■ Click OK to close each dialog box.

■ In Display Manager, select the new display layer name (Current
Drawing Element) and change it to Large Waterlines.

5 Repeat step 4 for the remaining sizes (Medium and Small).

6 Change the color of the Large Waterlines objects.

■ Turn off all the display layers except for Large Waterlines.
To turn off a display layer, clear its check box.

■ Click View tab ➤ Navigate panel ➤ Zoom drop-down ➤ Extents. 

■ Drag a selection box around all the objects that are displayed.

■ In the Quick Properties window, change the Color from ByLayer to
Red.

■ Press Esc to deselect the objects.

7 Repeat step 6 for the Medium and Small layers. Make Medium objects
green and Small objects blue.

8 Turn on all the display elements to see the results.

AutoCAD users cannot see the display layers (because AutoCAD does not
have Display Manager). However, the layer and object properties are
stored with the AutoCAD layers and objects, so the colors are visible.
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Where you are now

You imported an SDF file as drawing objects, styling the imported drawing
objects as they appeared in the original drawing.
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Tutorial: Working with
Polygon Features

About the Polygon Features Tutorial
AutoCAD Map 3D has options that are designed for geospatial features with
polygon geometry. For example, you can do any of the following:

■ Use a special expression to find the area of a polygon feature.

■ Split a single polygon feature into two or more new features.

■ Merge two or more polygons into a single feature.

■ Create rules for assigning properties to polygon features after you split or
merge them.

In this tutorial, you connect to geospatial data for parcel polygons. You split a
parcel into two uneven new parcels and assign attributes to each resulting parcel
using split/merge rules.

You join a data source to the parcels to add assessor data. You export the parcel
layer to create a data store that contains the joined data as part of its native
schema.

Connecting to the new data store, you create a property called “ValueByArea.”
ValueByArea is a calculated property that represents the last sales price of each
parcel divided by the area logged in the joined data store. You create a theme
based on an expression that references the calculated property.

Finally, you publish your map to MapGuide, so others can view it on a website.
You must have rights to a MapGuide 2009 Server, which supports the new
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templates used in this exercise. To do this exercise, you must have credentials
and write rights.

Lesson 1: Connect to Parcel Data
In this lesson, you connect to parcel data from the city of Redding, California.

Exercise 1: Create a map
Create a map file.

To create a map file

1 Click  ➤ New  ➤ Drawing. Select the map2d.dwt template.

2 Assign a coordinate system to the new map.

■ Switch the Task Pane to Map Explorer.

■ Right-click the Current Drawing entry and click Coordinate System.

■ Specify the CA-I coordinate system.

Set the coordinate system for a new map
from Map Explorer.

To continue this tutorial, go to Exercise 2: Bring in the parcel data (page 373).
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Exercise 2: Bring in the parcel data
Now, add a layer that displays parcels within the city of Redding. This layer
contains size, value, and address information about the parcels.

NOTE This exercise uses the map you created in Lesson 1: Connect to Parcel Data
(page 372).

To add the parcel layer to the map

1 In Display Manager, click Data  ➤ Connect To Data.

2 In the Data Connect window, under Data Connections By Provider, click
Add SDF Connection.

3 Click the file icon next to the Source File field and navigate to the folder
containing the sample files.

4 Select Assessor_Parcels.SDF and click Open.

5 In the Data Connect window, click Connect.

6 In the Data Connect window, click Add To Map.

7 Close the Data Connect window.

8 To see the data associated with this layer, select the Parcels layer in Display
Manager and click Table.

Scroll to the right to see all the columns of parcel data.

9 Leave the Data Table open for the next exercise.

Where you are now

You connected to a data store containing parcel information. You viewed the
geometry in your map and the attribute data in the Data Table.

To continue this tutorial, go to Lesson 2: Split a Polygon Feature (page 374).
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Lesson 2: Split a Polygon Feature
You can define rules that determine how properties are assigned after you
split a single feature into multiple pieces or merge multiple features into one.
In this lesson, you define split/merge rules for the Parcels feature. Then, you
split a parcel into two uneven pieces and use the rules you defined to assign
properties to each resulting parcel.

Exercise 1: Define split/merge rules
You can use the AutoCAD Trim and Break commands to split polygons.
However, the Split command has many advantages over those methods. A
split always results in a valid feature, and has special logic to deal with
attributes automatically.

With Split, you can set rules for the assignment of properties when you split
and merge geospatial features. You can use expressions for these rules.

For example, if you are splitting a parcel, you can base the land value of the
resulting parcels on a calculation that you define. You can also use automatic
calculations. For example, you can assign the average value of all merged
features to the resulting feature. You can divide the value of a feature evenly
among all its split features.

NOTE This exercise uses the map you created and modified in Exercise 1: Define
split/merge rules (page 374).

To create split/merge rules

1 The Data Table should still be open from the last exercise. If it is not, in
the Task Pane, switch to Display Manager. Select the Parcels layer and
click Table.

2 In the Data Table, click Options (at the bottom of the window) and select
Set Split And Merge Rules.
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Set rules for assigning properties after a split or merge operation.

Each property of the Parcels feature is listed under Feature Properties on
the left. Two properties (Geom and FeatID) are generated by the data
store, so you cannot set rules for them. If you select them, you can see
the rules that the data store uses to create them.

3 In the Split And Merge Rules dialog box, click the ADDRESS property.

4 For the Split Rule, specify Empty.

If you split this parcel, you must specify the address number for each
new parcel that is created.

5 For the Merge Rule, specify First Selected.

If you merge multiple parcels into one, the new parcel uses the address
number of the first parcel you select for the merge.

6 Specify rules for other properties, using the following table as a guide.

Merge ruleSplit ruleProperty

SumProportional Based On Area2D (Geom)ACRES

First SelectedCopyAPN

SumProportional Based On Area2D (Geom)AREA
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Merge ruleSplit ruleProperty

SumProportional Based On Area2D (Geom)IMP_VALUE

SumProportional Based On Area2D (Geom)LAND_VALUE

SumProportional Based On Area2D (Geom)NET_VALUE

First SelectedEmptyPRIMARY_INDEX

First SelectedCopySTNAME

For a complete description of the split/merge rule options, see Using
Expressions In Split/Merge Rules.

7 Click OK.

To continue this tutorial, go to Exercise 2: Find the parcel to split (page 376).

Exercise 2: Find the parcel to split
You can use the Data Table to find a particular parcel and zoom into it so you
can split it.

NOTE This exercise uses the map you created and modified in Exercise 1: Define
split/merge rules (page 374).

To find the parcel to split

1 If the Data Table is not open, click the Parcels layer in Display Manager
and click Table.

2 In the Data Table window, make sure Auto-Zoom is on.

When Auto-Zoom is on, it is a different color than the window

background  . When it is off, it is the same color as the window
background.

3 Click Search To Select (at the bottom of the window).

4 In the Search To Select window, click Property and select STNAME.

5 Click = (the equals sign in the toolstrip).
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6 Place your cursor over the text that says “value.”

7 In the tooltip that displays, click Get Values From A List.

8 Click the green arrow next to STNAME in the properties list to see the
street names for the Parcels feature.

The properties list is populated when you click the green arrow. Your selection replaces
the selected value.

9 Click Antigua Drive and click Insert Value.

Click Next if you do not see Antigua in the list.

10 Click Validate (at the bottom of the window) to make sure that the
expression is valid.

11 When you see “The expression is valid,” click OK.

12 Click the heading for the STNAME column to sort the parcel records by
street name.

In the Data Table, the entries for parcels on Antigua Drive are highlighted.
The map is zoomed to that street, and the parcels are selected in the map
as well.

To continue this tutorial, go to Exercise 3: Split the parcel (page 378).
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Exercise 3: Split the parcel
You interactively divide a parcel into two unequal closed polylines.

NOTE This exercise uses the map you created and modified in Exercise 2: Find
the parcel to split (page 376).

To divide one parcel into two new parcels

1 In the Data Table, click the leftmost column for one parcel on Antigua
Drive.

Make a note of the address, so you can compare your results later.

When you click the leftmost column, you select that entry in the Data
Table and automatically zoom to that parcel in your map.

2 Hide the Data Table so you can see the parcel more easily. On the Data

Table title bar, click  (Auto-Hide) .

3 Click Feature Edit tab ➤ Split/Merge panel ➤ Split Feature. 

4 When notified that the feature has been checked out, click Close.

5 At the first prompt, “Create new or multipart,” click New.

New splits this parcel in two pieces. You can create more pieces by
selecting Multipart.

NOTE You can specify the default values for two of these prompts in the
Feature Editing Options dialog box. You can turn off the prompts and always
use the default values. In that case, you see only the third prompt and not
the first two.

6 At the second prompt, “Generate new feature ID or use existing,” click
New.

This option auto-generates a unique identifier for the new parcel.

7 At the third prompt, “Would you like to draw or select the line for the
split,” click Draw.

8 Draw the line for the parcel split and press Enter.
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When you specify the last point and press Enter, the parcel is split.

To continue this tutorial, go to Exercise 4: Examine the results (page 379).

Exercise 4: Examine the results
In this exercise, you examine the results of your split in the Data Table. The
properties of the two resulting parcels are calculated automatically, using the
rules you specified.

The theme for the Parcels layer updates to show the new parcels appropriately,
reflecting the new values. The labels on the two new parcels update as well.

NOTE This exercise uses the map you created and modified in Exercise 3: Split
the parcel (page 378).
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To examine the results of the split

1 In the Data Table, examine the attribute values for the new parcels.

The Data Table now contains two new entries for the split parcels. The
address is null because you specified “Empty” as the split value for this
property.

2 Right-click each new parcel and click Check In Feature.

Where you are now

You set up rules for splitting parcels and allocating property values to the
resulting parcels. You used the Split command to divide one parcel into two
uneven pieces. You examined the results in the Data Table.

To continue this tutorial, go to Lesson 3: Use Joined Data to Create Calculated
Properties (page 380).

Lesson 3: Use Joined Data to Create Calculated
Properties

The parcel data does not contain information about the owners. Join the
Parcels layer to a Microsoft Access database that contains owner information.

To connect to an Access database from AutoCAD Map 3D, set up an ODBC
connection for that database using a control panel in Windows. Then, connect
to this source using Data Connect, just as you connected to the physical data
sources in your map. The database source contains a field that you can match
to a property in the Parcels layer, so you can join the data to the parcels. Using
the combined data, you create a calculated property that is stored in the map
but is not saved back to the original data stores. This property is not available
in either original data source alone. It requires a join and a calculation to
create it.

Exercise 1: Set up an ODBC connection for a Microsoft
Access database

Set up an ODBC connection for the Microsoft Access database using the
Administrative Tools control panel in Windows.
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NOTE If you created an ODBC connection in the tutorial, “Analyzing Data Using
Styles, Joins, and Buffers,” (page 243) you do not need to do so again. You can
skip to the next exercise.

To set up an ODBC connection for the Access database

1 From your Windows desktop, click Start  ➤  Settings  ➤  Control Panel
and open the Administrative Tools control panel.

2 In the Administrative Tools window, double-click Data Sources (ODBC).

3 In the ODBC Data Source Administrator dialog box, click Add.

4 In the Create New Data Source dialog box, click Microsoft Access Driver
(*.mdb) and click Finish.

5 In the ODBC Microsoft Access Setup dialog box, for Data Source Name,
enter Parcel_Owners.

6 Enter a description, for example, “Parcel owner information.”

7 Under Database, click Select.

8 In the Select Database dialog box, navigate to the sample files and select
the Assessor.mdb file.

Specify the database for this data source.

9 Click OK in the Select Database, ODBC Microsoft Access Setup, and ODBC
Data Source Administrator dialog boxes.

10 Close the Administrative Tools control panel.
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To continue this tutorial, go to Exercise 2: Connect to the Microsoft Access
database (page 382).

Exercise 2: Connect to the Microsoft Access database
Specify the new connection in the Data Connect window. Do not add any
specific feature class layers from the ODBC source to the map. All the
information becomes available to AutoCAD Map 3D automatically when you
connect to the ODBC source.

NOTE This exercise uses the ODBC source you created in Exercise 1: Set up an
ODBC connection for a Microsoft Access database (page 380) and the map you
created in Lesson 1: Connect to Parcel Data (page 372).

To connect to the Access database from AutoCAD Map 3D

1 In Display Manager in AutoCAD Map 3D, click Data  ➤ Connect To
Data.

2 Under Data Connections By Provider, click Add ODBC Connection.

3 Click  next to the Source field under Add A New Connection.

4 Select Parcel_Owners from the list of Data Source Names and click Select.

Connect to the ODBC data source you created, but do not click Add To Map.
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5 Click Connect.

6 When you see the User Name & Password dialog box, click Login without
entering anything in the fields. (This database has not been set up for
user name and password protection.)

Do not click Add To Map. The ODBC source does not contain spatial
data, so there is nothing to add to the map. AutoCAD Map 3D has access
to all non-spatial data automatically when you connect to its source.

7 Close the Data Connect window.

To continue this tutorial, go to Exercise 3: Join the ODBC data to the Parcels
layer (page 383).

Exercise 3: Join the ODBC data to the Parcels layer
After you connect to an external data source, you can join it to a layer in your
map using the Data Table. (To join two data sources, they must share a
common property). You can see the results of the join immediately.

NOTE This exercise uses the map you modified in Exercise 2: Connect to the
Microsoft Access database (page 382).

To join the ODBC parcel data to the geospatial parcel layer

1 In Display Manager, select the Parcels layer and click Table.

2 At the bottom of the Data Table, click Options  ➤ Create A Join.

3 In the Create A Join dialog box, the Primary Table Initiating The Join
entry reads SDF_1:Schema1:Parcels. For Table (Or Feature Class) To Join
To, select the ODBC_1:Fdo:Assessor layer.

4 For This Column From The Left Table, select APN.

5 For Matches This Column From The Right Table, select APN (if it is not
selected automatically).

Leave the other settings with their current values.

6 Click OK to display the original and joined data in the Data Table.

7 Scroll to the right to see the owner information.
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NOTE The joined data values for the new parcel you created with the Split
command are not accurate. The database that contains the joined data does
not know about the change to the parcel, so it cannot provide the proper
new data for it. Update the original data store independently to enter the
data for the split parcels.

To continue this tutorial, go to Exercise 4: Save the properties to a new data
store (page 384).

Exercise 4: Save the properties to a new data store
The Parcels layer now displays joined data. However, the joined data in the
Data Table is gray. The gray text reflects the fact that the joined data is not
part of the original data store. You cannot edit it or use it in a calculated
property.

You can save the layer out to a new data store, which will make the joined
properties available as native properties in the future.

NOTE This exercise saves the layer as an SDF data store. You can use Bulk Copy
to save joined and calculated properties to other geospatial data formats. For more
information, see Migrating GIS Data (Bulk Copy)

NOTE This exercise uses the map you modified in Exercise 3: Join the ODBC data
to the Parcels layer (page 383).

To save the original and joined properties to a new data store

1 In Display Manager, right-click the Parcels layer and click Export Layer
Data To SDF.
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Save the layer to a new SDF file to make the joined
attributes available for editing.

2 Specify a location and name for the SDF file and click Save.

3 Create a map.

■ Click  ➤ New  ➤ Drawing.

■ Select the map2d.dwt template.

4 Assign a coordinate system to the new map.

■ Switch the Task Pane to Map Explorer.

■ Right-click the Current Drawing entry and click Coordinate System.

■ Specify the CA-I coordinate system.

5 Connect to the new SDF file.

■ In Display Manager, click Data  ➤ Connect To Data.
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■ In the Data Connect window, under Data Connections By Provider,
click Add SDF Connection.

■ Click the file icon next to the Source File field and navigate to the
new SDF file.

■ Select the new SDF file and click Open.

■ Click Connect.

■ Click Add To Map.

6 Right-click the Parcels layer from the new SDF file and click Table.

7 In the Data Table, scroll to the right.

The joined properties are no longer gray. They are native properties of the new SDF
file.

8 Leave the Data Table open for the next exercise.

To continue this tutorial, go to Exercise 5: Create a calculated property (page
386).

Exercise 5: Create a calculated property
Now you have joined owner data to the Parcels layer and saved the result to
a new data store. You can use the combined information to create a calculated
property. The calculated property is the result of an expression: in this case,
the last sales price divided by the area.

NOTE To create or manage calculations, you must be connected to the data store
that contains the data for the calculation.
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NOTE This exercise uses the map you modified in Exercise 4: Save the properties
to a new data store (page 384).

To create a calculated property using joined data

1 If the Data Table is not still open from the previous exercise, select the
Parcels layer in Display Manager and click Table.

2 At the bottom of the Data Table, click Options  ➤ Create A Calculation.

3 In the Create A Calculation dialog box, name the calculated property
“ValueByArea.”

4 Click Properties. Select Assessor| LAST SALES PRICE.
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All properties for this feature class are listed in the Property
list.

5 Click the operator for “divided by” (the slash character).

6 Click Geometric  ➤  Area2D.

This option calculates the area of a polygon.
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7 Hold your cursor inside the parentheses, where you see the text “geometry
property.” On the tooltip that displays, click Enter A Property.

8 From the Properties list, select Geom (at the bottom of the list).

Every spatial feature has a geometry property that you can use to calculate
area or length.

9 Click Validate to make sure that the expression is a valid calculation.

10 When you see “The expression is valid,” click OK to create the calculated
property and return to the Data Table.

Scroll to the right in the Data Table to see the new field. It is gray, to
indicate that it is a calculated property and cannot be edited.

11 Close the Data Table.

Where you are now

You joined information from a Microsoft Access database to a layer containing
parcels. You saved the layer out to a new SDF file, making all its data available
in the future. You used the new data source to create a calculated property.

To continue this tutorial, go to Lesson 4: Theme Polygon Features (page 389).

Lesson 4: Theme Polygon Features
You can use the new calculated property you created as the basis for a theme
that styles parcels according to their value by area.

Exercise 1: Create a theme
A theme varies the display of individual features based on data values. For
example, if you theme by parcel value, less expensive parcels can be a lighter
color while more expensive ones are a darker shade.

In this exercise, you create a theme based on the calculated property you
defined for ValueByArea.

NOTE This exercise uses the map you modified in Lesson 3: Use Joined Data to
Create Calculated Properties (page 380).
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To create a theme using a calculated property

1 In Display Manager, select the Parcels layer and click Style.

2 In the Style Editor, click New Theme.

3 In the Theme Polygons dialog box, for Property, select ValueByArea.

4 For Distribution, select Jenks (Natural Breaks).

The Jenks distribution method groups ranges of features at their natural
breaks so that features with similar values are grouped. This method
shows the natural groupings in the data, rather than creating arbitrary
breaking points.

5 Under Theme The Polygons, click  next to Style Range and set the
foreground color range to any two colors.

The Style Range is a gradient between two colors
you specify.

6 Click OK twice to return to the Style Editor.

Leave the Style Editor open for the next exercise.
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To continue this tutorial, go to Exercise 2: Add labels that use an expression
(page 391).

Exercise 2: Add labels that use an expression
You can label each parcel with text that is determined by an expression. In
this exercise, you create a label for each parcel that displays the parcel address
on two lines.

The Style Editor should still be open from the previous exercise.

NOTE This exercise uses the map you modified in Exercise 1: Create a theme
(page 389).

To add labels using expressions

1 In the Style Editor, click the entry under Feature Label for the first rule
in the theme.

Because you are theming the Parcels feature, you have one entry for each
theme rule.

2 In the Style Label dialog box, click Property To Display, scroll down to
the bottom of the list, and click Expression.
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You can use an expression to determine the text
for labels.

3 To create the two-line label, enter CONCAT ( ADDRESS , '\n', STNAME )

The Concat operator combines multiple properties and uses the '\n'
argument to insert a line break.

4 Validate the expression.

5 Click OK in the Create/Modify Expressions window and again in the Style
Label dialog box.

6 In the Style Editor, click the entry under Feature Label for the second rule
in the theme.
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7 In the Style Label dialog box, click Property To Display, scroll down to
the bottom of the list, and click the Concat expression you created earlier.
Click OK twice.

Once you create an expression for a label, you can select it from the
Property To Display list. You do not have to re-create it each time.

8 Repeat steps 5 and 6 for each entry in the theme for which you want
labels.

9 Close the Style Editor to see the changes.

Where you are now

You themed the Parcels layer, using a calculated property as the basis for the
theme. You added labels whose content was determined by an expression.

To continue this tutorial, go to Lesson 5: Publish Your Styled Map to MapGuide
(page 393).

Lesson 5: Publish Your Styled Map to MapGuide
When you publish a styled map to MapGuide, all queries, filters, labels, and
calculated properties are saved to a .layer file and transferred to MapGuide.

From within AutoCAD Map 3D, you can preview the published information
just as it will appear on the website.

You must have rights to a MapGuide 2009 Server, which supports the new
templates used in this exercise. To do this exercise, you must have credentials
and write rights.

Exercise 1: Publish to MapGuide
When you publish to Autodesk MapGuide, you create a web page containing
a picture of your map. You must have rights to a MapGuide 2009 Server, which
supports the new templates used in this exercise. To do this exercise, you must
have credentials and write rights.

NOTE This exercise uses the map you modified in Lesson 4: Theme Polygon
Features (page 389).
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To publish to MapGuide

1 Save the map.

2 Click  ➤ Publish  ➤ Publish To MapGuide.

3 In the Publish To MapGuide dialog box, specify the URL for the target
website.

If the site requires a password, a Connect to Site dialog box is displayed.
Enter your user name and password.

4 Select a folder for the published files.

To create a folder, right-click the parent folder and click New Folder.

5 Check both options (for overwriting existing resources and previewing
the results).

6 Click Publish.

Once the publish operation is complete, the results appear in a browser window.

7 Click  ➤ Publish  ➤ Publish To MapGuide.
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8 Connect to the website. Then right-click the map to view and click Open
In Web Browser.

Open the published map in a browser to see the
results.

NOTE You can use tooltips to display information when the viewer holds the
cursor over a particular area. Within Autodesk MapGuide Studio, you can create
tooltips that display attribute values on the MapGuide web page when the viewer
hovers over a parcel. For more information, see the Autodesk MapGuide Studio
Help.

Where you are now

You published your map to Autodesk MapGuide, complete with joined data,
calculated properties, styling, and attribute data. You viewed the resulting
web page from within AutoCAD Map 3D.
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Batch Exporting

About the Batch Exporting Tutorial
If you have large numbers of DWG files to export to a different format (for
example, a GIS file format), you can export them in bulk. The tutorial explains
how to move a folder of DWG files to the SDF format in a single operation.

The first example shows limited capabilities and is intended to help you get
started. The tutorial includes another example that does not have as many
restrictions.

The examples in this tutorial illustrate batch techniques for exporting, but the
same approach can be used to do importing. Also, although the examples use
the SDF format, the approach can be used for any file-based format (SHP, DGN,
and so on).

What You Need to Know

The batch-exporting process requires a DOS batch file, an AutoCAD script, and
an AutoCAD Map 3D Export profile. While the steps for creating these items
are included here, you can find additional information on any of these areas:

■ For information on DOS batch files, check the Internet.

■ For information on AutoCAD Scripts, see "Customization Guide  ➤  Slides
and Command Scripts  ➤  Create Command Scripts" in the AutoCAD Help
(included in the AutoCAD Map 3D Help).

■ For information on AutoCAD Map 3D Export profiles, see "Users Guide  ➤ 

Setting Up  ➤  Setting Options  ➤  Customizing and Automating Import
and Export  ➤  Using Profiles" in the AutoCAD Map 3D Help. Press F1 from
anywhere in AutoCAD Map 3D to see the Help.
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What the Process Requires

To use this method, do the following:

■ Copy all the DWG files to export into the same folder.

■ Use a single AutoCAD Map 3D export profile (.EPF file) for all exported
files.

■ Write all the exported files to the same destination folder.

■ Use the same base filename for each exported file as its source DWG file.
For example, Redding.dwg is exported to Redding.sdf, and so on.

■ Store the script files and export profile in the same folder as the DWG files
you are exporting.

How the Process Works

The batch file loops through the folder in which you stored the DWG files to
export. It opens each DWG file it finds. Each iteration runs the script file and
renames a temporary file for the current operation.

The script file exports the current DWG file, using the AutoCAD Map 3D
Export profile settings. Each time it completes this operation, it returns control
to the batch file.

NOTE The script always creates a temporary SDF file and then renames it, because
the instructions within a script cannot vary. For a more advanced solution, see
"Refining the Process."

Lesson 1: Create a Simple Batch File
Create a batch file that exports a folder of DWG files to another format.

Exercise 1: Create the Export Profile
The batch file specifies an export profile (a .EPF file) to use for each export
operation. An export profile stores settings in the Export dialog box. When
you run the batch file, it applies these settings to each DWG file it exports.

Create the export profile within AutoCAD Map 3D by setting options in the
Export dialog box, as you would for any normal export operation.
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To create the export profile

1 Create a folder for the files to export.

You will specify this folder as the location for the export profile, batch
file, and script file.

2 Start AutoCAD Map 3D.

3 In AutoCAD Map 3D, click Output tab  ➤ Data Transfer panel  ➤ Map
3D Export.

4 In the Export Location dialog box, set the file type to SDF and specify
any location and file name. Click OK.

You will not use the file created by the export operation itself, so the file
name and location do not matter.

5 In the Export dialog box, specify the settings to save.

You can specify settings on any tab of the dialog box. An export profile
does not store the current file name or the current selection set.

6 To create the export profile, under Saved Profiles, click Save.

7 Enter a location and name for the profile.

Save the export profile in the same folder as the DWG files to export.

To continue this tutorial, go to Exercise 2: Create the Script File (page 399).

Exercise 2: Create the Script File
The next step is to create an AutoCAD script. An AutoCAD script is a text file
that issues the commands you would type at the Command prompt in
AutoCAD Map 3D to execute an operation. It has some special syntax to make
sure that the commands are properly executed outside the application.

NOTE This exercise continues the process of batch-exporting from the previous
exercise, Exercise 1: Create the Export Profile (page 398).

Each line in the script file is a response to a Command prompt within the
export operation.
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The finished script file looks like the following example (except for your
replacements for file and folder names):

_-mapexport

FDO_SDF

SDFs\Temp.sdf

_yes

D:\Demo\MyExport.epf

_proceed

_quit

Create the script file in a text editor, such as Notepad.

To create the script file

1 Start the Notepad application from your computer desktop. For example,
click Start  ➤  Accessories  ➤  Notepad.

2 Enter the following:

_-mapexport

This line initiates the export operation. The underscore indicates that
the command or prompt will be in English (and will not be translated).
Therefore, the script runs in any language.

3 Press Enter and enter the following:

FDO_SDF

This line is the Command prompt response to "Enter file type to export
to, or ? for list <FDO_SDF>:" It specifies that you will export the DWG
file to SDF format.

4 Press Enter and enter the following:

SDFs\Temp.sdf

Replace SDFs\ with the name of the folder where you will store the
temporary SDF files required by the operation.

This line is the Command prompt response to "Enter name of file to
create <D:\PreviousExport.sdf>:"

5 Press Enter and enter the following:

_yes

This line is the Command prompt response to "Load Profile? [Yes/No]
<No>:" In this case you want to load a profile.
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6 Press Enter and enter the full pathname of the folder and file containing
your export profile. For example, enter:

D:\Demo\MyExport.epf

Specify the same folder as the DWG files to export.

This line is the Command prompt response to "Enter path and name of
.EPF file for options:"

7 Press Enter and enter the following:

_proceed

This line is the Command prompt response to "Change options
[Selection/Data/Options/ Proceed] <Proceed>:"

8 Press Enter and enter the following:

_quit

This line ends the script and returns control to the batch file.

9 Save and close the script file.

Save the script file in the same folder as the DWG files to export.

To continue this tutorial, go to Exercise 3: Create the Batch File (page 401).

Exercise 3: Create the Batch File
The batch file contains commands that run the script and apply the export
profile. Create the batch file in a text editor, such as Notepad.

The finished batch file looks like the following example (except for your
replacements for file and folder names):

for %%f in (*.dwg) do (

"C:\Program Files\AutoCAD Map 3D 2011\acad.exe" %%f /b MyExport.scr

rename SDFs\Temp.sdf %%~nf.sdf

)

NOTE This exercise continues the process of batch-exporting from the previous
exercise, Exercise 2: Create the Script File (page 399).

To create the batch file

1 Start the Notepad application from your computer desktop. For example,
click Start  ➤  Accessories  ➤  Notepad.
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2 Enter the following:

for %%f in (*.dwg) do (

The variable %%f tells the batch file to iterate through the folder, selecting
a new file each time. The expression (*.dwg) tells the batch file to look
for files with the extension .dwg.

3 Press Enter and enter the following:

"C:\Program Files\AutoCAD Map 3D 2011\acad.exe" %%f /b

MyExport.scr

If your version of AutoCAD Map 3D is installed in a different folder,
substitute that location for C:\Program Files\AutoCAD Map 3D
2011\acad.exe. Substitute the name of your script file for MyExport.scr.

4 Press Enter and enter the following:

rename SDFs\Temp.sdf %%~nf.sdf

Replace SDFs\Temp.sdf with the location you specified in the script file.

5 Press Enter and close the expression by typing a close parenthesis.

6 Save and close the batch file.

Save the batch file in the same folder as the DWG files to export.

To continue this tutorial, go to Exercise 4: Run the Batch File (page 402).

Exercise 4: Run the Batch File
Run the batch file to execute the script using the export profile.

When the batch file process is finished, there will one SDF file for each DWG
file in the original folder. You can add data from the SDF files to any map
using Data Connect in AutoCAD Map 3D.

NOTE This exercise continues the process of batch-exporting from the previous
exercise, Exercise 3: Create the Batch File (page 401).

To run the batch file

1 Copy the DWG files, the AutoCAD script, and the batch file into the
folder you created for the export operation.

2 Run the batch file.

■ On your desktop, click Start  ➤  Run.
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■ In the Run dialog box, enter cmd.

■ At the DOS prompt, enter chdir and enter the full path to the folder
containing the batch file.

■ Enter the name of the batch file.

Where you are now

You created a DOS batch file that runs an AutoCAD script and applies settings
from an AutoCAD Map 3D Export profile. The batch file exports a folder of
DWG files to SDF format.

To continue this tutorial, go to Lesson 2: Refine the Process (page 403).

Lesson 2: Refine the Process
If the simple script and batch file are too restrictive, you can create a more
complex batch file. This version of the batch file avoids creating the temporary
file for each export operation. It allows you to store the batch file in a different
folder, export multiple folders of files, and use multiple export profiles.

Exercise 1: Extend the Batch File Capabilities
The following example shows how to amend the batch file you created in
Lesson 1: Create a Simple Batch File (page 398). In this example, you specify
the location of the DWG files and the location of the exported files. The batch
file creates a script for each DWG file. It uses a profile with the same name as
the DWG file.

For example, Dubuque.dwg would have to have a corresponding Dubuque.epf.
So, to use this method, create an EPF for each DWG.

To create the complex batch file

1 In Notepad, enter the following:

set srcDir=D:\Redding\DWGs

set outDir=D:\ReddingSDFs

Substitute the directories shown with your own directories. Specify the
directories where you store the drawing files and the exported files.
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2 Create the temporary export script temp.scr by entering the following
lines.

for %%f in (%srcDir%\*.dwg) do (

echo _-mapexport> temp.scr

echo FDO_SDF>> temp.scr

echo %outDir%\%%~nf.sdf>> temp.scr

echo _yes>> temp.scr

3 Create an export profile with the same base name as the drawing file.

echo %%~df%%~pf%%~nf.epf>> temp.scr

echo _proceed>> temp.scr

echo _quit>> temp.scr

"C:\Program Files\AutoCAD Map 3D 2011\acad.exe" %%f /b temp.scr

)

Substitute the location of your installed application, if needed.

4 Name and save the batch file.

NOTE Run the batch file from the Command window. You can also use the
DOS "AT" command to set up a schedule to run the batch file automatically
at specific times.

Where you are now

You refined the batch file you created in Lesson 1: Create a Simple Batch File
(page 398). The file now specifies the location of the DWG files and the location
of the exported files.

To continue this tutorial, go to Exercise 2: Create a Production Batch File (page
404).

Exercise 2: Create a Production Batch File
This example shows how to export DWG files across multiple folders at a time.
It uses an enhanced batch file that includes error detection and logging.

The batch file receives three parameters each time it is executed:

■ Source folder (for the DWG files)

■ Destination folder (for the exported SDF files)
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■ A default export profile to use when the operation does not find an export
profile with the same name as the DWG file
In the previous example (page 398), every DWG must have a corresponding
export profile. This example allows you to use either a corresponding
profile or a default one. If a DWG file does not have its own profile, it uses
the default one.

Using a Log File

The log file captures the entire command window for each DWG file. It uses
the AutoCAD command copyhist, which moves the command window history
to the system clipboard. This example uses winclip.exe, a free open-source tool,
to paste it to the log file.

Using an Outer Batch File

You can call the batch file from an "outer" batch file: a master batch file that
contains only calls to the subordinate batch file, providing the parameters.

For example, suppose you have drawings for three cities. If the batch operation
exports a folder of drawings for one city, the outer batch file might contain
the following:

batchexport Redding\DWGs Redding\SDFs Redding\DefExport.epf

batchexport Spokane\DWGs Spokane\SDFs Spokane\DefExport.epf

batchexport Dubuque\DWGs Dubuque\SDFs Dubuque\DefExport.epf

NOTE To use this method, either specify a different export.log for each call, or
move the line if exist export.log del export.log to the outer batch file.
Otherwise each call overwrites the previous log.
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Sample Production Batch File

The following sample production batch file is called batchexport.bat. Create
it in Notepad, as you did in the previous procedures.
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@echo off

setlocal

rem Get and verify the command parameters

set srcDir=%1

set outDir=%2

set defEpf=%3

if '%srcDir%' == '' goto usage

if '%outDir%' == '' goto usage

if '%defEpf%' == '' goto usage

if not exist %srcDir% (

echo Source Directory "%srcDir%" not found.

goto done

)

if not exist %srcDir%\*.dwg (

echo No DWG files found in "%srcDir%".

goto done

)

if not exist %outDir% (

echo Destination Directory "%outDir%" not found.

goto done

)

if not exist %defEpf% (echo Default Export Profile "%defEpf%" not

found.

goto done

)

if exist export.log del export.log

rem Loop through the DWGs, exporting each

for %%f in (%srcDir%\*.dwg) do (

if exist %outDir%\%%~nf.sdf del %outDir%\%%~nf.sdf

echo. >> export.log

echo ******* EXPORTING %%f TO %outDir%\%%~nf.sdf ******* >> ex

port.log

echo ******* EXPORTING %%f TO %outDir%\%%~nf.sdf *******

rem Create the Export Script ...

echo _-mapexport> export.scr

echo FDO_SDF>> export.scr

echo %outDir%\%%~nf.sdf>> export.scr

echo _yes>> export.scr

if exist %%~df%%~pf%%~nf.epf (

rem Use a profile that has the same name as the DWG

echo %%~df%%~pf%%~nf.epf>> export.scr

) else (

rem Use the default profile
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echo %defEpf%>> export.scr

)

echo _proceed>> export.scr

echo _copyhist>> export.scr

echo _quit>> export.scr

"C:\Program Files\AutoCAD Map 3D 2009\acad.exe" %%f /nologo /b

export.scr

winclip -p >> export.log

)

goto done

:usage

echo USAGE: %0 [sourceDir] [destDir] [defaultExportProfile]

echo example: %0 Redding\dwgs Redding\sdfs Redding\defExport.epf

:done

Where you are now

You created an enhanced batch file with error detection and logging to export
DWG files across multiple folders at a time.

408 | Chapter 11   Batch Exporting



Glossary

AcDbEntity A standard AutoCAD object, such as a line or arc, that can have properties such
as color, linetype, or lineweight.

adjacent arrows Polygonal objects in a map book template that display the map tiles
immediately contiguous to the current one.

anchor point The location on a drawing object that determines the position of any annotation
attached to that object.

annotation A way to display related values on a drawing object. To annotate geospatial
features, use a label (page 412).

annotation template The information to display in an annotation and the layout of that
information. Annotation templates are stored as specially named blocks within your drawing.
They can include text and graphics.

attribute data Tabular data that describes the characteristics of a feature (page 411), for example,
the number of lanes and pavement-type belonging to a road feature. See also external data
(page 411), object data (page 413), property (page 414).

AutoCAD layer A logical grouping of data. Layers are like transparent acetate overlays on a
drawing. An AutoCAD layer differs from a map layer in Display Manager (page 410). A Display
Manager layer references a feature source or a drawing source, contains styling and theming
information, and optionally has a collection of scale ranges. See also layer (page 412), drawing
layer (page 411), feature layer (page 412), or surface layer (page 415).

Autodesk Design Review A free software utility that allows anyone to view, print, measure,
mark up, and revise 2D and 3D designs created by Autodesk design software. You do not need
the original design-creation software to use this tool.

batch file A file containing a series of commands to be carried out by the operating system.

buffer A zone of a specific radius created around a selected feature. Used to select features
within a specific distance of another feature. In AutoCAD Map 3D, you can define buffers for
drawing topologies and for features, but you define them differently.
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COGO Short for Coordinate Geometry. COGO inquiry commands extract geometric
information from drawing objects such as lines, curves, closed polylines, and polygons. Use
COGO input commands to enter accurate geometry when creating objects. For example,
you can create parcel boundaries from legal documents or survey data.

Enter COGO commands from a dialog box or “transparently.” Use transparent COGO
commands by entering an apostrophe ( ' ) before the command name.

constrained Restricted to particular values. A feature class property that is constrained is
validated when a new feature is added to that class. For example, a "minor road" feature
class may be constrained to be 25, 30, or 40 miles per hour.

contour lines A line that connects points of the same elevation or value relative to a
specified reference datum. The lines can help you determine the elevation at a specific
location on a surface. They help clarify and analyze the 3D surface terrain, and help with
tasks such as navigation.

coordinate system See global coordinate system (page 412).

Create Method A setting on the Class Settings tab of the Define Object Classification dialog
box. It determines the method used to create new objects from this class (when you right-click
the object class and choose Create Classified Object).

Data Connect AutoCAD Map 3D window where you can access a data store (page 410) and
add specific data to your map. Display the Data Connect window by clicking Data in Map
Explorer (page 413) or Display Manager (page 410) (in the Task Pane (page 416)).

data provider Used by Data Connect to connect to geospatial data store (page 410)s.

data store A collection of feature class (page 411)es contained in a single data storage location.
The data store contains feature classes defined within one or more schemas. Data stores can
be files, such as an SDF file, or databases, such as an Oracle Spatial database.

Data Table In AutoCAD Map 3D, the feature (page 411)-based grid where you can view and
edit attributes of selected spatial features, perform searches, and work with selection sets.

DEM Digital Elevation Model. A file that contains a representation of surface terrain. The
surface is stored as a grid. Each grid cell can have any one of several different meanings,
such as elevation, color, density, and so on.

digitize To convert existing data from paper maps, aerial photos, or raster (page 414) images
into digital form by tracing the maps on a digitizer. Object locations are recorded as X,Y
coordinates.

Display Manager A tab in the Task Pane (page 416) that handles the styling and theming of
feature (page 411)s in your map.
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display map All the settings for a specific map, such as the data to include, the appearance
of each layer (page 412), and the legend definition. A display map can include objects from
attached drawings, raster (page 414) images, and feature (page 411)s stored in data store (page
410)s. For example, it can include data from Oracle databases, SDF or SHP files, and ArcSDE.
One map can include multiple display maps.

draping The process of displaying a set of features or a raster (page 414) image on a surface
so that the features or the image reflect the underlying terrain.

Draw Query A query that retrieves objects (copies them into the current drawing). You can
manipulate and edit the objects. You can save them back to their attached drawings, save
them to the current drawing, or save them to a new drawing.

drawing layer A layer in Display Manager (page 410) that contains drawing objects from a
DWG file. See also AutoCAD layer (page 409), feature layer (page 412), layer (page 412), or surface
layer (page 415).

drawing set The set of source drawing (page 415)s attached to a map.

drawing source In AutoCAD Map 3D, a drawing (DWG) file and also its associated
information, such as attached drawing files, drawing-based feature class (page 411)es, linked
template data, and topologies. Compare with feature source (page 412).

drive alias In AutoCAD Map 3D, the mechanism that points to the folder where attached
DWG files are stored.

DWF Design Web Format. An Autodesk file format for sharing two-dimensional,
three-dimensional, and spatially enabled design data on the Web.

export profile A file with a .epf extension that stores settings for an export operation.

external data The attribute data (page 409) linked to a map object but contained in a database
or file outside the map file. See also object data (page 413), property (page 414).

FDO Feature Data Objects data access technology. An Autodesk software standard and
general-purpose API for accessing feature (page 411)s and geospatial data regardless of the
underlying data store (page 410). See also feature class (page 411).

feature An abstraction of a natural or man-made real world object. A spatial feature has one
or more geometric properties. For example, you can represent a road feature with a line,
and a hydrant with a point. A non-spatial feature does not have geometry, but can be related
to a spatial feature that does. For example, a road feature can contain a sidewalk feature
that is defined as not containing any geometry. See also attribute data (page 409), FDO (page
411).

feature class A schema element that describes a type of real-world object. It includes a class
name and property (page 414) definitions. Commonly used to refer to a set of feature (page
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411)s of a particular class, for example, the feature class "roads" or the feature class "hydrants."
See also FDO (page 411), schema (page 414).

feature layer A layer in Display Manager (page 410) containing feature (page 411)s from a
single feature class (page 411) in a spatial data source. Feature layers are added to your map
using Data Connect. See also AutoCAD layer (page 409), drawing layer (page 411), layer (page
412), or surface layer (page 415).

feature source Any source of feature (page 411) data that has been connected to a map.
Compare with drawing source (page 411).

field A specific category of information in a data file, such as Address or Diameter.

geometry (Oracle Spatial database) The representation of a spatial feature (page 411).

GIS (Geographic Information System) A computerized decision support system that
integrates geographic data, attribute data (page 409), and other spatially referenced data. A
GIS is used to capture, store, retrieve, analyze, and display spatial data (page 415).

global coordinate system A method that converts the coordinates representing latitude
and longitude into an AutoCAD Map 3D map Cartesian coordinate system. This method
accounts for the curvature of the surface of the earth with a projection. A coordinate system
can use a projection, an ellipsoid definition, a datum definition, standard parallels, and a
central meridian to define it.

inset A detailed, large-scale portion of a map, often placed on the same sheet as a
smaller-scale map of the larger area.

join A relationship that is established between attribute data and feature sources to create
a view of the combined data for ad-hoc analysis.

key view A thumbnail view of an entire map. You can create a simplified view of the mapped
area to use as the key view.

label Text placed on or near a map feature (page 411) that describes or identifies it.

layer A resource that references a feature class (page 411) or a drawing source (page 411) that
you add using Display Manager (page 410). The layer contains styling and theming
information, and optionally a collection of scale ranges. See also AutoCAD layer (page 409),
drawing layer (page 411), feature layer (page 412), or surface layer (page 415).

legend A table that lists the styles in your map and specifies which layers or map scales
they represent.

lock To make all or part of a disk file read only so that other users on a network cannot
modify it. Object locking applies to objects that someone else is editing. File locking applies
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to entire files, for example when an AutoCAD user wants to open a file while the file is being
edited in AutoCAD Map 3D.

logical operator A symbol such as And, Or, Not, =, >, >=, <, and <= used to define logical
relationships.

map A collection of layers displayed within a consistent coordinate system and extents. See
also layer (page 412).

map book A collection of map tiles that you publish as separate pages. You can specify the
layout and properties for your map book on the Map Book tab of the Task Pane (page 416).

Map Explorer The Task Pane (page 416) tab where you manage your mapping resources.

map query A set of conditions that specify the selection of drawing objects from source
drawing (page 415)s. These conditions can be based on the location or properties of an object
or on data stored in the drawing or in a linked database table.

metadata Data about data. In the GIS context, metadata consists of information that
describes the essential characteristics of geospatial data sets.

Mpolygon A polygon object. A polygon differs from a closed polyline in that it stores
information about its inner and outer boundaries.

named view A defined region of a drawing at a particular zoom level. You can quickly
restore this view by choosing its name from a list.

north arrow A visual indicator of the northern direction in a map. Sample north arrows
and scale bars (both metric and imperial) are available as dynamic blocks for you to insert
into your maps.

object class All the drawing objects that have been created using a specific object class
definition. Use object classification to organize objects in your drawing based on the
real-world features they represent, such as roads. Object classes allow you to create new
objects that automatically have the appropriate properties and values for objects in your
drawing.

object class definition How to create a classified drawing object in a drawing. An object
class definition can include information about the object type, default properties of the
object, or default data to attach to the object.

object data The attribute data (page 409) attached to a drawing object and stored in the
drawing file. Compare with external data (page 411).

Object Type (drawing classification) A setting on the Applies To tab of the Define Object
Classification dialog box that determines which existing objects you can add to this object
class. If the object was not created with the selected method, you cannot add it.
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overlay analysis Provides spatial and data analysis capabilities for two sets of geospatial
features. Use an Overlay operation to compare two layers that overlap in space.

polygon A closed area that stores information about its inner and outer boundaries, and
about other polygons nested in it or grouped with it. In a polygon topology, any lines or
arcs in the drawing can enclose the polygon. In addition, AutoCAD Map 3D supports a
polygon object, sometimes called an Mpolygon (page 413) or mapping polygon.

Preview Query A query that displays the objects on screen, but does not retrieve them.
When you change the screen, the objects disappear.

property A single attribute of a feature class (page 411). A feature class has one or more
property definitions. For example, you can have a Road feature class with properties called
Name, NumberLanes, or Location. See also attribute data (page 409), feature (page 411).

publish To generate output from a map.

query A set of criteria for specifying the selection of objects or records. For example, a layer
(page 412)-based query can display only the objects on the layers that contain state and
district boundaries.

raster Images containing individual dots (called pixels or cells) with color values, arranged
in a rectangular, evenly spaced array. Aerial photographs and satellite images are examples
of raster images used in mapping. Compare with vector (page 416).

resolution In a raster (page 414) image, the density of pixels-per-inch (PPI) or dots-per-inch
(DPI).

save set Objects that were created or modified in the current drawing and are marked to be
saved back to source drawing (page 415)s.

scale The ratio of the distance on a paper map to the distance on the ground. A scale of
1:100,000 (also represented as 1/100000), means that a distance of one unit on the map
corresponds to 100,000 units on the ground. On a digital map, scale represents the scale of
the map from which the digital map was derived.

scale threshold Levels at which a map display changes. You can define different style (page
415)s at different scale thresholds. For example, turn on the display of road names only when
the drawing scale factor is below 1:5000.

schema The metadata that provides a logical description of multiple feature class (page 411)es
and the relationships between them.

SDF Spatial Data File. The current version of the SDF format that is the native format for
the Autodesk MapGuide technology (Autodesk MapGuide Enterprise 2007 and MapGuide
Open Source). Each SDF file can contain multiple feature class (page 411)es or types of data
stored in tables with attributes and geometry.
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SDF 2 A previous version of the SDF file format that was the native file format for Autodesk
MapGuide (the last release was Autodesk MapGuide 6.5). Each SDF 2 file contained one
feature (page 411) or type of data, for example points, lines, polygons, or text.

sheet An individual named object in a sheet set (page 415) that can be published. A sheet
references a layout.

sheet set A named collection of sheets and sheet subset (page 415)s for publishing.

sheet subset A named collection of sheets within a sheet set (page 415). An individual sheet
can be a member of only a single subset.

sheet template A drawing file that defines a title block and a layout for use in sheets. A
sheet template can be specified for sheet set (page 415)s and sheet subset (page 415)s.

source drawing A drawing file attached to another drawing. The set of all source drawings
attached to a drawing is called the drawing set. Use a query to retrieve selected objects from
multiple source drawings.

spatial A generic term used to reference the mathematical concept of n-dimensional data.

spatial data Information about the location and shape of geographic feature (page 411)s,
and the relationships between those features.

spatial database A database containing information indexed by location.

style Settings that specify how to display the objects in a Display Manager (page 410) layer.
For example, you can style color, linetype, linewidth, and scale.

SuperUser An AutoCAD Map 3D user who can perform user administration tasks, set system
options, and perform any other AutoCAD Map 3D operation.

surface layer A layer in Display Manager (page 410) containing feature (page 411)s from a
raster (page 414) image that contains elevation information. Surface layers are added to your
map using Data Connect. See also AutoCAD layer (page 409), drawing layer (page 411), feature
layer (page 412).

Survey A tab on the Task Pane that allows you to bring in LandXML or ASCII point data.
You can manage the resulting point layer and Bulk Copy the data to another data store.

swing tie A type of measurement taken by a surveyor using a known distance plus an angular
offset. A tie is a direct measurement, made with a tape or chain. Swing refers to the angle
offset of the tie.

table A set of data arranged in records (rows) and fields (columns). When a table is displayed
in a grid, records are displayed in horizontal rows and fields are displayed in vertical columns.
Each field value in the table is displayed in a cell.
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Task Pane AutoCAD Map 3D window that displays information about the current drawing.
The Task Pane contains four tabs: Map Explorer (page 413), Display Manager (page 410), Map
Book (page 413), and Survey (page 415). You can resize the Task Pane and place it where you
want.

template A paper space layout you can use as the basis for a new layout. The paper space
objects and page setup in a template are used for any new layout you create with that
template. You can keep, delete, or modify any of the objects from a template you use. No
model space objects are included. Layout templates are identified with a .dwt file extension.

text layer Static text stored as a separate SDF data store, independent from the current map.
You can precisely position text on the layer, and style and rotate the text.

theme A style (page 415) that varies the appearance of an element in a layer based on the
value of a specific property (page 414). For example, instead of coloring lakes blue, you could
vary the shade of blue based on the depth of the lake. Instead of choosing one line width
for all roads, you could vary the line width based on number of lanes.

tile Map books divide a single map into a set of tiles and display each tile on a separate map
book page.

title block A defined DWG block that can include title information, such as your company
or group name and the name of the map. Many organizations have standard title blocks to
insert in this element. You can define certain attributes of the title block from within your
template. When you generate the map book, you can choose a drawing for the title block.
That drawing replaces the original title block contents defined in the template layout.

unclassified objects Objects that have not been assigned to any object class (page 413).

user privileges The AutoCAD Map 3D operations available to each user.

vector A mathematical calculation of an object with precise direction and length. Vector
data is stored as X,Y coordinates that form points, lines, and areas. Compare with raster
(page 414).

viewport (paper space) A view of model space from a layout.

Workflow An automated set of tasks that can be arranged to run in series or parallel. The
output of one task can be used as the input of another task. You can configure the sequence
and parameters for execution graphically.

workflow activity A single step in a workflow that executes a command or set of commands.

workflow binding A relationship between activities such that the output of one activity
is used as the input of another.
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workspace Contains the commands and tools for specific tasks. The Tool-Based Ribbon
workspace is tailored to those already familiar with the AutoCAD ribbon, while the Task-Based
Ribbon is optimized for mapping tasks.

Click the current workspace name in the status bar (page 23)to change the workspace.

zoom To change the display magnification. Magnification focuses on progressively smaller
areas of an image (when you zoom in) and larger areas (when you zoom out).

zoom extents To magnify a drawing based on its extents so that the view shows the largest
possible view of all spatial objects.

 | 417



418



Index

2D
draping data on 3D surfaces 251

3D
draping 2D data on 251

A

annotation
tutorial 133

annotation templates
tutorial 134

application menu 6
search field 9

application window
AutoCAD Map 3D 4

ASCII point data (tutorial) 300–301, 
304, 309, 315

attached drawings
previewing 98

attaching
drawings to a map 97

AutoCAD drawings
assigning a drive alias 81
cleaning up 87
georeferencing 81
preparing for AutoCAD Map 3D 81

AutoCAD layers
converting to feature classes 338
importing data to 365

AutoCAD Map 3D
application window 4
command line interface 25
dynamic input 25
model and layout tabs 24
Properties palette 20
ribbon 6
ribbon workspaces 6
right-click menus 27
shortcut menus 27
status bar 23
Task Pane 12

workspaces 11
AutoCAD Raster Design

digitizing paper drawings 81
AutoCAD users

learning AutoCAD Map 3D 81
preparing drawings for AutoCAD Map

3D 81
Autodesk Design Review 217, 238
automatic update

turning off while editing
(tutorial) 65

automating tasks (tutorial) 279, 285, 288

B

background color
changing for maps 29, 244

background images
placing behind drawing objects 117

batch exporting
advanced (tutorial) 403
production-level (tutorial) 404

batch exporting (tutorial) 397
batch files

advanced exporting (tutorial) 403
and exporting (tutorial) 397
DWG export (tutorial) 401–402
exporting with error detection and

logging (tutorial) 404
for exporting DWG files

(tutorial) 398
production-level exporting

(tutorial) 404
running (tutorial) 402

batch files for exporting (tutorial) 401
Bearing/Bearing command

(tutorial) 292, 297
brightness

adjusting for raster images 118
buffers

and points 278

Index | 419



creating 263
tutorial 262, 278
using to filter data 264

Bulk Copy
tutorial 360

C

calculated properties
tutorial 371, 386

checking in
features after editing (tutorial) 65

checking out
features for editing (tutorial) 65

classification
drawing objects 177

classifying objects
tutorial 177

cleaning up
drawings 87
duplicate objects 88

clipping
raster images 120

COGO commands (tutorial) 291–292, 
297

colors
for themes 50

command line
interface in AutoCAD Map 3D 25

Command prompt
in AutoCAD Map 3D 25

commands
finding on the ribbon 9

composite styles
tutorial 55
video (tutorial) 55

Concat function
tutorial 151

connecting
data sources

video (tutorial) 38
data sources (tutorial) 38
data sources using drag-and-drop 38
to DWG files 39
to exported survey data

(tutorial) 315

using Data Connect 43
contrast

adjusting for raster images 118
coordinate systems

setting for map 38
setting for maps 30
setting when connecting to data 45

creating
new features (video) 60
new features on existing layers

(tutorial) 60
CSV files (comma-separated)

exporting to from Data Table 270

D

data
exporting to CSV 270
moving to different sources 335
purchasing for maps 74
web-based sources 74–76

Data Connect
and raster images 45
video (tutorial) 43

Data Connect (tutorial) 43
data sources

connecting to(tutorial) 38
data stores

types 244
Data Table

adding information for features
(tutorial) 62

displaying for layers (tutorial) 63
exporting data from 270
filtering (tutorial) 63
overview 21
updating after editing features

(tutorial) 66
using for joins 260, 383
zooming to a view (tutorial) 63

Data Table (video) 62–63
Data View

overview 21
defining

object classes (tutorial) 181
defining split/merge rules 374

420 | Index



deleting duplicate objects 88
Design Web Format

publishing to 70
digital maps

purchasing 75
DigitalGlobe

satellite photos 74
digitizing

paper drawings with AutoCAD Raster
Design 81

dispaly order
changing 117

Display Manager
and themes (tutorial) 49
attaching DWG files to maps 39
AutoCAD Map 3D 12
tab in Task Pane 12
using for drag and drop (tutorial) 38

Display Manager layers
adding raster images to 123
renaming 123

Distance/Distance command
(tutorial) 292

drag-and-drop method
for connecting to feature sources 38

draw queries 96
Drawing Cleanup

deleting duplicates 88
extending undershoots 91
profiles 94
tutorial 87

drawing errors
correcting 87

drawing objects
adding to a map 96
assigning to object classes

(tutorial) 190
classifying (best practices) 215
classifying (tutorial) 177
converting to other formats 335
converting to SDF 338
creating with object classes

(tutorial) 200
deleting duplicates 88
editing with object classes

(tutorial) 200

exporting to SDF 343
extending undershoots 91
georeferencing 84
importing SDF data as 364
multiline labels 134
retrieving using property

queries 100
drawing properties

mapping to feature classes 347
drawings

attaching to a map 97
drive alias

creating 81–82
defining 4

DSN (Data Source Name)
creating in Windows XP 257

DSNs
creating for use with maps 380

DWF (Design Web Format)
choosing sheets to publish

(tutorial) 72
publishing map books to

(tutorial) 238
publishing options 128
publishing to 70, 125
setting publishing options

(tutorial) 70
setting publishing options

(video) 70
DWF files

viewing 217
DWG

batch exporting (tutorial) 398
DWG files

attaching to maps (tutorial) 39
exporting multiple folders

(tutorial) 403–404
querying objects into maps 41

DWG files (exporting a folder at a time
(tutorial) 397

dynamic input 25

E

electric industry toolkit 178

Index | 421



elevation
showing with styling 244

export
batch files (tutorial) 398
profiles for batch exporting

(tutorial) 397–398
exporting

and object data 126
filtered layer data 266
folders of DWG files at one time

(tutorial) 397, 403–404
object classes (tutorial) 209
point groups (tutorial) 309

expressions
tutorial 391

extending undershoots 91
external data

joining to layers 257, 380

F

fade
adjusting for raster images 118

feature classes
creating from AutoCAD layers 338
mapping object classes to

(tutorial) 209
mapping object data to 344
mapping properties to 347

feature sources
dragging and dropping 38

features
adding data for (tutorial) 62
automatic check-out (tutorial) 65
checking in (tutorial) 65
creating (tutorial) 60
editing (tutorial) 65
labeling with text along a curve 155
locking while editing (tutorial) 65
multiline labels 147
updating after editing (tutorial) 66

filtering
Data Table (tutorial) 63
Data Table (video) 63

flood analysis
tutorial 271, 273

G

geodata portal 74
georeferenced DWFs

publishing 70
georeferencing drawings 81
geospatial data

copying to a different format 360
geospatial features

adding data for (tutorial) 62
creating (tutorial) 60

I

image frames
displaying 118

image information
viewing 115

images
adding to maps 112
inserting without using Data

Connect 112
importing

feature classes as AutoCAD
layers 365

information
viewing for raster images 115

Insert Image command
tutorial 112

inserting
raster images 112

insets
and map books 235

Intermap
topographic images 76

J

joins
and styling 257, 261, 380
tutorial 260, 383

422 | Index



K

key map views
and map books 228

L

labels
adding to themes (tutorial) 52
text along a curve 155
tutorial 133, 147, 391
unrelated to objects or features 162
video (tutorial) 52

layers
comparing 267
displaying Data Table for

(tutorial) 63
exporting 266
mapping imported data to AutoCAD

layers 365
layouts

and publishing (tutorial) 72
legends

and map books 228
changing order of items (tutorial) 68
creating for maps 67
excluding items from (tutorial) 68
inserting (tutorial) 67

linear features
displaying text along a curve 155

lines
composite styles (tutorial) 55
composite styles (video) 55

location
queries 103

locking
features while editing (tutorial) 65

M

managing data
tutorial 335

map books
adding an inset 235
creating with templates 228
customizing north arrows 227

customizing templates 220, 222
customizing title blocks 224
generating 231
including a key map view 228
including a legend 228
previewing 231
publishing to DWF 238
saving settings 231
settings for 229
specifying printers or plotters

for 220
templates and north arrows for 227
templates and plotters for 220
templates and title blocks for 224
templates and viewports for 222
templates for 220
tutorial 217

Map Books tab
in Task Pane 12

Map Classic 11
Map Explorer tab

in Task Pane 12
map2d.dwt 30
MapGuide

tutorial 393
tutorial for publishing 371

maps
changing background color for 244
creating (tutorial) 30

menu commands
finding on the ribbon 9

menus
in AutoCAD Map 3D 6

metadata
and object classification

(tutorial) 206
model and layout tabs

AutoCAD Map 3D 24
multi-user editing

and drive aliases 82
multiline labels

for drawing objects 134
for features 147
tutorial 391

multiple drawings
attaching to a map 97

Index | 423



N

NAVTEQ
digital maps 75

north arrows
for map book templates 227

O

object classes
and export(tutorial) 209
and metadata(tutorial) 206
assigning objects (tutorial) 190
creating objects (tutorial) 200
defining (tutorial) 181
editing objects (tutorial) 200
predefined 178
using in new maps(tutorial) 194

object classification
and industry toolkits 178
and new maps (tutorial) 194
and SuperUser privileges 179
best practices 215
tutorial 177

object data
and exporting 126
mapping to feature classes 344

object data index
creating 110

ODBC
connecting to data 259
joining data to features 260
setting up connections 257

ODBC connections
setting up 380

ODBC data
connecting to 382

options
AutoCAD 29
AutoCAD Map 3D 29

organization name
changing for map book 224

overlays
tutorial 271, 273

P

plot date
changing for map books 224

plotters
specifying for map books 220

point groups (tutorial) 304
points

styling as symbols 76
tutorial 277

polygon features 374
labeling tutorial 391
splitting 374
splitting (tutorial) 371
theming tutorial 389
tutorial 371

preview queries 96
previewing

attached drawings 98
using property queries 100

profiles
batch export (tutorial) 397–398
creating for Drawing Cleanup 94

properties
adding to SDF data stores 350
adding to SDF features 357

Properties palette
AutoCAD Map 3D 20

proximity
using to analyze data in maps 262

publishing
to DWF 70

publishing options
for DWF 128

publishing to DWF (video) 72

Q

queries
complex 103
creating an object data index

for 110
for adding drawing objects to a

map 96
for DWG objects 41
for previewing 96

424 | Index



location 103
multiple criteria 103
previewing with 100
property 100
using buffers with 264

querying
drawing objects with no coordinate

system 84
DWG objects into maps (video) 41

Quick Access Toolbar 6
Quick View

tutorial 96, 98

R

raster images
adding (tutorial) 45
adding (video) 45
adding to Display Manager

layers 123
adding with Data Connect 45
adjusting image brightness 118
adjusting image contrast 118
adjusting image fade 118
changing draw order (tutorial) 47
clipping 120
displaying behind drawing

objects 117
displaying frames for 118
inserting 112
moving behind other layers

(tutorial) 47
viewing information for 115
viewing size 115

ribbon
changing tab order 6
finding commands from previous

releases 9
in AutoCAD Map 3D 6
keyboard shortcuts 6

Ribbon Command Locator 9
right-click menus

AutoCAD Map 3D 27
Rubber Sheet

and georeferencing 84

S

sample files for tutorials 2
satellite images

choosing a transparent color in 76
satellite photos

purchasing 74
Schema Editor

tutorial 357
schemas

editing 355
script files for batch exporting

(tutorial) 399
scripts

advanced exporting (tutorial) 403
and exporting (tutorial) 397
batch export (tutorial) 399

SDF
converting drawing objects to 338
exporting drawing objects to 343
exporting layers to 266
importing data as drawing

objects 364
SDF files

adding properties to 350, 357
dragging and dropping (tutorial) 38

shared drawings
setting up a drive alias for 82

sheet sets
choosing for publishing 72

shortcut menus
AutoCAD Map 3D 27

SHP files
connecting to 43

split/merge rules
defining 374

splitting
polygon features (tutorial) 371, 374

status bar
AutoCAD Map 3D 23

styles
and joins 261
and zoom levels 55
and zoom levels (tutorial) 59
and zoom levels (video) 59
combining two line styles 55

Index | 425



composite 55
styling

to show elevation 244
SuperUser

setting privileges 179
surfaces

draping vector data on 251
draping vector files on 254
styling to show elevation 244
theming 76, 246

survey data (tutorial) 291
survey point data (tutorial) 300–301, 

304, 309, 315
Survey tab

in Task Pane 12
symbols

using for point features 76

T

Task Pane
AutoCAD Map 3D 12
Display Manager tab 12
Map Explorer tab 12

Task-based Ribbon workspace 11
templates

for map books 220, 222, 224, 227
for new maps 30
object classification 178
tutorial 364
using to create map books 228

text
tutorial 133
unrelated to objects or features 162

text layers
editing 166
styling 164
tutorial 162

text style
changing for map books 224

themes
adding labels (tutorial) 52
and map scale (tutorial) 52
and ranges of values (tutorial) 49
defining colors (tutorial) 50
for surfaces 76

for surfaces with elevation 246
video (tutorial) 49

theming
tutorial 389

title blocks
for map book templates 224

Tool-based Ribbon workspace 11
topographic images

purchasing 76
transparency

and satellite images 76
and underlying surfaces 254
changing for layers (tutorial) 47

tutorial
annotation templates 134
Concat function 151
labels 147
text 133
text along a curve 155
text layers 162

tutorials
adding a property to an SDF file 350
adding points 277
annotation 133
applying themes to surfaces 246
ASCII point data 291
AutoCAD to AutoCAD Map 3D 81
batch files for export 401–402
buffers 262, 278
Bulk Copy 360
calculated properties 371, 386
changing map background

color 244
comparing layers 267
connecting to SDF files 350
converting survey points to

SDF 309, 315
creating a template 364
display layers 367
Drawing Cleanup 87
drawing queries 96
editing schemas 355
entering swing tie data 291
export profiles for batch export 398
exporting display layers 371, 384

426 | Index



exporting from DWG to SDF 125–
126, 343

exporting to CSV 270
expressions 391
filtering data with buffers 264
importing SDF data as drawing

objects 364
importing survey points 300–301
joined data 371
joins 257, 260, 380, 383
joins and styling 261
labeling polygon features 391
location queries 103
making layers transparent 254
managing data 335
map books 217
mapping drawing properties to feature

class properties 347
mapping object data to feature

classes 344
mapping to AutoCAD layers on

import 365
migrating data 335
multiline labels 391
object classification 177
ODBC connections 257, 380
ODBC data sources 259, 382
organizing survey points 304
overlay 271, 273
overview 1
publishing maps to DWF 125
publishing to MapGuide 371, 393
raster images 112
resizing the window for 4
sample files for 2
Schema Editor 357
scripts for batch export 399
searching to select 376
splitting polygon features 371, 374
styling surfaces to show

elevation 244
survey 291
theming polygon features 389
workflows 279
workspace for 4

tutorials (advanced batch exporting) 403

tutorials (batch exporting) 397
tutorials (COGO commands) 292, 297
tutorials (production-level batch

exporting) 404

U

undershoots
extending 91

updating
features after editing (tutorial) 65
features after editing (video) 65

user rights (tutorial) 179

V

vector data
draping on 3D surfaces 251

videos
adding raster images (tutorial) 45
attaching DWG files (tutorial) 39
automatic update (tutorial) 65
checking in features (tutorial) 65
checking out features (tutorial) 65
composite styles (tutorial) 55
connecting to data (tutorial) 38
creating new features (tutorial) 60
Data Connect (tutorial) 43
Data Table (tutorial) 62–63
defining themes (tutorial) 50
DWF options 70
editing feature properties

(tutorial) 62
editing features (tutorial) 65
editing legends (tutorial) 68
labeling 52
legends (tutorial) 67
moving raster images behind

features 47
publishing options for DWF

(tutorial) 70
publishing to DWF (tutorial) 72
querying DWG objects (tutorial) 41
styles and zoom levels (tutorial) 59
themes (tutorial) 49
transparency (tutorial) 47

Index | 427



updating feature information
(tutorial) 66

viewports
for map books 228
resizing on templates 222

W

wastewater industry toolkit 178
water industry toolkit 178
workflows

editing (tutorial) 280, 285
running (tutorial) 288
tutorial 279

working offline 65

workspaces
AutoCAD Map 3D 6
selecting for tutorials 4
switching between 11

Z

z-order
changing (tutorial) 47

zoom levels
and styles (tutorial) 59
and styles (video) 59
assigning styles to 55

zooming
using Data Table (tutorial) 63

428 | Index


	Contents
	Tutorial: Introducing AutoCAD Map 3D 2011
	Lesson 1: Get Ready to Use the Tutorials
	Exercise 1: Prepare your sample data
	Exercise 2: Save your tutorial maps
	Exercise 3: Set up the tutorial window
	Exercise 4: Choose a workspace

	Lesson 2: Take a Quick Tour of AutoCAD Map 3D
	The Ribbon
	Finding Commands
	Workspaces
	The Task Pane
	Properties Palette
	Data Table and Data View
	Status Bars
	Layout Tabs
	Dynamic Input
	Shortcut Menus
	Options

	Lesson 3: Get Started
	Exercise 1: Create a map
	Exercise 2: Use Data Connect to add data to your map
	Exercise 3: Style a feature


	Tutorial: Building a Map
	About the Building a Map Tutorial
	Lesson 1: Use Multiple Sources
	Exercise 1: Drag and drop a source file
	Exercise 2: Attach a drawing file
	Exercise 3: Query in data from the drawing
	Exercise 4: Use Data Connect
	Exercise 5: Add a raster image
	Exercise 6: Display the raster image behind other features

	Lesson 2: Style Map Features
	Exercise 1: Create a theme for the parcels layer
	Exercise 2: Define the theme
	Exercise 3: Add labels

	Lesson 3: Change the Display by Zoom Level
	Exercise 1: Use a composite style for roads
	Exercise 2: View styles at different zoom levels

	Lesson 4: Create Map Features
	Exercise 1: Draw a new parcel
	Exercise 2: Add information about the new parcel

	Lesson 5: Find and Edit Features
	Exercise 1: Use the Data Table to find a feature
	Exercise 2: Check out and edit a feature
	Exercise 3: Update information for the edited feature

	Lesson 6: Create a Legend
	Exercise 1: Insert a legend object
	Exercise 2: Change the order of items in the legend

	Lesson 7: Publish Your Map
	Exercise 1: Specify attributes to include
	Exercise 2: Publish to DWF

	Lesson 8: Branch Out - Find Data Sources
	Exercise 1: Explore the Data Portal - DigitalGlobe®
	Exercise 2: Explore the Data Portal - NAVTEQ™
	Exercise 3: Explore the Data Portal - Intermap™
	Exercise 4: Try out the sample data


	Tutorial: Moving From AutoCAD to AutoCAD Map 3D
	About The AutoCAD/AutoCAD Map 3D Tutorial
	Lesson 1: Prepare Drawings for Use With AutoCAD Map 3D
	Exercise 1: Set up a drive alias
	Exercise 2: Georeference source drawings

	Lesson 2: Clean Up Your Drawings
	Exercise 1: Delete duplicates
	Exercise 2: Extend undershoots
	Exercise 3: Use cleanup profiles (optional)

	Lesson 3: Add Drawing Objects to a Map
	Exercise 1: Attach source drawings
	Exercise 2: Preview attached drawings with Quick View
	Exercise 3: Preview drawing objects with a property query
	Exercise 4: Retrieve objects with a property and location query
	Exercise 5: Query object data
	Exercise 6: Create an object data index (optional)

	Lesson 4: Add Raster Images
	Exercise 1: Insert a raster image
	Exercise 2: View image information
	Exercise 3: Change the display order

	Lesson 5: Modify Raster Images
	Exercise 1: Adjust image brightness, contrast, and fade
	Exercise 2: Clip the image
	Exercise 3: Add a raster image to a Display Manager layer

	Lesson 6: Share Your Map with Others
	Exercise 1: Export a map to Autodesk SDF
	Exercise 2: Publish a map to a DWF file


	Tutorial: Annotating Your Map
	About the Annotation Tutorial
	Lesson 1: Use Annotation Templates
	Exercise 1: Create an annotation template
	Exercise 2: Attach annotation to drawing objects
	Exercise 3: Add a static text label

	Lesson 2: Add Labels to Features
	Exercise 1: Use a style to label features
	Exercise 2: Use an expression to refine the labels
	Exercise 3: Display text along a curve
	Exercise 4: Add static text

	Lesson 3: Use text layers
	Exercise 1: Create a text layer
	Exercise 2: Style the text layer
	Exercise 3: Add text to the text layer
	Exercise 4: Use the text layer in another map


	Tutorial: Classifying Drawing Objects
	About the Classifying Drawing Objects Tutorial
	Lesson 1: Set Up For Classification
	Exercise 1: Set up your work environment
	Exercise 2: Set up your user privileges

	Lesson 2: Define Object Classes
	Exercise 1: Create the object class definition file
	Exercise 2: Define an object class
	Exercise 3: Add object classes to the definition file

	Lesson 3: Classify Objects
	Exercise 1: Classify the signal objects
	Exercise 2: Classify roads and parcels

	Lesson 4: Create a Map Using Object Classes
	Exercise 1: Create a map
	Exercise 2: Assign a coordinate system
	Exercise 3: Query in objects

	Lesson 5: Create and Edit Objects Using Object Classes
	Exercise 1: Create objects using object classes
	Exercise 2: Edit classified objects

	Lesson 6: Generate Metadata for a Classified Drawing
	Exercise 1: View metadata
	Exercise 2: Share metadata

	Lesson 7: Use Object Classes When Exporting
	Exercise 1: Export object classes to SDF
	Exercise 2: Connect to the resulting SDF file
	Exercise 3: Style the new feature classes

	Object Classification: Best Practices

	Tutorial: Creating a Map Book With an Inset
	About the Map Book Tutorial
	Lesson 1: Prepare the Map
	Exercise 1: Create a map
	Exercise 2: Add data to your map

	Lesson 2: Customize a Map Book Template
	Exercise 1: Change the printer/plotter for the template
	Exercise 2: Resize the main viewport
	Exercise 3: Modify the title block
	Exercise 4: Replace the north arrow block

	Lesson 3: Create A Map Book
	Exercise 1: Create a key map view and a legend
	Exercise 2: Specify the map book settings
	Exercise 3: Preview and generate the map book

	Lesson 4: Create an Inset
	Exercise 1: Draw a viewport for the inset
	Exercise 2: Change the information displayed in the viewport

	Lesson 5: Publish The Map Book
	Exercise 1: Set DWF publishing options
	Exercise 2: Set background publishing options
	Exercise 3: Publish the map book to DWF format


	Tutorial: Analyzing Data
	About the Analyzing Data Tutorial
	Lesson 1: Analyze Data Visually, Using Surfaces
	Exercise 1: Prepare your map file
	Exercise 2: Add a surface to view elevation data
	Exercise 3: Add a layer on top of the surface
	Exercise 4: Drape a parcel layer on top of the surface

	Lesson 2: Analyze Data With External Information Using Joins
	Exercise 1: Set up an ODBC connection for an Access database
	Exercise 2: Connect to the Access database
	Exercise 3: Join the data from the ODBC source to the layer containing the parcels
	Exercise 4: Use the joined data for calculated fields and styles

	Lesson 3: Analyze Data by Proximity Using Buffers
	Exercise 1: Create a buffer representing a construction zone
	Exercise 2: Select the parcels within the construction-zone buffer
	Exercise 3: Export the construction-zone parcels to an SDF file
	Exercise 4: Compare the two parcel layers
	Exercise 5: Export the data to CSV for use in a report

	Lesson 4: Perform a Flood Analysis with Overlay
	Exercise 1: Add the layers to compare
	Exercise 2: Use an overlay to compare two layers
	Exercise 3: Add and style a road layer
	Exercise 4: Add emergency response points
	Exercise 5: Find streets that are far from a hospital

	Lesson 5: Edit a Predefined Workflow
	Exercise 1: Automate grouping layers
	Exercise 2: Automate AutoCAD commands
	Exercise 3: Run the workflow


	Tutorial: Working with Survey Data
	About the Survey Data Tutorial
	Lesson 1: Use COGO to Enter Field Measurements
	Exercise 1: Set up your work environment
	Exercise 2: Find a location using two distances
	Exercise 3: Find a location using two bearings

	Lesson 2: Add field-collected point data to a map
	Exercise 1: Create the map
	Exercise 2: Import the point data
	Exercise 3: Organize the points
	Exercise 4: Convert the points to spatial data
	Exercise 5: Connect to the exported point data

	Lesson 3: Creating a point cloud from LiDAR data
	Exercise 1: Download the sample data
	Exercise 2: Create a map
	Exercise 3: Create indexed point cloud data stores from LiDAR data
	Exercise 4: Add a point cloud to your map using the Point Cloud Manager

	Lesson 4: Work with Point Cloud Data
	Exercise 1: Create a map
	Exercise 2: Add a point cloud to your map
	Exercise 3: Style a point cloud
	Exercise 4: Filter a point cloud
	Exercise 5: Export point cloud data

	Lesson 5: Create a Surface From Point Cloud Data
	Exercise 1: Create a surface
	Exercise 2: Style the surface


	Tutorial: Managing Data From Different Sources
	About the Managing Data Tutorial
	Lesson 1: Convert Drawing Layers to Feature Classes
	Exercise 1: Examine the original drawing layers
	Exercise 2: Examine the object data
	Exercise 3: Export the drawing layers to SDF - Select the layers
	Exercise 4: Export the drawing layers to SDF - Map object data to feature class properties
	Exercise 5: Export the drawing layers to SDF - Map drawing properties to feature class properties
	Exercise 6: Export the drawing layers to SDF - Set export options

	Lesson 2: Use the Resulting SDF Files
	Exercise 1: Create a map
	Exercise 2: Connect to the new SDF data
	Exercise 3: Edit the schema
	Exercise 4: Add a property
	Exercise 5: Populate the new property with values

	Lesson 3: Move SDF Data to a Different Geospatial Format
	Exercise 1: Connect to a new SHP file folder
	Exercise 2: Use Bulk Copy to move an SDF layer to SHP format

	Lesson 4: Import SDF Files as DWG Layers
	Exercise 1: Create a template for the imported material
	Exercise 2: Import the SDF layers
	Exercise 3: Use display layers to assign object properties


	Tutorial: Working with Polygon Features
	About the Polygon Features Tutorial
	Lesson 1: Connect to Parcel Data
	Exercise 1: Create a map
	Exercise 2: Bring in the parcel data

	Lesson 2: Split a Polygon Feature
	Exercise 1: Define split/merge rules
	Exercise 2: Find the parcel to split
	Exercise 3: Split the parcel
	Exercise 4: Examine the results

	Lesson 3: Use Joined Data to Create Calculated Properties
	Exercise 1: Set up an ODBC connection for a Microsoft Access database
	Exercise 2: Connect to the Microsoft Access database
	Exercise 3: Join the ODBC data to the Parcels layer
	Exercise 4: Save the properties to a new data store
	Exercise 5: Create a calculated property

	Lesson 4: Theme Polygon Features
	Exercise 1: Create a theme
	Exercise 2: Add labels that use an expression

	Lesson 5: Publish Your Styled Map to MapGuide
	Exercise 1: Publish to MapGuide


	Batch Exporting
	About the Batch Exporting Tutorial
	Lesson 1: Create a Simple Batch File
	Exercise 1: Create the Export Profile
	Exercise 2: Create the Script File
	Exercise 3: Create the Batch File
	Exercise 4: Run the Batch File

	Lesson 2: Refine the Process
	Exercise 1: Extend the Batch File Capabilities
	Exercise 2: Create a Production Batch File


	Glossary
	Index

